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iFIX Database Reference

This e-book is intended for process engineers responsible for designing   and building a process data-
base. It contains the following sections which   provide more details on how to use the database blocks 
and functions that   are available in the iFIX Database Manager:

 l Creating   a Process Database

 l Database   Block Reference

 l Database   Block Field Reference

 l Typical   Uses of Database Blocks

 l Database   Block Examples

 l Commands   Available from Database Blocks

 l Math   Features in Database Blocks

 l Additional   Information on Alarming

 l SQL   Use in Database Blocks

 l System   Fields

 l SIM   Signal Generation Registers

 

 

Creating a Process Database

To create a process database: 

 1. In the Database Manager,   create a new database.

 2. Create primary blocks   for your I/O points.

 3. Create any secondary   blocks you need.

 4. Connect the primary   and secondary blocks to form chains.

 5. Verify the database   for errors.

 6. Correct any errors   and fine-tune the database.

Click the appropriate link below for more detailed information on creating   a process database:

 l Learning   Database Basics

 l Managing   Blocks

 l Managing   Databases

 l Working   with the Spreadsheet

 l Customizing   Database Manager
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Learning Database Basics

Click any of the following links for more information about learning   database basics :

 l Creating,   Opening, Saving, and Loading Databases

 l Creating,   Modifying, and Deleting Blocks

 

Creating, Opening, Saving, and Loading Databases

Click any of the following links for more information about creating,   opening, saving, and loading data-
bases:

 l Creating   a New Database

 l Opening   a Database

 l Closing   a Database

 l Saving   a Database

 l Saving   a Database with a New Name

 l Loading   or Reloading a Database

 

Creating a New Database

 To create a new database:

In the Database Manager, in Ribbon view,   on the Home tab, in the Process Database group, 
click Load Empty. 

- Or -

In Classic view, click the New button on   the Database Manager's toolbar. 

An empty spreadsheet appears. 

 

Opening a Database

To open a database:  

 1. In the Database Manager, in Ribbon view, click the   Main Button, then click Open. 

- Or -

In Classic view, on the Database Manager's   toolbar, click the Open button.

 2. Double-click the   SCADA server to which you want to connect. 

 

Closing a Database
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 To close a database:  

 1. In   the Database Manager, in Ribbon view, click the Main Button, and then   click Close.

- Or -

In Classic view, on the Database Menu click   Close.

 2. If you made changes   to the database, you are prompted to save when exiting. 

WARNING: If   you click Yes to save and there is an AAD file mismatch, the database   is not saved even 
though it appears that the system saves it. An error   message does not appear. 

 

Saving a Database

 To save a database:  

In the Database Manager, in Ribbon view,   on the Home tab, in the Process Database group, 
click Save. 

- Or -

In Classic view, on the Database Manager's   toolbar, click Save. 

NOTE: If there is an AAD file mismatch,   you cannot save the file. An error message will appear if you 
try to save.   

 

Saving a Database with a New Name

 To save a database under a new database name:  

In the Database Manager, in Ribbon view,   click the Main Button, then click Save As. 

- Or -

In Classic view, on the Database Menu, click   Save As.

The Save As Dialog Box appears.

 2. In the Enter Database   Name field, enter the name of the database. 

 3. Click Save As to   save the database. 

 

Loading (or Reloading) a Database

 To load or reload a database:  

 1. In the Database Manager, in Ribbon view, on the Home   tab, in the Process Database group, 
click Reload. 

- Or -

In Classic view, on the Database Menu, click   Reload.

The Reload Dialog Box appears.

© 2020 General Electric Company. All rights reserved. 3



 2. Double-click the   node whose database you want to reload. 

 3. Double-click the   name of the database you want to load. 

IMPORTANT: When you reload a database,   all I/O points are reset to the appropriate starting values. 
Do not use   this function during an active production cycle. 

NOTE:   When you reload the database, all of the new database tags are added to   Historian. In addi-
tion, all of the tags from the previous database are   hidden from Historian. It may seem as though those 
tags are deleted, but   they are not.

 

Creating, Modifying and Deleting Blocks

Click any of the following links for more information about creating,   modifying, and deleting blocks:

 l Adding   a Primary Block to a Database

 l Adding   a Secondary Block to a Database

 l Chaining   Two Blocks Together

 l Modifying   Blocks

 l Deleting   Blocks

 l Displaying   Blocks

 l Enabling   Event Messages

 l Enabling   and Disabling Alarming

 l Assigning   Alarm Areas to a Database Block

 l Entering   Alarm Limits

 l Selecting   an Alarm Priority

 l Configuring   a Block to Require Electronic Signatures

 

Adding a Primary Block to a Database

 To add a primary block to the database:  

 1. In the Database Manager,   double-click a cell in an empty row of the spreadsheet. 

 2. Double-click the   type of primary block you want to add. 

 3. Complete the block   dialog box. 

NOTE:   If the block you are adding will be collected by GE Historian, and   the Collector is running, it 
takes approximately two minutes for the addition   to appear. This change affects all blocks; at the time 
of addition, all   tags stop collecting briefly while the tag is added to the collection.   

 

Adding a Secondary Block to a Database
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 To add a secondary block to the database:  

 1. In the Database Manager,   double-click a cell in an empty row of the spreadsheet. 

 2. Double-click the   type of secondary block you want to add. 

 3. Complete the block   dialog box. 

 

Chaining Two Blocks Together

 To chain two blocks together:  

 1. In the Database Manager,   double-click any cell of the first block in the chain you want to create.   

 2. In the Next field,   enter the name of the next block in the chain, or click the Browse button   to 
select the next block from the list that appears. 

Example 1 of Chained Blocks

Incorrect: AI1 > CA > AI2 

Correct:     AI1 > CA > AO 

Example 2 of Chained Blocks

Incorrect: AI1 > CTR > AI2 

Correct:    AI1 > CTR > AO 

 

Long Tag Names

With iFIX 6.0, tag names and description lengths increased from 30 characters to 256. This helps sup-
port longer tag names with complete hierarchies coming from the PLC. Please be aware of the following 
limitations when using long tag names:

 l Older iFIX nodes cannot connect to iFIX 6.0 or greater SCADA server. For example, you cannot 
connect a 5.9 iClient to a 6.1 SCADA server.  However, a 6.1 iClient can still view a 5.9 or earlier 
SCADA server.

 l If using the Auto Alarm Manager (AAM), all the iFIX sender and receiver nodes (servers and cli-
ents) must be of same version. This is specific to iFIX 6.0 and above, as older iFIX nodes (iFIX 
5.9 and below) cannot connect to a newer SCADA server.

 l When browsing tags in the Expression Editor on an iClient (view node), it may take 50% longer to 
perform the initial tag lookup.

 l When using with GE Historian 7 SP6 or earlier, you must limit iFIX tag names to 199 characters 
or less to support the Historian iFIX Collector and Historian Administrator interface. Using tags 
longer than 199 characters with Historian will result in an unstable system. This limitation does 
not exist in Historian 7.1 and later. 

 l The maximum column length when you export an Enhanced Chart is 200 characters.  Be aware 
that when you take into account the node name and other characters that make up the tag such 
as the tag type (for example: .F_CV) the tag length maximum is probably closer to around 175 
characters.
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 l If using iFIX with Batch Execution, be aware that long tag names and descriptions are not sup-
port by Batch Execution. Batch Unit Definitions, Batch Phase Tag Definitions, and the Batch 
Watchdog Tag are all limited to 255 characters.  When using iFIX for these Items, the full 
Node:Tag:Field address must be used, so the length of your iFIX tag names should be con-
sidered when creating your iFIX database tags.

 l The Recipe Builder Reports limit the Tag Identifier to 100 Characters.
 l Tag Control Panel and Quick Trend screens are limited to tag names of 234 characters.
 l Microsoft Visual Basic limits character identifiers in scripts to a maximum of 255 characters.
 l The Discover and Auto Configure tool and the OPC Client Driver do not support long tag names 

or descriptions.

Modifying Blocks

 To modify a block:  

 1. In the Database Manager,   double-click any cell of the block you want to modify. 

 2. Modify the fields   in the block configuration dialog box as needed.  

NOTE:   If the block you are modifying is collected by GE Historian, and   the Collector is running, it takes 
approximately two minutes for the modification   to appear. This change affects all blocks; at the time of 
modification,   all tags stop collecting briefly while the tag is modified. 

 

Deleting Blocks

 To delete blocks:  

 1. Select the blocks   you want to delete. 

 2. In the Database Manager,   in Ribbon view, on the Home tab, in the Blocks group, click Delete. 

- Or -

In Classic view, click the Delete button   on the Database Manager's toolbar.

 3. Click Yes to delete   a single block or click Delete All to delete multiple blocks and place   their 
chains off scan. 

NOTES:

 l If you are   using GE Historian to collect block values, and you delete a block   from the iFIX data-
base, the tag is also deleted from the Historian Collector.   

 l If the block   you are deleting is collected by GE Historian, and the Collector   is running, it takes 
approximately two minutes for the deletion to appear.   This change affects all blocks; at the time 
of deletion, all tags stop   collecting briefly while the deleted tag is removed from the collection.   

 

Displaying Blocks

 To display a block's configuration dialog box:  

 1. Select the block   you want to display. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Blocks group,   click Show. 

- Or -
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In Classic view, on the Database   Manager's toolbar, click Show button.

 

Enabling Event Messages

To enable event messages: 

 1. In the Database Manager,   double-click the block you want to modify from the database spread-
sheet.   

 2. From the block configuration   dialog box, click the Alarms tab. 

 3. Select the Enable   Event Messaging check box. 

 

Enabing and Disabling Alarming

To enable or disable alarming: 

 1. In the Database Manager,   double-click the block you want to modify from the database spread-
sheet.   

 2. From the block configuration   dialog box, click the Alarms tab. 

 3. Select the Enable   Alarming check box to enable alarming or clear the check box to disable   alarm-
ing.

 

Assigning Alarm Areas to a Database Block

 To assign alarm areas to a database block: 

 1. In the Database Manager,   double-click the block you want to modify from the database spread-
sheet.   

 2. From the block's   configuration dialog box, click the Alarms tab. 

 3. Double-click a line   in the Alarm Areas list box. 

 4. Enter an alarm area   name. 

 5. Repeat steps 3 and   4 until you enter all the names you require. 

You can also select alarm areas from the   alarm area database by double-clicking a line in the 
Alarm Areas list   box and selecting the Browse button. When Configure Alarm Areas dialog   box, 
perform one or more of the following tasks, as desired: 

 l To assign   all available alarm areas, select the Use All Alarm Areas check box. 

 l To add individual   alarm areas, clear the Use All Alarm Areas check box, select the area   in 
the Available Areas list box, and click the right-arrow button to add   it to the Configured 
Areas list box. 

 l To create   a new alarm area, clear the Use All Alarm Areas check box, enter the alarm   area 
name in the field provided, and click the Add New button. The new   alarm area appears in 
both the Available Areas list box and the Configured   Areas list box. 
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Entering Alarm Limits

To enter an alarm limit or condition for a block:   

 1. In the Database Manager,   double-click the block you want to modify from the database spread-
sheet.   

 2. From the block configuration   dialog box, click the Alarms tab. 

 3. In the Alarms area,   complete the fields for the analog blocks. For digital blocks, in the   Alarms 
Type area, select the type of alarm you want. 

 

Selecting an Alarm Priority

To select a block's alarm priority: 

 1. In the Database Manager,   double-click the block you want to modify from the database spread-
sheet.   

 2. From the block configuration   dialog box, click the Alarms tab. 

 3. From the Priority   area, select the alarm priority. 

 

Configuring a Tag to Require Electronic Signatures

To configure a tag to require Electronic Signature:

 1. In the Database Manager,   navigate to the Advanced tab of the tag's dialog box. 

 2. Select the type of   electronic signature that you want for this tag: 

 l None   – Do   not require Electronic Signatures for this tag at run time. This is the   default 
option. 

 l PerformOnly –   Require a Performed By signature for any changes or alarm acknow-
ledgements   to this tag at run time. 

 l Perform   and Verify –   Require both a Performed By and a Verified By signature for any 
changes   or alarm acknowledgements to this tag at run time. 

 3. Select the options   that you want for this tag: 

 l Allow   Continuous Use –   Select to allow the operator to repeatedly sign for successive 
actions   by supplying only a password. Continuous use applies only to the person   per-
forming an action and does not affect the person verifying an action.   This is selected by 
default. 

 l Exempt   Alarm Acknowledgement –   Select to allow operators to acknowledge alarms 
without entering a signature,   even when this tag requires electronic signature for data 
entry. 
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 l Comment Required – Select to open a dialog box to provide information needed for the 
comment. The comment is enforced depending on the option configured for the tag.

 4. Select how you want   the tag to handle unsigned writes. Your options are as follows:

 l Accept   –   Accept the unsigned write. 

 l Log   – When   an unsigned write is accepted, send a message indicating that the tag   accep-
ted an unsigned write. This option is only available when the tag   is configured to accept 
unsigned writes. 

 l Reject   – Reject   the unsigned write and do not update the database. A message is sent 
indicating   that the tag rejected an unsigned write. (default) 

NOTE: You must   have purchased the Electronic Signature option for these parameters to   take effect 
at run time.

 

Enabling or Disabling Block Collection by Historian

To enable or disable block collection by Historian:   

 1. In the Database Manager,   right-click the block you want to modify from the database spread-
sheet.   

 2. Select Enable Collection   to begin block collection by Historian. Select Disable Collection to stop   
block collection by Historian.

NOTES:

 l If Enable   Collection is unavailable from the menu, it means that the selected block   has already 
been designated for collection. Similarly, if Disable Collection   is unavailable, the selected 
block has been removed from collection by   Historian.

 l To modify   default GE Historian collection options, double-click the block and   on the GE His-
torian tab of the dialog box, choose the desired parameters.

TIP:   To view which blocks are collected, add the Collect column to the database;   it displays if a block 
is collected or not. For instructions, see Adding   Columns to a Spreadsheet.  

Managing Blocks

Click any of the following links for more information about managing   blocks:

 l Adding   Multiple Blocks to a Database

 l Selecting   a Database Block

 l Copying   and Pasting Blocks

 l Duplicating   Blocks

 l Moving   Blocks to Another Database

 

Adding Multiple Blocks to a Database
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 To add multiple blocks to a database:  

 1. In the Database Manager,   in Ribbon view, on the Home tab, in the Blocks group, click the Gen-
erate   button. 

- Or -

In Classic view, on the Blocks menu, click   Generate. 

The Generate Wizard appears.

 2. Use the Generate   Wizard to create the block you want. 

 

Selecting a Database Block

 To select a block type: 

 1. In the Database Manager,   double-click the type of block you want to create. 

 2. Complete the dialog   box that appears. Refer to the Database   Block Reference topic for more 
information about the block types available.   

 

Selecting a Block from the Generate Wizard

 To select a block from the Generate Wizard:

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Blocks group, click Generate.   

- Or -

In Classic view, on the Blocks menu, click   Generate.

A message about SAC appears.

 2. Click OK to continue.   The Generate Wizard dialog box appears.

 3. Click the browse   (...) button next to the Enter tag field to display the Select Tag Names   dialog 
box. The Select Tag Names dialog box appears.

 4. From the Nodes list   box, select the SCADA server containing the database block you want to   
use. 

 5. In the Enter Tag   Name field, enter the name of the block you want the Generate Wizard to   use as 
a template or select the block from the Tag Names list box. 

 6. Click OK.

 

Selecting a Column in the Generate Wizard

 To select a column for the Generate Wizard:

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Blocks group, click Generate.   
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- Or -

In Classic view, on the Blocks menu, click   Generate.

A message about SAC appears.

 2. Click OK to continue.   The Generate Wizard dialog box appears.

 3. Enter the required   information on each page of the wizard. Click Next until you are on page   3 of 
the wizard. 

 4. On page 3 of the   wizard, click the browse (...) button next to a field name to open the   Select 
Column dialog box.

 5. Double-click the   column (block field) that you want to use. The Select Column dialog box   closes 
and you return to page 3 of the wizard.

 6. Repeat steps 5-6   for each field name that you want to add.

 7. On page 3 of the   wizard, enter information into the Prefix, Start, End, Inc, and Suffix   field, as 
required.

 8. Click OK. When the   wizard creates the blocks you specified, it will assign a custom value   for the 
block fields you have selected.

 

 To copy and paste a block: 

 1. Select a cell in   the row you want to copy. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Clipboard   group, click Copy.

- Or -

In Classic view, click the Copy button on   the Database Manager's toolbar.

 3. Reload an empty or   existing database into memory. 

 4. In   Ribbon view, on the Home tab, in the Clipboard group, click Copy.

- Or -

In Classic view, click the Paste button   on the Database Manager's toolbar.

 

 

Duplicating Blocks

 To duplicate blocks: 

 1. Select the blocks   you want to duplicate. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Blocks group,   click Duplicate. 

- Or -

In Classic view, on the Blocks   menu, click Duplicate.

The Duplicate Blocks dialog box appears.   
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 3. In the New Tagnames   column, enter a new name for each block that you are duplicating. 

 4. Click OK to duplicate   the blocks. 

 

Moving Blocks to Another Database

 To move a block to another database: 

 1. Select the block   you want to move. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Clipboard   group, click Cut. 

- Or -

In Classic view, on the Database Manager's   toolbar, click the Cut button.

A message box with the following text appears:   
Delete tag [block] from spreadsheet and database? 

 3. Click Yes to cut   the block. 

 4. On the Database menu,   click Reload to close the current database and open the destination data-
base.   Save your changes when prompted. 

 5. Click the Paste button   on the Database Manager's toolbar when the destination database opens.   

 

Managing Databases

Click any of the following links for more information about managing   databases:

 l Merging   Two Databases

 l Verifying   a Database

 l Correcting   Verification Errors

 l Displaying   a Database Summary

 l Importing   a Database

 l Exporting   a Database

 l Changing   the Scanning Order of a Database's Blocks

 l Placing   a Block On or Off Scan

 l Saving   or Reloading a Database

 

Merging Two Databases
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  To   merge two databases: 

 1. In the Database Manager,   export each database. 

 2. Examine each export   file as follows: 

 a. Verify that   each block in each database has a unique name. 

 b. If two blocks   have the same name, change one. Remember to also change the text in the   
Next field of the previous block so that the chain remains intact. 

 3. Import one of the   databases you want to merge into an empty database.

 4. Import the other   database.
 

Verifying a Database

 To verify a database: 

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Diagnostics group, click   
Verify. 

- Or -

In Classic view, on the Database Menu, click   Verify.

If Database Manager detects no errors, the   following text appears: 
Database verified on node: [nodename]. No errors detected. 

 2. Click OK to acknowledge   the message. 

 3. If Database Manager   detects errors, the Verify Database dialog box appears. Correct the errors   
listed in the dialog box.

 

Correcting Verification Errors

 To correct verification errors: 

 1. In the Database Manager,double-click   an error you want to correct. 

 2. Edit the block dialog   box that appears. 

 3. Click Save, and place   the block back on scan when prompted. 

 4. Repeat steps 1 through   3 for each error listed. 

 

Displaying a Database Summary
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To display a database summary:

In the Database Manager, in Ribbon view,   on the Home tab, in the Diagnostics group, click Sum-
mary.

- Or -

In Classic view, on the Database   menu, click Summary.

The Database Summary for Node dialog box   appears.

The   Database Summary lists the database blocks by block type. By scrolling   through the list 
box, you can see how many blocks are used and allocated   for each block type. 

 l Database–   displays the name of the database. 

 l Size– indicates   the number of bytes actually in use by the database. 

 l SN– displays   the serial number of the database generated anytime a block is added to   or deleted 
from the database. Allows you to determine if the database   has been changed (by adding or delet-
ing a database block) since you last   saved it. To do this, record the serial number when you finish 
making   changes to the database. You can later compare that number with the number   displayed 
in the Database Summary dialog box. 

 l I/O Count–   displays the number of allocated blocks that use I/O. The block types   are AA, AI, AO, 
AR, BB, DA, DC, DI, DO, DR, MDI, and TX. 

 l Type– displays   the type of block. 

 l Used– lists   the number of blocks that exists for each block type. 

 l Allocated–   lists the number of blocks allocated per block type. Each SCADA node automatically   
pre-allocates a specific number of blocks for each block type to make   efficient use of memory 
and improve performance. The number of block allocated   equals the number of blocks of one type 
that fits in four kilobytes of   memory. Since blocks vary in size according to their type, the exact 
number   of blocks varies for each block type. 

 

Importing a Database

 To import a database: 

IMPORTANT:   Be aware that before you perform a large import, you should adjust the   spreadsheet 
refresh rate to 20 or more seconds. If you leave the refresh   rate at a low number, such as the default of 
5 seconds, and you try to   import a large amount of tags, the database may appear unresponsive. To   
adjust the refresh rate, in Classic view, on the Tools menu, click Options,   or in Ribbon view, on the 
Home tab, in the Settings group, click Options,   and then edit the value for the Spreadsheet Auto 
Refresh field, if it's   enabled. After this is done, you can import the database. 

 1. In the Database Manager,   in Ribbon view, on the Home tab, in the Process Database group, 
click   Import.

- Or -

In Classic view, on the Database Menu, click   Import.

The following   text appears: 
SAC will be stopped while blocks are being imported and then restarted. 
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 2. Select OK   to acknowledge the message. 

 3. Select the file you   want to import. 

NOTES:

 l If you are   using GE Historian as your Historian and you import and open a database   on a 
machine that does not have GE Historian 3.1 or above installed,   fields added for Historian col-
lection are disabled. Additionally, the   values for Historian fields are retained.

 l If you enabled   Automatically Configure Tags for Collection in Historian on the   Historian tab of 
the User Preferences dialog box, then:

 l All   imported tags will be added to the default collector and collection by   GE Historian 
are enabled.

 l If you    have an existing database and import a new database and both databases   con-
tain a tag with the same name, the existing database tag are overwritten   by the new 
database tag.

 l If you   have an existing database and those tags are not enabled for collection   in His-
torian, at reload time the tags are not enabled for collection.   In other words, this setting 
does not override Historian's settings.

 

Exporting a Database

 To export a database: 

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Process Database group,   
click Export. 

- Or -

In Classic view, on the Database   menu, click Export.

The Export Database Blocks... dialog box   appears.

 2. Select the path and   file type you want to use. 

 3. In the File Name   field, enter the file name. 

 

Changing the Scanning order of a Database's Blocks

 To change the scanning order of a database's blocks: 

 1. Export the database.

 2. Edit the export file.   

 3. In   the Database Manager, in Ribbon view, on the Home tab, in the Process   Database group, 
click Load Empty. 

- Or -

In Classic view, click the New button on   the Database Manager's toolbar.

 4. Import the edited   export file.
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Placing a Block On or Off Scan

 To place a block on or off scan when prompted: 

 l Click Yes to place   the block on scan. 

WARNING: Use   caution when placing a block on scan. Placing a block on scan may cause   data to be 
written to the hardware. 

 l Click No to place   the block off scan. 

To automatically place blocks on scan without being prompted:   

 1. In the Database Manager,   select the Do Not Prompt Next Time check box. 

 2. Click Yes to place   this block on scan and to automatically place all blocks on scan that   you 
modify in the future. 

TIP: You   can also set the on/off scan setting for the database using preferences.   For steps, refer to the 
Setting Database   Manager Preferences section.

 

Saving or Reloading a Database

Select the procedure you want to perform: 

 l Reload   a database.

 l Save   a database under a new database name.

IMPORTANT: When   you reload a database, all I/O points are reset to the appropriate starting   values. Do not 
use this function during an active production cycle. 

 

Working with the Spreadsheet

Click the appropriate link below for more information about working   with the spreadsheet:

 l Setting   Database Manager Preferences

 l Locating   Data

 l Refreshing   the Spreadsheet

 l Setting   Spreadsheet Properties and Appearance

 

Setting Database Manager Preferences

16 © 2020 General Electric Company. All rights reserved.



 To set Database Manager preferences: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Options. 

- Or -

In Classic view, on the View menu, click   Options.

The Options   Dialog Box appears. 

 2. Select the General   Options preferences you want to enable. 

 3. Select the View Options   preferences you want to enable. 

 4. Select the Edit Options   preferences you want to enable. 

 

Locating Data

Click the appropriate link below for more information about locating   data:

 l Finding   Data in a Spreadsheet

 l Finding   and Replacing Data in a Spreadsheet

 l Going   to Specific Locations in the Spreadsheet

 

Overview: Finding and Replacing Data

The Database Manager lets you find data and replace data within a spreadsheet.    For steps,   refer to the 
following sections:

 l Finding   Data in a Spreadsheet

 l Finding   and Replacing Data in a Spreadsheet

 

Finding Data in a Spreadsheet

 To find data in a spreadsheet: 

 1. Select the column   you want to search in. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Edit group,   click Find.

- Or -

In Classic view, on the Database Manager's   toolbar, click Find.

The Find dialog box appears.

 3. In the Find What   field, enter the text you want to locate. 

 4. Select the Match   Case check box to do a case sensitive search. Otherwise, clear it. 
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 5. Select the Match   Whole Words Only check box to locate only whole words that match the search   
string. Clear the check box to locate partial words. 

 6. Click Find Next.   

 7. Repeat step 6 to   locate subsequent occurrences of the specified text. 

 

Finding and Replacing Data in a Spreadsheet

 To find and replace data in a spreadsheet: 

 1. Select the column   or cell you want to search in. 

 2. In   the Database Manager, in Ribbon view, on the Home tab, in the Edit group,   click Replace. 

- Or -

In Classic view, on the Edit menu, click Replace.

The Replace dialog box appears.

 3. In the Find What   field, enter the text you want replaced. 

 4. In the Replace With   field, enter the replacement string. 

 5. To do a case sensitive   search, select the Match Case check box. Otherwise, clear it. 

 6. To locate only whole   words that match the search string, select the Match Whole Words Only   
check box. Clear the check box to locate partial words. 

 7. To replace text in   the current selection, click the Selection option button. Or, to replace   text in the 
selected column, click the Entire Column option button. 

 8. Click Find Next to   locate the first occurrence of the search string in the selected column.   

 9. Click Replace to   replace the text. 

 10. Repeat steps 7 and   8 to locate and replace subsequent occurrences of the search string. 

 

Going to Specific Locations in the Spreadsheet

You can go directly to a specific row, column, or block in a database.   

To go to a row:

 1. In   the Database Manager, in Ribbon view, on the Home tab, in the Edit group,   click Go to.

- Or -

In Classic view, on the Edit menu, click   Go To.

The Go To dialog box appears.

 2. From the Go to What   list box, select Row. 

 3. Enter the row number   you want to display. 
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 To go to a column:

 1. In   Ribbon view, on the Home tab, in the Edit group, click Go to.

- Or -

In Classic view, on the Edit menu, click   Go To.

The Go To dialog box appears.

 2. From the Go to What   list box, select Column. 

 3. Double-click the   column you want to display from the Select any column list box. 

 To go to a specific block:

 1. In   Ribbon view, on the Home tab, in the Edit group, click Go to.

- Or -

In Classic view, on the Edit menu, click   Go To.

The Go To dialog box appears.

 2. From the Go to What   list box, select Tag. 

 3. Click the browse   (...) button and double-click the block you want to display. 

 

Refreshing the Spreadsheet

Click the appropriate link below for more information about refreshing   the spreadsheet:

 l Automatically   Updating the Spreadsheet Data

 l Pausing   and Resuming Automatic Spreadsheet Updates

 l Manually   Refreshing the Spreadsheet

 

Updating the Spreadsheet Data

 To automatically update spreadsheet data:

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Options. 

- Or -

In Classic view, on the View menu, click   Options.

The Options   Dialog Box appears. 

 2. From the View Options   area, select Enable Spreadsheet Auto Refresh. 

 3. In the Enter refresh   period field, type in the refresh rate you want. 

IMPORTANT:   Be aware that for a large database, you should increase the refresh rate   to 20 or more 
seconds. Do not use the default of 5 seconds for large databases.   If you leave the refresh rate at low 
number, such as the default of 5   seconds, and you try to import a large amount tags, the database may 
appear   unresponsive. 
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Pausing and Resuming Automatic Spreadsheet Updates

 To pause and resume automatic spreadsheet updates: 

 1. In   the Database Manager, in Ribbon view, on the View tab, in the SpreadSheet   Settings group, 
click Pause. 

- Or -

In Classic view, on the Database Manager's   toolbar, click Pause.

 2. To resume updating   the spreadsheet:

In Ribbon   view, on the View tab, in the SpreadSheet Settings group, click Refresh.   

- Or -

In Classic view, on the Database Manager's   toolbar, click Refresh.

The spreadsheet resumes updating. 

 

Manually Refreshing the Spreadsheet

 To manually refresh the spreadsheet: 

In the   Database Manager, in Ribbon view, on the View tab, in the SpreadSheet   Settings group, 
click Refresh. 

- Or -

In Classic view, on the Database Manager's   toolbar, click the Refresh button.

 

Setting Spreadsheet Properties and Appearance

Click the appropriate link below for more information about setting   spreadsheet properties and appear-
ance:

 l Setting   Spreadsheet Colors

 l Setting   Spreadsheet Font Properties

 l Locking   or Unlocking Columns

 l Working   with Spreadsheet Column Properties

 l Sorting   the Database

 l Working   with Queries

 

Locking or Unlocking Columns from Scrolling Left or Right
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 To lock or unlock a column from scrolling left or right:   

 1. Select the column   you want to lock or unlock. 

 2. In   the Database Manager, in Ribbon view, on the View tab, in the SpreadSheet   Settings group, 
click Freeze Column. 

- Or -

In Classic view, on the View menu, click   Freeze Column.

 

Working with Spreadsheet Column Properties

Click the appropriate link below for more information about working   with spreadsheet column properties:

 l Adding   Columns to a Spreadsheet

 l Loading   Column Format Files

 l Saving   Column Format Files

 l Modifying   Column Headings

 l Modifying   Column Widths

 l Removing   Columns to a Spreadsheet

 l Removing   All Columns from a Spreadsheet

 l Arranging   Columns in a Spreadsheet

 l Overriding   the Default Column Layout

 l Restoring   the Default Column Layout

 

Adding Columns to a Spreadsheet

 To add a column to a spreadsheet: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click   
Properties. 

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Column   tab, and then double-click the column you want to add from the Available   
Columns list box. 

 

Loading Column Format Files
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 To load a format file: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Column   tab, and then click the Load button. 

 3. Enter the name of   the format file you want to open. 

 

 To save a column format file: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties   Dialog Box appears.

 2. Click the Column   tab, and then click the Save button. 

 3. Enter the name of   the format file you want to create. 

 

Modifying Column Headings

 To modify a column heading: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Column   tab. 

 3. From the Display   Columns list box, select a column. 

 4. In the Column Name   field, enter the heading you want for the column. 

 

Modifying Column Widths
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 To modify a column width: 

 1. In the Database Manager,   click and drag the right edge of the column heading. 

 2. Release the mouse   when the column is the correct size. 

 

Removing Columns to a Spreadsheet

 To remove a column from a spreadsheet: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Column   tab, and then double-click the column you want to remove from the Display   
Columns list box. 

NOTE: The   Tag Name column cannot be removed from the spreadsheet. 

 

Removing All Columns from a Spreadsheet

 To remove all columns from a spreadsheet: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Column   tab, and click Clear. 

NOTE: The   Tag Name column cannot be removed from the spreadsheet. 

 

Arranging Columns in a Spreadsheet

 To arrange the columns in a spreadsheet: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click   
Properties. 

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

© 2020 General Electric Company. All rights reserved. 23



 2. Click the Column   tab. 

 3. From the Display   Columns list box, select the column you want to move. 

 4. Click the up arrow   button to move the column left in the spreadsheet. Click the down arrow   button 
to move the column right in the spreadsheet. 

 

Overriding the Default Column Layout

 To override the default column layout: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Column   tab, and then create the layout you want as the new default. 

 3. Save the layout to   a file.

 4. Click OK to apply   the new layout to the database. 

 

Restoring the Default Column Layout

 To restore the default column layout: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Column   tab, and then click the Load button. 

 3. Double-click the   DEFAULT.FMT file. 

 4. Click OK to apply   the default layout to the database. 

 

Sorting the Database

Click the appropriate link below for more information about sorting   the database:

 l Loading   a Sort Order

 l Saving   a Sort Order

 l Adding   a Column to the Sort Order
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 l Removing   a Column from the Sort Order

 l Sorting   a Column in Ascending or Descending Order

 l Arranging   a Column in the Sort Order

 l Disabling   Sorting

 l Overriding   the Default Sort Order

 l Restoring   the Default Sort Order

 

Loading a Sort Order

 To load a sort order: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Sort tab,   and then click the Load button. 

 3. Enter the name of   the sort order file you want to open. 

 

Saving a Sort Order

 To save a sort order: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties   Dialog Box appears. 

 2. Click the Sort tab,   and then click the Save button. 

 3. Enter the name of   the sort order file you want to create. 

 

Adding a Column to the Sort Order

 To add a column to the sort order: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click   
Properties. 

- Or -
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In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Sort tab,   and then double-click the column you want to add from the Display Columns   
list box. 

 

Removing a Column from the Sort Order

 To remove a column from the sort order: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Sort tab,   and then double-click the column you want to remove from the Sort Order   List 
box. 

 

Sorting a Column in Ascending or Descending Order

 To sort a column in ascending order or descending order:   

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears. 

 2. Click the Sort tab,   and select the column you want to sort from the Sort Order list box. 

 3. Click the Ascending   button to sort a column in ascending order. Click the Descending button   to 
sort a column in descending order. 

 

Arranging a Column in the Sort Order

 To arrange the columns in the sort order: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click   
Properties. 

- Or -

In Classic view, on the View menu, click   Properties. 
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The Properties dialog box appears.

 2. Click the Sort tab,   and then select the column you want to move from the Sort Order list box.   

 3. To move the column   up in the list box, select the up arrow button. To move the column down,   
select the down arrow button. 

 

Disabling Sorting

 To disable sorting: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the view Menu, click   Properties.

The Properties dialog box appears.

 2. Click the Sort tab,   and remove all the columns from the Sort Order list box. 

 3. Click the Save button   and enter the name DEFAULT.SRT when prompted for a file name. 

 

Overriding the Default Sort Order

 To override the default sort order: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Sort tab,   and then define the sort order you want to use as the new default. 

 3. Save the sort order   to a file.

 4. Click OK to apply   the new sort order to the database. 

 

Restoring the Default Sort Order

 To restore the default sort order: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 
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The Properties dialog box appears.

 2. Click the Sort tab,   and then click the Load button. 

 3. Double-click the   DEFAULT.SRT file. 

 4. Click OK to apply   the default query to the database. 

 

Working with Queries

Click the appropriate link below for more information about working   with queries:

 l Creating   a Query

 l Loading   a Query

 l Saving   a Query

 l Appending   a New a Query to an Existing Query

 l Overriding   the Default Query

 l Restoring   the Default Query

 

Creating a Query

 To create a query: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties dialog box appears.

 2. Click the Query tab,   and enter the query you want. 

 

Loading a Query

 To load a query: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Query tab,   and then click the Load button. 

 3. Enter the name of   the query file you want to open. 
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Saving a Query

 To save a query: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties   Dialog Box appears. 

 2. Click the Query tab,   and then click the Save button. 

 3. Enter the name of   the query file you want to create. 

 

 To append a new query to the existing query: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click   
Properties. 

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Query tab,   and press the right arrow key to position the cursor at the end of the   field. 

 3. Enter the new query   you want to append. 

 

Overriding the Default Query

 To override the default query: 

 1. In   the Database Manager, in Ribbon view, on the Home or View tab, in the   Settings group, click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties Dialog Box appears.

 2. Click the Query tab,   and enter the query you want as the new default. 

 3. Save the query to   a file.

 4. Click OK to apply   the new query to the database. 

 

Restoring the Default Query
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 To restore the default query: 

 1. In the Database Manager,   in Ribbon view, on the Home or View tab, in the Settings group, click 
Properties.   

- Or -

In Classic view, on the View menu, click   Properties. 

The Properties dialog box appears.

 2. Click the Query tab,   and then click the Load button. 

 3. Double-click the   DEFAULT.QRY file. 

 4. Click OK to apply   the default query to the database. 

 

Setting Spreadsheet Colors

 To color a spreadsheet property: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties   Dialog Box appears. 

 2. Click the Color tab.   

 3. Select the property   you want to color. 

 4. Select the color   you want to assign to the selected property. 

 

Setting Spreadsheet Font Properties

 To set spreadsheet font properties: 

 1. In the Database   Manager, in Ribbon view, on the Home or View tab, in the Settings group,   click 
Properties. 

- Or -

In Classic view, on the View menu, click   Properties.

The Properties   Dialog Box appears. 

 2. Click the Font tab.   

 3. Select the font type,   style, and size for the text in the spreadsheet. 

 

Customizing the Database Manager
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Click the appropriate link below for more information on customizing   the Database Manager toolbar and 
the contents of the Tools menu: 

NOTE: The first   item in the list applies to Classic view only.  Ribbon   view includes all options.

 l Customizing   the Toolbar

 l Customizing   the Tools Menu

 

Customizing the Toolbar

Click the appropriate link below for more information about customizing   the toolbar:

NOTE: The following   list applies to Classic view only.  Ribbon   view includes all options.

 l Adding   a Button to the Database Manager's Toolbar

 l Removing   a Button from the Database Manager's Toolbar

 l Arranging   Buttons on the Database Manager's Toolbar

 

Adding a Button to the Database Manager's Toolbar

 To add a button   to Database Manager's toolbar: 

NOTE:   The following steps apply to Classic view only. Ribbon view includes all   options.

 1. In the Database Manager, in Classic view, on the Tools Menu, click   Customize. The Customize 
dialog box appears.

 2. Click the Toolbars   tab. 

 3. Click and drag the   button you want to add onto the toolbar. 

 

Removing a Button from the Database Manager's Toolbar

 To remove a button on the Database Manager's toolbar: 

NOTE:   The following steps apply to Classic view only. Ribbon view includes all   options.

 1. In the Database Manager, in Classic view, on the Tools Menu, click   Customize. The Customize 
dialog box appears.

 2. Select   the Toolbar Tab.

 3. Click and drag the   button you want to remove off the toolbar. 

 

Arranging Buttons on the Database Manager's Toolbar
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 To arrange the buttons on the Database Manager's toolbar:   

NOTE:   The following steps apply to Classic view only. Ribbon view includes all   options.

 1. In the Database Manager, in Classic view, on the Tools Menu, click   Customize. The Customize 
dialog box appears.

 2. Click and drag the   button you want to move to its new location. 

 

Customizing the Tools Menu

Click the appropriate link below for more information about customizing   the Tools menu:

 l Adding   a Menu Item to the Tools menu

 l Selecting   the Application to Launch from the Database Manager

 l Arranging   Menu Items on the Tools Menu

 l Removing   Menu Items from the Tools Menu

 l Launching   an Application

 

Adding a Menu Item to the Tools menu

 To add a menu item to the Tools menu: 

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Customize Tools group,   click 
the Customize Dialog Box Launcher. 

- Or -

In Classic view, on the Tools Menu, click   Customize.

The Customize   Dialog Box appears. 

 2. Click the Tools tab.   

 3. Select the application   you want to launch on the Database Manager.

 4. In the Menu Text   field, enter the text you want displayed in the Tools menu. 

 5. Enter any arguments   you want to use when the application runs. If you want to prompt the user   
for arguments, select the Prompt for Arguments check box instead. 

 6. Select the Place   Separator After This Entry check box to add a dividing line between this   menu 
entry and the next menu entry. 

 

 To select the application you want to launch: 

In the Database Manager, in Ribbon view,   on the Home tab, in the Customize Tools group, click 
Tools, then click   the application you want to launch. 

- Or -

In Classic view, on the Tools menu, click   the application you want to launch.
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Arranging Menu Items on the Tools Menu

 To arrange menu items on the Tools menu: 

 1. In the Database   Manager, in Ribbon view, on the Home tab, in the Customize Tools group,   click 
the Customize Dialog Box Launcher. 

- Or -

In Classic view, on the Tools Menu, click   Customize.

The Customize   Dialog Box appears.

 2. Click the Tools tab.   

 3. Select the menu entry   you want to move. 

 4. Click the up or down   arrow button to move the selected item in the direction you want. 

 

Removing Menu Items from the Tools Menu

 To remove a menu item from the Tools menu: 

 1. In the Database Manager,   in Ribbon view, on the Home tab, in the Customize Tools group, click 
the   Customize Dialog Box Launcher. 

- Or -

In Classic view, on the Tools menu, click   Customize. 

The Customize dialog box appears.

 2. Click the Tools tab.   

 3. Select the menu entry   you want to delete and click the Delete button. 

 

Launching Applications from the Tools Menu

 To launch an application: 

In the   Database Manager, in Ribbon view, on the Home tab, in the Customize Tools   group, click 
Tools, select an application. 

- Or -

In Classic view, on the Tools Menu, click   the application.

 

Database Block Reference
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Click one of the blocks listed below to get more information on the   individual block. 

A

Analog Alarm

Analog Input

Analog Output

Analog Register

B-C

Boolean

Calculation

D

Dead Time

Device Control

Digital Alarm

Digital Input

Digital Output

Digital Register

E-L

Event Action

Extended Trend

Fanout

Histogram

Lead Lag

M-Q   

Multi-State Digital

On-Off Control

Pareto

Program

PID
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R-S   

Ramp

Ratio Bias

Signal Select

SQL Data

SQL Trigger

Statistical Control

Statistical Data

T-Z 

Text

Timer

Totalizer

Trend

Analog Alarm Block

 

Purpose

The Analog Alarm (AA) block sends and receives analog data from the   I/O driver or OPC server to 
provide alarm control. Using this block you   can suspend alarms and define limits and priorities for each 
alarm. The   block can also wait a specified time interval before issuing an alarm,   close a contact when an 
alarm occurs, and automatically reissue and acknowledge   alarms. 

Features

The Analog Alarm block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Generates alarms   when values are outside of defined limits. 

 l Sends and receives   values from an I/O driver or OPC server when placed in Automatic mode.   

 l Receives values from   operator input in the iFIX WorkSpace, from scripts, from Program   blocks, 
or from Easy Database Access programs when operating in Manual   mode. 

 l Can be used in a   chain with exception-based or time-based processing.

 l Can be configured   using Continuous Output that allows blocks to attempt to write the contacts   
with every scan, even if the value being written in unchanged. Without   Continuous Output, the 
block only attempts to write to the defined contact   tag when a value has changed and it needs to 
be written to the PLC. (In   this instance, the write is a one-time attempt, so if it fails, the write   will 
not be retried until the block needs to write a new value.)
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NOTE:   Because the contact mode of “Never” does not reset the contact, the Continuous   Output option 
is not supported for this contact mode. 

 l Can be configured   using the Suppress COMM Alarm option, which allows you to separate the   ori-
ginal alarm condition from the COMM alarm, and return the AA block   to the same state as it was 
prior to a COMM alarm. If you disable the   Suppress COMM Alarm option,  AA   blocks handle one 
alarm at a time. (As a result, it is possible that acknowledgement   of a COMM alarm could cause 
the ACK bit in the PLC to be written, and   the original alarm condition, if already acknowledged, 
could re-alarm.)

 l Can be configured to enable the Event messaging (Suspend mode), which applies suppression 
behavior to disable alarm processing. When the tag is in suspend mode, the Alarm state is set to 
OK, the Alarm is an alarm message only and therefore, does not appear in the alarm summary. 
Alarm processing continues with each alarm state transition recorded in the alarm loggers but 
does not display in the alarm summary. The alarm state contact (tag) is not processed.

 l Can use linear scaling   on values received. The following formula is used to determine the linear   
scale value:

The equation for a line is Y = mX + b

Where Y is the scaled output value, X is   the raw value from the PLC, m is the slope of the 
line and b is the y   intercept.

The slope for our linearization is defined   by output range divided by the input.

m  =    (ScaleHigh   - ScaleLow ) / (RawHigh - RawLow) 

The y intercept is determined by using the   low values and the slope.

b = ScaleLow - m(RawLow)

In the analog block this results in the   block's current value is equal to the driver value 
times the slope plus   the y intercept.

X_CV = (IO value)m + b  

The driver value equates to the block current   value minus the y intercept divided by the 
slope. 

IO Value = (X_CV – b) / m

Analog Input Block

 

Purpose

The Analog Input (AI) block sends and receives analog data from an I/O   driver or OPC server every time 
the Scan, Alarm, and Control (SAC) program   scans the block. 

Features

The Analog Input block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Generates alarms   when values are outside of defined limits. 
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 l Sends and receives   values from an I/O driver or OPC server when placed in Automatic mode.   

 l Receives values from   operator input in the iFIX WorkSpace, from scripts, from Program   blocks, 
or from Easy Database Access programs when operating in Manual   mode. 

 l Can be used in a   chain with exception-based or time-based processing. 

 l Can use linear scaling   on values received. The following formula is used to determine the linear   
scale value:

The equation for a line is Y = mX + b

Where Y is the scaled output value, X is   the raw value from the PLC, m is the slope of the 
line and b is the y   intercept.

The slope for our linearization is defined   by output range divided by the input.

m  =    (ScaleHigh   - ScaleLow ) / (RawHigh - RawLow) 

The y intercept is determined by using the   low values and the slope.

b = ScaleLow - m(RawLow)

In the analog block this results in the   block's current value is equal to the driver value 
times the slope plus   the y intercept.

X_CV = (IO value)m + b  

The driver value equates to the block current   value minus the y intercept divided by the 
slope. 

IO Value = (X_CV – b) / m

 

Analog Output Block 

 

Purpose

The Analog Output (AO) block sends an analog signal to an I/O driver   or OPC server every time it 
receives a value from an upstream block, an   operator, a Program block, a script, or from its Initial Value 
field.   

Features

The Analog Output block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Can be used in a   chain with exception-based or time-based processing. 

 l Can read back the   current PLC value when iFIX starts or when the database is reloaded. Values   
are only read back once when the database is initialized. 

 l Can use linear scaling   on values received. The following formula is used to determine the linear   
scale value:

The equation for a line is Y = mX + b
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Where Y is the scaled output value, X is   the raw value from the PLC, m is the slope of the 
line and b is the y   intercept.

The slope for our linearization is defined   by output range divided by the input.

m  =    (ScaleHigh   - ScaleLow ) / (RawHigh - RawLow) 

The y intercept is determined by using the   low values and the slope.

b = ScaleLow - m(RawLow)

In the analog block this results in the   block's current value is equal to the driver value 
times the slope plus   the y intercept.

X_CV = (IO value)m + b  

The driver value equates to the block current   value minus the y intercept divided by the 
slope. 

IO Value = (X_CV – b) / m

 

Analog Register Block

 

Purpose

The Analog Register (AR) block reads and writes analog values to process   hardware. It provides both 
input and output capacity in a single block   using a minimum amount of memory because iFIX only pro-
cesses the block   when a picture that references it is open. 

Features

The Analog Register block: 

 l Is a primary block.   

 l Is always a stand-alone   block. 

 l Sends and receives   values from an I/O driver or OPC server. 

 l Requires no SAC processing.   

 l Lowers CPU overhead   when compared to an Analog Input block and increases SAC per-
formance.   

 l Is processed when   the picture containing the Analog Register block is displayed in the   iFIX 
WorkSpace, even when SAC is not running. The block is not processed   when another picture is 
displayed or when the operator exits the   iFIX WorkSpace. 

 l Accepts pulse count   or word value (register) analog signals, which are then converted to engin-
eering   units (EGU) for viewing. 

 l Accesses up to 1024   Analog points in the same poll record. 

 l Does not support    alarming. 

 l Can use linear scaling    on values received. The following formula is used to determine the linear   
scale value:

The equation for a line is Y = mX + b
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Where Y is the scaled output value, X is   the raw value from the PLC, m is the slope of the 
line and b is the y   intercept.

The slope for our linearization is defined   by output range divided by the input.

m  =    (ScaleHigh   - ScaleLow ) / (RawHigh - RawLow) 

The y intercept is determined by using the   low values and the slope.

b = ScaleLow - m(RawLow)

In the analog block this results in the   block's current value is equal to the driver value 
times the slope plus   the y intercept.

X_CV = (IO value)m + b  

The driver value equates to the block current   value minus the y intercept divided by the 
slope. 

IO Value = (X_CV – b) / m

 

Boolean Block

 

Purpose

The Boolean (BL) block calculates a single true/false output from multiple   inputs. 

Features

The Boolean block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Takes up to eight   input values and calculates a single output value. 

 l Can use alarm states   as inputs. 

 l Can be used in a   chain with time-based or exception-based processing. 

Calculation Block

 

Purpose

The Calculation (CA) block performs simple mathematical calculations   on the value passed by the 
upstream block and up to seven other constants   or block values. 

NOTE: The precision of calculations is fifteen digits. Round-off errors can occur in the sixteenth digit.

Features

The Calculation block: 
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 l Is a secondary block.   

 l Accepts the output   values and fields of other blocks. 

 l Accepts floating   point, integer, or exponential constants. 

 l Can be used in a   chain with time-based or exception-based processing. Note that if any   of the 
inputs (from B - H) are exception-based, the Calculation block   will not trigger when any of these 
change. 

Dead Time Block

 

Purpose

The Dead Time (DT) block can delay the transfer of an input value to   the next block in the chain. 

Features

The Dead Time block: 

 l Is an optional control   block. 

 l Is a secondary block.   

 l Sends values on to   the next block based on first-in, first-out (FIFO). 

 

Device Control Block

 

Purpose

The Device Control (DC) block coordinates the opening and closing of   digital devices on the plant floor 
based upon certain user-defined conditions.   This block allows for the timed operation of a device by con-
firming its   status with feedback signals. 

Features

The Device Control block:

 l Is a primary block.   

 l Is an optional batch   block. 

 l Can monitor up to   16 digital-input points and can output up to 8 digital-output points.   

 l Allows two feedback   signals (confirm Open and confirm Close) for each output. 

 l Can be placed on   scan by a RUN or CALL command in the Program block or through a Data link.   

 l Executes all commands   without interruption in Automatic mode. 

 l Suspends the execution   of all commands in Manual mode. 

Digital Alarm Block
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Purpose

The Digital Alarm (DA) block sends and receives digital data (1 or 0)   from an I/O driver or OPC server to 
provide alarm control. Using this   block, you can suspend alarms and define an alarm condition and an 
alarm   priority. The block can also wait a specified time interval before issuing   an alarm, close a contact 
when an alarm occurs, and automatically reissue   and acknowledge alarms. 

Features

The Digital Alarm block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Generates alarms   when values are outside of defined limits. 

 l Sends and receives   values from an I/O driver or OPC server when placed in Automatic mode.   

 l Receives values from   operator input in the iFIX WorkSpace, from scripts, from Program   blocks, 
or from Easy Database Access programs when operating in Manual   mode. 

 l Can be used in a   chain with exception-based or time-based processing.

 l Can be configured   using Continuous Output that allows blocks to attempt to write the contacts   
with every scan, even if the value being written in unchanged. Without   Continuous Output, the 
block only attempts to write to the defined contact   tag when a value has changed and it needs to 
be written to the PLC. (In   this case, the write is a one-time attempt, so if it fails, the write   will not 
be retried until the block needs to write a new value.)

 NOTE:   Because the contact mode of “Never” does not reset the contact, the Continuous   Output 
option is not supported for this contact mode. 

 l Can be configured   using the Suppress COMM Alarm option, which allows you to separate the   ori-
ginal alarm condition from the COMM alarm, and return the DA block   to the same state as it was 
prior to a COMM alarm. If you disable the   Suppress COMM Alarm option, DA blocks handle one 
alarm at a time. (As   a result, it is possible that acknowledgement of a COMM alarm could cause   
the ACK bit in the PLC to be written, and the original alarm condition,   if already acknowledged, 
could re-alarm.)

 l Can be configured to enable the Event messaging (Suspend mode), which applies suppression 
behavior to disable alarm processing but shows an alarm message. When the tag is in suspend 
mode, the Alarm state is set to OK. Since the Alarm is an alarm message only, it does not appear 
in the alarm summary. Alarm processing continues with each alarm state transition recorded in 
the alarm loggers; however, this does not display in the alarm summary. The alarm state contact 
(tag) is not processed. 

Digital Input Block

 

Purpose

The Digital Input (DI) block sends and receives digital data (1 or 0)   from an I/O driver or OPC server 
every time the Scan, Alarm, and Control   (SAC) program scans the block. 
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Features

The Digital Input block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Generates alarms   when values are outside of defined limits. 

 l Sends and receives   values from an I/O driver or OPC server when placed in Automatic mode.   

 l Receives values from   an operator input in the iFIX WorkSpace, from scripts, from Program   
blocks, or from Easy Database Access programs when operating in Manual   mode. 

 l Can be used in a   chain with exception-based or time-based processing. 

 

Digital Output Block 

 

Purpose

The Digital Output (DO) block sends a digital value (1 or 0) to an I/O   driver or OPC server every time it 
receives a value from an upstream block,   an operator, a Program block, a script, or from its Initial Value 
field.   

Because iFIX processes Digital Output blocks whenever a new value is   sent to the hardware, they gen-
erally operate as though they were latched.   If you configure a Digital Output block as a stand alone 
block, it outputs   a digital value each time the value changes. 

Features

The Digital Output block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Can be used in a   chain with exception-based or time-based processing. 

 l Can read back the   current PLC value when iFIX starts or when the database is reloaded. Values   
are only read back when the database is initialized. 

 l Can receive values   from a Program block or a script.

 l Can be configured   using the "Write if Different" output option to prevent a write   by the DO block if 
the value in the driver is the same as the value that   is to be written. The DO block will read the bit 
from the driver and if   different, execute the write. If the values are the same, no value is   written on 
this scan.

 

Digital Register Block 
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Purpose

The Digital Register (DR) block reads and writes digital values to process   hardware. It provides both 
input and output capacity in a single block   using a minimum amount of memory because iFIX only pro-
cesses the block   when a picture that references it is open. 

Features

The Digital Register block: 

 l Is a primary block.   

 l Is always a stand-alone   block. 

 l Sends and receives   values from an I/O driver or OPC server. 

 l Requires no SAC processing.   

 l Lowers CPU overhead   when compared to an Digital Input block and increases SAC per-
formance.   

 l Is processed when   the picture containing the Digital Register block is displayed in the   iFIX 
WorkSpace, even when SAC is not running. The block is not   processed when another picture is 
displayed or when the operator exits   the iFIX WorkSpace. 

 l Accepts pulse or   digital signals. 

 l Accesses up to 1024   digital I/O points in the same poll record. 

 l Does not support   alarming. 

 

Event Action Block

 

Purpose

The Event Action (EV) block tests the value or alarm condition of the   previous block using IF-THEN-
ELSE logic. Based upon the outcome of the   test expression, the block can then either open or close a 
digital point   or turn a block on or off scan. 

Features

The Event Action block: 

 l Is a secondary block.   

 l Has undefined default   values so that if a field is left blank, no action takes place. 

 l Tests up to two conditions   consecutively. 

Extended Trend Block

© 2020 General Electric Company. All rights reserved. 43



 
Purpose

The Extended Trend (ETR) block collects up to 600 values from an upstream   block. By using this block, 
you can trend up to 10 minutes worth of data   (assuming a one second scan time) with one block instead 
of chaining multiple   Trend blocks together. In addition, you can store several hours, or even   days of real-
time data, by combining different scan rates in conjunction   with the Average Compress field. 

The upstream primary block in the chain determines Extended Trend block's   scan time. When the block 
receives a value, it stores the data and passes   it to the next downstream block immediately. You can 
display data collected   by the block using a chart in the iFIX WorkSpace. 

Note that the process database also provides a Trend block. This block   trends up to 80 values. If you 
need to trend more than 80 values, use   the Extended Trend block. 

Features

The Extended Trend block: 

 l Is a secondary block.   

 l Stores up to 600   values from an upstream block in a First In, First Out (FIFO) queue. 

 l Averages groups of   data (optional) and stores the averages for trending. 

 l Displays values in   the iFIX WorkSpace through a chart. 

 l Uses data in conjunction   with Easy Database Access programs. 

 

Fanout Block 

 

Purpose

The Fanout (FN) block sends the value it receives to the Next Block   and up to four additional blocks. 
The block listed as a Next Block receives   the value immediately. The additional destination blocks 
receive the value   the next time iFIX scans those blocks. If the destination block is in   Manual mode, the 
update is instantaneous. 

Features

The Fanout block: 

 l Is a secondary block.   

 l Sends values to blocks   that are in the same database. 

 l Requires that the   target primary blocks be in Manual mode to receive values. 

 l Can only send values   to a Trend block that is in the Next Block field. 

 l Does not place blocks   on scan by sending its values. 

 l Does not generate   alarms. 

 l Can be used in a   chain with exception-based or time-based processing. 
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Histogram Block

 

Purpose

The Histogram (HS) block records how frequently a value occurs during   a specified period. 

Features

The Histogram block: 

 l Is an optional statistical   process block. 

 l Is a secondary block.   

 l Receives values from   an upstream block. 

Display Considerations 

The Histogram block displays only previously collected values. The Group   field determines the number 
of values the block collects before it displays   them. For example, if the upstream block's scan rate is 5 
seconds and   you specify a Group value of 10, the chart only reflects the values collected   during the last 
50 seconds. 

Meanwhile, the Histogram block is collecting another set of values,   which it will display at the end of the 
next 50-second, scan interval.   Note that if the upstream block is taken off scan, the histogram does   not 
register the frequency-of-occurrence data. 

 

Lead Lag Block 

 

Purpose

The Lead Lag (LL) block allows you to simulate process dynamics by combining   the advantages of lead 
and lag compensation strategies. 

TIP: We suggest you   use this block only if you are thoroughly familiar with lead lag theory.   If you simply need 
a time delay, consider using the Dead Time block.

The Lead Lag formula is: 

Output=C3[C1(Input-Prior Output)+(Input*Scan time)+C2(Prior Output)]   

C1, C2, and the scan time (of the primary block) are in seconds. K is   the constant defined in the block's 
Constant field. 
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Features

The Lead Lag block: 

 l Is an optional control   block. 

 l Is a secondary block.   

 l Lets the lead dominate   if the lead time is greater than the lag time. 

 l Lets the lag dominate   if the lag time is greater than the lead time. 

NOTE: Lead compensation   tends to improve the rise time and overshoot of the system, but increases   the 
dead band. Lag compensation improves the steady-state response, but   results in a longer rise time since the 
dead band decreases. 

 

Multistate Digital Input Block 

 

Purpose

The Multistate Digital Input (MDI) block provides a means of monitoring   the state of one, two, or three 
related digital inputs. The block produces   a raw input value (0 - 7) based on digital values it receives from 
an   I/O driver or OPC server every time the Scan, Alarm, and Control (SAC)   program scans the block. 

Features

The Multistate Digital Input block: 

 l Is a primary block.   

 l Can be used as a   stand-alone block. 

 l Provides more detailed   information about a device than a Digital Input block. 

 l Generates alarms   when values are outside of defined limits. 

 l Receives values from   up to three driver I/O addresses or OPC servers. 

 l Receives values from   Program blocks or from Easy Database Access programs. 

 l Can be used in a   chain with exception-based or time-based processing. 

 

On-Off Control Block 

 

Purpose

The On-Off Control (BB) block opens and closes up to two digital outputs   based upon an incoming ana-
log value or an operator input. 

Features

The On-Off Control block: 
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 l Is an optional control   block. 

 l Is a secondary block.   

 l Must receive input   from an upstream Analog Input or Analog Alarm block. 

 l Controls one or two   digital outputs automatically, when operated in Automatic mode. 

 l Allows an operator   to open and close the high and low contacts from the iFIX WorkSpace,   when 
operated in Manual mode. 

 l Can be used in a   chain with exception-based or time-based processing. 

 

Pareto Block

 

Purpose

The Pareto (PA) block can accept up to eight inputs and calculate percentages   for them. 

Features

The Pareto block: 

 l Is an optional statistical   process control block. 

 l Is a primary block.   

 l Is a stand-alone   block. 

 l Accepts up to eight   inputs from blocks, such as Analog Input and Totalizer blocks, or through   
operator entries. 

 l Continually calculates   the percentage of the total inputs. 

 l Maintains two sets   of values: one sorted in ascending or descending order; the other unsorted.   
Unsorted values remain in their order of entry on the Pareto block dialog   box. 

 l Can be used in a   chain with exception-based or time-based processing. 

 

PID Block

 

Purpose

The PID block maintains balance in a closed loop by changing the controlled   variable (an analog output) 
in response to deviations from a user-defined   set point. The difference between the actual value (an ana-
log input) and   the set point value is the error, or deviation. 

In response to errors, the PID block calculates an appropriate control   output signal, which attempts to 
reduce the error to zero. The adjustment   that the PID block makes is a function of the difference 
between the set   point and the measurement, in addition to the values of the proportional   band, the reset, 
and the rate. 
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Features

The PID block: 

 l Is an optional control   block. 

 l Is a secondary block.   

 l Ultimately receives   its value from an upstream Analog Input block even though secondary blocks   
can intervene between the AI and the PID block in the chain. 

 l Bases its control   period on the scan time selected for the upstream Analog Input block.   

 l Can send output to   another control block or to an Analog Output block. 

 l Can have its set   point value changed by: 

 l The output of a master   PID block (cascaded set point). 

 l Operator entry into   a Data link that references a Target Value field. 

 l A SETTARG Program   block command (in the Batch option) or a script. 

 l A change in the value   of an Analog Input block that is specified as the PID block's set point.   

 l A change in the value   of an Analog Input block connected to a Fanout block. The Fanout block   
would have the PID block's name listed in its Destination field. 

NOTE: When using   a Fanout block in this manner, you must append the field F_TV1 to the   PID block's 
name. 

 l Maintains the balance   in the process loop when operating in Automatic mode. 

 l Suspends updates   to the PID algorithm when operating in Manual mode. You can change block   
parameters, such as the Set Point, Tuning Parameters, and Engineering   Units Output from the 
keyboard in Manual mode. 

 

Program Block

 

Purpose

The Program (PG) block provides a powerful means of running short programs   to increase the degree of 
automation in your process or to assist in batch   control. For a list of the supported commands that you 
can use in programming   statements within this block, refer to the Program   Block Commands section. 

Features

The Program block: 

 l Is a Batch block.   

 l Works in Automatic   mode by executing all programming commands without interruption. 

 l Works in Manual mode   by suspending the execution of programming commands until the block 
returns   to Automatic mode. When returned to Automatic mode, the Program block   continues 
executing commands where it left off. 
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 l Cannot execute time-related   commands, such as WAITFOR, CALL, MAXWAIT, WAITSTAT, 
SETDEBUG, and DELAY,   when the scan time is either 0 or exception-based. 

 l Triggers an immediate   scan on manual inputs. For example, if AI1 is in manual mode and the Pro-
gram   block contains the command SETOUT AI1 50, an immediate scan of AI1 occurs   when the 
Program block runs. 

 

Ramp Block

 

Purpose

The Ramp (RM) block decreases or increases a target output value. The   block provides up to three 
stages for ramping values. Each ramp stage   lets you specify a target value and a ramp rate. The first 
two stages   also provide a hold time. At each scan cycle, the Ramp block sends its   output value to the 
block specified in the Next Block field. 

Features

The Ramp block: 

 l Is a primary block.   

 l Is a control block.   

 l Can be used as a   stand-alone block. 

 l Can have a ramp rate   manually changed in the iFIX WorkSpace through a Data link. 

 l Can have a target   value manually changed in the iFIX WorkSpace through a Data link   or by the 
Program block's SETTARG command. 

 l Can have a hold time   manually changed in the iFIX WorkSpace through a Data link or   by the Pro-
gram block's SETTIME command. 

 l Can send its value   to any secondary block. 

 l Operates in Automatic   mode by initializing its current value based on the Low Limit value. On   a 
transition to Automatic mode, the Ramp block begins the ramping process   from where it last left 
off, using either the value it had reached when   it was placed in Manual mode, or the latest values 
from the WorkSpace   if the operator entered values while the block was in Manual mode. 

 l Operates in Manual   mode by initializing its current value from either a manual entry or the   Low 
Limit value. On a transition to Manual, iFIX suspends ramping until   the block is returned to Auto-
matic mode. The last current value of the   block is output until the block is switched back to Auto-
matic mode. 

 

Ratio Bias Block 
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Purpose

The Ratio Bias (RB) block lets you change an incoming signal by adding   a constant (bias) and/or by mul-
tiplying by a constant (ratio). The block   calculates the constant by subtracting an offset from the signal. 

The following equation illustrates this method: 

Output = Ratio (Input - Offset) + Bias 

NOTE: This is a variation   of y = mx + b. 

Features

The Ratio Bias block: 

 l Is a control block.   

 l Is a secondary block.   

 l Can be used in a   chain with exception-based or time-based processing. 

 

Signal Select Block

 

Purpose

The Signal Select (SS) block provides a means of sampling up to six   inputs, manipulating the inputs 
according to a user-selected mode, and   sending the result to the next block. 

Features

The Signal Select block: 

 l Is a secondary block.   

 l Supports changing   the Selected Mode from a Data link, Program block, or Easy Database 
Access   program. 

 l Accepts multiple   inputs and generates one output. 

 

SQL Data Block

 

Purpose

The SQL Data (SQD) block identifies the data to read or write when a   SQL Trigger block executes. The 
SQL Data block transfers data between   the iFIX process database and your relational database. 

Features

The SQL Data block: 
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 l Is a secondary block.   

 l Only follows an SQL   Trigger block. 

 l Identifies up to   20 block and field name pairs. 

 l Chains to other SQL   Data blocks. 

 l Determines the direction   of data transfer. 

 

SQL Trigger Block

 

Purpose

The SQL Trigger (SQT) block lets iFIX execute SQL commands. 

Features

The SQL Trigger block: 

 l Is a primary database   block. 

 l Runs as a stand alone   block, but is usually followed by at least one SQL Data block. 

 l Determines which   SQL command in the SQL Library Table to use in handling process data.   

 l Determines when to   execute the SQL command. 

 l Defines the selection   mode. 

 

Statistical Control Block 

 

Purpose

The Statistical Control (SC) block lets you adjust a value from another   block by calculating the average 
offset and the rate of deviation from   the average XBARBAR. 

Features

The Statistical Control block: 

 l Is a statistical   block. 

 l Is a secondary block   that can only be preceded by a Statistical Data block. 

 l Uses an approximate   curve to determine slope and deviation values. 

 l Only calculates an   adjustment value if the upstream Statistical Data block generates an alarm;   
the Statistical Control block bases its adjustment on the alarm it receives.   

 l Is disabled if the   alarms on the Statistical Data block are disabled. 
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 l Operates in Automatic   mode by automatically passing the adjustment value to the block spe-
cified   in the Add To field. 

 l Operates in Manual   mode by calculating the adjustment value, but not passing it to another   block. 

 l Passes its adjustment   to other blocks such as the Analog Output, PID, and Ramp blocks. 

 

Statistical Data Block 

 

Purpose

The Statistical Data (SD) block collects and performs statistical calculations   on data. 

Features

The Statistical Data block: 

 l Is a statistical   block. 

 l Can be used as a   stand-alone block. 

 l Can only be followed   by a Statistical Control block, if appropriate. 

 l Receives data from   Analog Input, Analog Output, Analog Alarm, and Calculation blocks through   
the Input field, not from a previous block's Next Block field. 

 l Supports from 12   to 50 groups and from 1 to 25 observations per group. 

 l Performs alarming   and charting on control and warning limits. 

 l Provides out of process   control alarms. 

 l Operates in Automatic   mode by accepting automatic updates. 

 l Operates in Manual   mode by accepting manual updates from operators or from Easy Database   
Access programs. 

 l Can be used in a   chain with exception-based processing if you do not enter a time in the   Wait 
Time field. 

 

Text Block

 

Purpose

The Text (TX) block reads and writes text from your process hardware   or an OPC server. When the 
block receives text, it sends the data to all   enabled alarm destinations assigned to the block's alarm 
areas. 

Features

The Text block: 
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 l Is a primary block.   

 l Reads up to 80 characters.   

 l Allows operators   to write up to 80 characters from the iFIX WorkSpace. 

 l Displays a null-terminated   message through a Data link referencing the A_CV field. 

 l Operates in Automatic   mode by reading or writing its current value. 

 l Operates in Manual   mode by disabling its processing. 

 l Supports the SIM   driver. 

IMPORTANT: You   can only use the Text block with drivers that support it. Check with your   local GE 
distributor for the availability of TX-compatible I/O drivers.

 

Timer Block 

 

Purpose

The Timer (TM) block functions as a time counter by incrementing or   decrementing its value. 

Features

The Timer block: 

 l Is a secondary block.   

 l Passes the value   (0 or 1) from its upstream block to the downstream block. 

 l Can be chained from   a Digital Input block, a Digital Alarm block, or a Boolean block. The   Timer 
block can also be chained from a Digital Output block but only if   the Digital Output block is part of 
an chain that starts with a scanned   block. 

 l Cannot be chained from an AR or DR block, as these blocks are not processed by SAC.

 l Starts counting from   a preset value or zero. 

 l Increments its value   up to 365 days or until reset. 

 l Decrements its value   to a target value or to zero. 

 l Triggers an alarm   upon reaching a target value. 

 l Can suspend counting   using a digital block. 

 l Resets when the digital   upstream block changes from zero to one. 

 

Totalizer Block 

 

Purpose

The Totalizer (TT) block maintains a floating-point total for values   passed to it from upstream blocks. 
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Features

The Totalizer block: 

 l Is a secondary block.   

 l Displays values in   the iFIX WorkSpace and passes values to downstream blocks with   up to 15 
digits of precision. 

 l Can be reset by using   a SETOUT command from the Program block, a PUT operation from a 
Easy Database   Access program, reloading the process database, or restarting the computer. 

 l Can be used in a chain with exception-based or time-based processing.

 l Cannot be chained from an AR or DR block, as these blocks are not processed by SAC.

 

Trend Block

 

Purpose

The Trend (TR) block can collects up to 80 values over a period of time.   You can trend these values by 
connecting the block to a chart in the   iFIX WorkSpace. 

The upstream primary block in the chain determines Trend block's scan   time. When the block receives a 
value, it stores the data and passes it   with negligible dead time (transportation delay) to the next down-
stream   block immediately. 

Features

The Trend block: 

 l Is a secondary block.   

 l Stores up to 80 values   from an upstream block in the First In, First Out (FIFO) queue. 

 l Can be chained to    other Trend blocks to trend more than 80 values. 

 l Averages groups of   data and stores the averages for trending. 

 l Displays its data   in a picture through a chart. 

 l Uses data in conjunction   with Easy Database Access programs. 

 

Database Block Field Reference
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Click one of the blocks listed below to get a list of fields for each   block. 

A 

Analog   Alarm

Analog   Input

Analog   Output

Analog   Register

B-C   

Boolean

Calculation

D 

Dead   Time

Device   Control

Digital   Alarm

Digital   Input

Digital   Output

Digital   Register

E-L   

Event   Action

Extended   Trend

Fanout

Histogram

Lead Lag

M-Q   

Multistate   Digital Input

On-Off   Control

Pareto

PID

Program
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R-S   

Ramp

Ratio   Bias

Signal   Select

SQL Data

SQL   Trigger

Statistical   Control

Statistical   Data

T-Z 

Text

Timer

Totalizer

Trend

 

Analog Alarm Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry 

A_AACK A block and field to use for alarm 
acknowledgment.   

Block.field 

A_ADI The blocks alarm areas. N/A. This field is 
provided for backward 
compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the blocks alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display 
only field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display 
only field. 

A_ALMSN The serial number of the alarm area 
database. 

N/A. This is a display 
only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in 
and out of alarm   before it is acknow-
ledged.

N/A. This is a display 
only field. 

A_ALMSHELFREMTIME

F_ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display 
only field. 
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A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display 
only field. 

A_ALMSHELVEPOLICY The name of alarm shelving policy. N/A. This is a display 
only field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display 
only field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display 
only field. 

A_ALM_
SUSPENDMODE

F_ALM_SUSPENDMODE
 

Configures Event messaging (Sus-
pend mode), which applies to the pro-
cess alarm limit as an event. 

Enable: Yes (1), or Dis-
able: No (0). 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the 
block. 

ALL or an alarm area 
name. 

A_ASUSP A block and field that controls 
whether the Analog   Alarm block pro-
cesses alarms. 

Block.field 

A_AUTO 
F_AUTO 

The current automatic/manual status 
of the block.   

Automatic (1) or Manual 
(0). 

A_CCDEV The digital block to close when devi-
ation alarms occur.   

FIX32.node.block.field 

A_CCHH The digital block to close when High 
High alarms occur.   

FIX32.node.block.field 

A_CCHI The digital block to close when High 
alarms occur.   

FIX32.node.block.field 

A_CCLL The digital block to close when Low 
Low alarms occur.   

FIX32.node.block.field 

A_CCLO The digital block to close when Low 
alarms occur.   

FIX32.node.block.field 

A_CCOTH The digital block to close when other 
alarms occur.   

FIX32.node.block.field 

A_CCROC The digital block to close when Rate 
of Change alarms   occur. 

FIX32.node.block.field 

A_CHALM The chains most severe alarm. N/A. This is a display 
only field. 

A_COMM_SURPRESS
F_COMM_SURPRESS

Sets whether COMM alarms are sup-
pressed for this block.   

When selected, this option separates 
the original   alarm condition from the 
COMM alarm, and returns the block 
to the same   state as it was prior to a 
COMM alarm. For example, if prior to 
the COMM   alarm, the AA block was 

Enable (1) or Disable (0).
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an active alarm but already acknow-
ledged, that   is the state it should 
return to after communication is 
restored.

If disabled, AA blocks handle one 
alarm at a time.   As a result, it is pos-
sible that acknowledgement of a 
COMM alarm could   cause the ACK 
bit in the PLC to be written, and the 
original alarm condition,   if already 
acknowledged, could re-alarm.

A_CTK_PERSIST
F_CTK_PERSIST

Sets whether blocks allow write 
attempts to the contact(s)   with every 
scan, even if the value being written 
is unchanged. 

When disabled, the AA block only 
attempts to write   to the defined con-
tact tag when a value has changed 
and it needs to be   written to the PLC. 
The write is a one-time attempt, so if 
it fails, the   write will not be retried until 
the block needs to write a new value.

NOTE: There   are four modes for the 
contacts - “Acknowledge”, “Return”, 
“All Clear”,   and “Never” - that control 
when the contact is cleared. Since 
the contact   mode of “Never” does not 
reset the contact, the Continuous Out-
put option   is not supported for this 
contact mode. 

Enable (1) or Disable (0).

A_CUALM The blocks current alarm. N/A. This is a display 
only field. 

A_CV 
E_CV
F_CV 

The blocks current value. A numeric value within 
the EGU range. 

A_DALM
F_DALM

Whether to delete alarm from sum-
mary queue after acknowledgment.

0 (false) or 1 (true).

A_DBAND 
F_DBAND 

The maximum fluctuation the block 
accepts without   re-issuing an alarm. 

A numeric value within 
the EGU range. 

A_DESC The text in the blocks Description 
field. 

Up to 256 characters.  

A_DEV 
E_DEV
F_DEV 

The blocks deviation alarm limit. A numeric value within 
the EGU range. 

A_DTDEV The length of time to wait before gen-
erating deviation   alarms. 

Any time from 
00:00:00:00 to 
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03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTHH The length of time to wait before gen-
erating High   High alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTHI The length of time to wait before gen-
erating High   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTLL The length of time to wait before gen-
erating Low Low   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTLO The length of time to wait before gen-
erating Low alarms.   

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTOTH The length of time to wait before gen-
erating other   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DTROC The length of time to wait before gen-
erating rate   of change alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).    

A_DVALM The current alarm status for deviation 
alarms. 

N/A. This is a display 
only field. 

A_DVPRI The alarm priority of deviation alarms. Low, Medium, or High. 

A_EGUDESC The blocks engineering units label. Up to 33 characters. 

A_EHI 
E_EHI
F_EHI 

The blocks high EGU limit. A numeric value. The 
range between the low 
and high   values value 
cannot exceed 
3.40282300000000e+38.

A_ELO 
E_ELO
F_ELO 

The blocks low EGU limit. A numeric value. The 
range between the low 
and high   values value 
cannot exceed 
3.40282300000000e+38.
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A_ENAB 
F_ENAB 

The blocks alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_EOUT Yes, if the block writes data to the pro-
cess hardware,   or No, if the block 
does not. 

Yes or No. 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag 
without entering a signature, even if 
this tag requires electronic   signatures 
for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_COMMENT

F_ESIGREQ_COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accep-
ted or rejected by   this tag or accepted 
and logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the blocks 
engineering   units label. 

N/A. This field is 
provided for backward 
compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display 
only field. 

A_HHALM The current alarm status for High 
High alarms. 

N/A. This is a display 
only field. 

A_HHPRI The alarm priority of High High 
alarms. 

Low, Medium, or High. 

A_HI
E_HI
F_HI 

The blocks High alarm limit. A numeric value within 
the EGU range. 

A_HIHI 
E_HIHI
F_HIHI 

The blocks High High alarm limit. A numeric value within 
the EGU range. 

A_HIALM The current alarm status for High 
alarms. 

N/A. This is a display 
only field. 

A_HIPRI The alarm priority of High alarms. Low, Medium, or High. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is 
under collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE The type of Collector deadband set- Absolute (0) or Per-
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F_HIST_COMPTYPE ting. centage (1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. 
The value   of this field must be greater 
than the value of the A_HIST_
OFFSET and   F_HIST_OFFSET 
fields.

Use the following formula to determ-
ine if the entered   value is acceptable 
for this field.

A_/F_HIST_INTERVAL > A_/F_
HIST_OFFSET * 1000 

NOTE: The   values for the A_HIST_
OFFSET and F_HIST_OFFSET 
fields are in seconds.   

A float value, in mil-
liseconds. Values must 
be entered   in increments 
of 100. Minimum value: 
100 ms.

A_HIST_OFFSET
F_HIST_OFFSET

The block's collection offset time.The 
value of this   field must be less than or 
equal to the value of the A_HIST_
INTERVAL and   F_HIST_INTERVAL 
fields.

Use the following formula to determ-
ine if the entered   value is acceptable 
for this field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The   values for the A_HIST_
INTERVAL and F_HIST_INTERVAL 
fields are in milliseconds.   

A numeric value, in 
seconds. Must use 
whole numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display 
only field. 

A_IOAD The blocks I/O address. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IODV The name of the blocks I/O driver. Depends on your driver. 
Refer to your driver 
manual   for more inform-
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ation. 

A_IOHT The I/O drivers hardware options. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOSC The type of signal conditioning used 
by the block.   

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ISCAN The initial scan status (on or off) of 
the block.   

On or Off 

A_LAALM The blocks most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display 
only field. 

A_LLALM The current alarm status for Low Low 
alarms. 

N/A. This is a display 
only field. 

A_LLPRI The alarm priority of Low Low alarms. Low, Medium, or High. 

A_LO 
E_LO
F_LO 

The blocks Low alarm limit. A numeric value within 
the EGU range. 

A_LOALM The current alarm status for Low 
alarms. 

N/A. This is a display 
only field. 

A_LOLO 
E_LOLO
F_LOLO 

The blocks Low Low alarm limit. A numeric value within 
the EGU range. 

A_LOPRI The alarm priority of Low alarms. Low, Medium, or High. 

A_MDEDV When to open the deviation alarms 
contact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDEHH When to open the High High alarms 
contact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDEHI When to open the High alarms con-
tact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDELL When to open the Low Low alarms 
contact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDELO When to open the Low alarms con-
tact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDEOT When to open the other alarms con-
tact. 

Acknowledge, Return, 
All Clear, or Never. 

A_MDERC When to open the contact for Rate of 
Change alarms.   

Acknowledge, Return, 
All Clear, or Never. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display 
only field. 
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A_NAME The blocks type, for example AI for an 
Analog Input   block. 

N/A. This is a display 
only field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the 
chain. 

N/A. This is a display 
only field. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display 
only field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display 
only field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display 
only field. 

A_OPCTIME The time and date from the OPC 
server. 

N/A. This is a display 
only field. 

A_OTALM The current alarm status for other 
alarms. 

N/A. This is a display 
only field. 

A_OTPRI The alarm priority of other alarms. Low, Medium, or High. 

A_PDR_ACCESSTIME
F_PDR_ACCESSTIME

Reserved. N/A.

A_PDR_ARRAYLENGTH
F_PDR_ARRAYLENGTH

Reserved. N/A.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved. N/A.

A_PDR_DISABLEOUT
F_PDR_DISABLEOUT

Reserved. N/A.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved. N/A.

A_PDR_UPDATERATE
F_PDR_UPDATERATE

Reserved. N/A.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display 
only field. 

A_PRI The blocks alarm priority. Low, Medium, or High. 

A_PRIM The blocks name. N/A. This is a display 
only field. 

A_RATDV The length of time to wait before re-
issuing deviation   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RATHH The length of time to wait before re-
issuing High   High alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RATHI The length of time to wait before re- Any time from 
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issuing High   alarms. 00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RATLL The length of time to wait before re-
issuing Low Low   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).    

A_RATLO The length of time to wait before re-
issuing Low alarms.   

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RATOT The length of time to wait before re-
issuing other   alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RATRC The length of time to wait before re-
issuing Rate   of Change alarms. 

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_RCALM The current alarm status for Rate of 
Change alarms.   

N/A. This is a display 
only field. 

A_RCPRI The alarm priority for Rate of Change 
alarms. 

Low, Medium, or High. 

A_ROC
E_ROC 
F_ROC 

The maximum, acceptable change in 
the blocks value   that can occur 
between scan periods. 

A numeric value within 
the EGU range. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCALE_CLAMP
F_SCALE_CLAMP

Whether the data received or sent will 
be limited   to the ranges specified in 
the following fields:

 l A_/E_/F_SCALE_HIGH

 l A_/E_/F_SCALE_LOW

 l A_/E_/F_SCALE_RAWHIGH

 l A_/E_/F_SCALE_RAWLOW

Yes (1) or No (0).

A_SCALE_ENABLED
F_SCALE_ENABLED

Whether linear scaling is enabled. Yes (1) or No (0).

A_SCALE_HIGH
E_SCALE_HIGH

The high limit of the sent values. A numeric value.
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F_SCALE_HIGH

A_SCALE_LOW
E_SCALE_LOW
F_SCALE_LOW

The low limit of the sent values. A numeric value.

A_SCALE_RAWHIGH
E_SCALE_RAWHIGH
F_SCALE_RAWHIGH

The high limit of the received values. A numeric value.

A_SCALE_RAWLOW
E_SCALE_RAWLOW
F_SCALE_RAWLOW

The low limit of the received values. A numeric value.

A_SCALE_USEEGU
F_SCALE_USEEGU

Whether Engineering Units are used 
for scaling block   output.

Yes (1) or No (0).

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The blocks scan time and phase. E for exception-based 
processing, 0 for one 
shot processing,   or 
time:phase for time-
based processing. 

A_SMOTH The smoothing value. 0 to 15. 

A_TAG The blocks name. N/A. This is a display 
only field. 

A_TARG 
F_TARG 

The blocks optimum value or block 
and field name followed   by:

 l R if the value   is retrieved from 
a block.

 l L if the value   is local. 

Block.field or a numeric 
value within the EGU 
range.   

A_TRTAG The blocks deviation alarm limit. A numeric value within 
the EGU range. 

A_TYP1 
through 
A_TYP7 

Text describing each type of alarm 
the block generates.   

Up to 3 characters. 

A_WARM Yes or No. N/A. This is a display 
only field. 

A_ALMACK
F_ALMACK

Reserved. N/A.

A_ALMCHANGE
F_ALMCHANGE

Reserved. N/A.

A_ALMDELETE
F_ALMDELETE

Reserved. N/A.

A_ALMGEN
F_ALMGEN

Reserved. N/A.

A_ALMRESET
F_ALMRESET

Reserved. N/A.

A_ALMUPDATE Reserved. N/A.

© 2020 General Electric Company. All rights reserved. 65



F_ALMUPDATE

A_PUBLISH
F_PUBLISH

Reserved. N/A.

A_WRITABLE
F_WRITABLE

Reserved. N/A.

 

Analog Input Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry 

A_ADI The block's alarm areas. N/A. This field is 
provided for backward 
compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's 
alarm extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the 
block generated the   alarm. 

N/A. This is a display 
only field. 

A_ALMLASTTIME The time and date at which the 
block last generated   an alarm. 

N/A. This is a display 
only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block 
goes in and out of alarm   before it 
is acknowledged.

N/A. This is a display 
only field.

A_ALMSHELFREMTIME

F_ALMSHELFREMTIME

The remaining time left for a 
shelved alarm.

N/A. This is a display 
only field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified 
alarm is shelved (YES/NO).

N/A. This is a display 
only field. 

A_ALMSHELVEPOLICY The name of alarm shelving 
policy.

N/A. This is a display 
only field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving 
is enabled (YES/NO) for a block. 

N/A. This is a display 
only field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display 
only field. 

A_ALMSN The serial number of the alarm 
area database. 

N/A. This is a display 
only field. 

A_AREA1 through A_AREA15 The alarm areas assigned to the 
block. 

ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual 
status of the block.   

Automatic (1) or Manual 
(0). 

A_CHALM The chain's most severe alarm. N/A. This is a display 
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only field. 

A_CUALM The block's current alarm. N/A. This is a display 
only field. 

A_CV 
E_CV
F_CV

The block's current value. A numeric value within 
the EGU range. 

A_DALM
F_DALM

Whether to delete alarm from 
summary queue after acknow-
ledgment.

0 (false) or 1 (true). 

A_DBAND 
E_DBAND
F_DBAND 

The maximum fluctuation the 
block accepts without   re-issuing 
an alarm. 

A numeric value within 
the EGU range. 

A_DESC The text in the block's Descrip-
tion field. 

Up to 256 characters.  

A_EGUDESC The block's engineering units 
label. 

Up to 33 characters. 

A_EHI 
E_EHI
F_EHI 

The block's high EGU limit. A numeric value. The 
range between the low 
and high   values value 
cannot exceed 
3.40282300000000e+38.

A_ELO 
E_ELO
F_ELO 

The block's low EGU limit. A numeric value. The 
range between the low 
and high   values value 
cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_EOUT Yes, if the block writes data to 
the process hardware,   or No, if 
the block does not. 

Yes or No. 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag 
without entering a signature, 
even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is 
enabled for this tag. 

Yes or No. 

A_ESIG_COMMENT

F_ESIG_COMMENT

A comment is required when 
using an electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGREQ_COMMENT

F_ESIGREQ_COMMENT

A comment is required when 
using an electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are 
accepted or rejected by   this tag 
or accepted and logged. 

ACCEPT, LOG, 
REJECT. 
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A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this 
tag. 

None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the 
block's engineering   units label. 

N/A. This field is 
provided for backward 
compatibility.   

A_EVENT The initial event messaging 
status. 

N/A. This is a display 
only field. 

A_HI 
E_HI
F_HI 

The block's High alarm limit. A numeric value within 
the EGU range. 

A_HIHI 
E_HIHI
F_HIHI 

The block's High High alarm 
limit. 

A numeric value within 
the EGU range. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is 
under collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression 
is used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time 
out.

A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband 
setting.

Absolute (0) or Per-
centage (1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting.  A   positive numeric 
value (0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this 
block.The value of   this field must 
be greater than the value of the 
A_HIST_OFFSET and F_HIST_
OFFSET   fields.

Use the following formula to 
determine if the entered   value is 
acceptable for this field.

A_/F_HIST_INTERVAL > A_/F_
HIST_OFFSET * 1000 

NOTE: The values for the A_
HIST_OFFSET and F_HIST_
OFFSET   fields are in seconds.

A float value, in mil-
liseconds. Values must 
be entered   in increments 
of 100. Minimum value: 
100 ms.

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The 
value of this field   must be less 
than or equal to the value of the 
A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

A numeric value, in 
seconds. Must use 
whole numbers.   
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Use the following formula to 
determine if the entered   value is 
acceptable for this field.

A_/F_HIST_OFFSET ≤ A_/F_
HIST_INTERVAL / 1000   

NOTE: The values for the A_
HIST_INTERVAL and F_HIST_
INTERVAL   fields are in mil-
liseconds. 

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual 
status of the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display 
only field. 

A_IOAD The block's I/O address. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IODV The name of the block's I/O 
driver. 

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOHT The I/O driver's hardware 
options. 

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOSC The type of signal conditioning 
used by the block.   

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ISCAN The initial scan status (on or off) 
of the block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the 
current alarm is displayed. 

N/A. This is a display 
only field. 

A_LO 
E_LO
F_LO 

The block's Low alarm limit. A numeric value within 
the EGU range. 

A_LOLO 
E_LOLO
F_LOLO 

The block's Low Low alarm limit. A numeric value within 
the EGU range. 

A_NALM 
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-

N/A. This is a display 
only field. 
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knowledged alarms. 

A_NAME The block's type, for example AI 
for an Analog Input   block. 

N/A. This is a display 
only field. 

A_NEXT The name of the next block in the 
chain. 

N/A. This is a display 
only field. 

A_OPCLIMIT The hardware options of the 
OPC server. 

N/A. This is a display 
only field. 

A_OPCQLTY The quality status of the OPC 
server. 

N/A. This is a display 
only field. 

A_OPCSUBSTAT The quality substatus of the 
OPC server. 

N/A. This is a display 
only field. 

A_OPCTIME The time and date from the OPC 
server. 

N/A. This is a display 
only field. 

A_PDR_ACCESSTIME
F_PDR_ACCESSTIME

Reserved. N/A. 

A_PDR_ARRAYLENGTH
F_PDR_ARRAYLENGTH

Reserved. N/A. 

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved. N/A. 

A_PDR_DISABLEOUT
F_PDR_DISABLEOUT

Reserved. N/A. 

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved. N/A. 

A_PDR_UPDATERATE
F_PDR_UPDATERATE

Reserved. N/A. 

A_PREV The name of the previous block 
in the chain. 

N/A. This is a display 
only field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display 
only field. 

A_ROC 
E_ROC
F_ROC 

The maximum acceptable 
change in the block's value   that 
can occur between scan periods. 

A numeric value within 
the EGU range. 

A_SA1 
through 
A_SA3 

The security areas assigned to 
the block. 

Up to three security area 
names. 

A_SCALE_CLAMP
F_SCALE_CLAMP

Whether the data received or 
sent will be limited   to the ranges 
specified in the following fields:

 l A_/E_/F_SCALE_
HIGH

 l A_/E_/F_SCALE_
LOW

 l A_/E_/F_SCALE_

Yes (1) or No (0).
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RAWHIGH

 l A_/E_/F_SCALE_
RAWLOW

A_SCALE_ENABLED
F_SCALE_ENABLED

Whether linear scaling is 
enabled.

Yes (1) or No (0).

A_SCALE_HIGH
E_SCALE_HIGH
F_SCALE_HIGH

The high limit of the sent values. A numeric value.

A_SCALE_LOW
E_SCALE_LOW
F_SCALE_LOW

The low limit of the sent values. A numeric value.

A_SCALE_RAWHIGH
E_SCALE_RAWHIGH
F_SCALE_RAWHIGH

The high limit of the received val-
ues.

A numeric value.

A_SCALE_RAWLOW
E_SCALE_RAWLOW
F_SCALE_RAWLOW

The low limit of the received val-
ues.

A numeric value.

A_SCALE_USEEGU
F_SCALE_USEEGU

Whether Engineering Units are 
used for scaling block   output.

Yes (1) or No (0).

A_SCAN The on/off scan status of the 
block. 

On or Off. 

A_SCANT The block's scan time and 
phase. 

E for exception-based 
processing, 0 for one 
shot processing,   or 
time:phase for time-
based processing. 

A_SMOTH The smoothing value. 0 to 15.

A_TAG The block's name. N/A. This is a display 
only field. 

A_WARM Yes or No. N/A. This is a display 
only field. 

A_ALMACK
F_ALMACK

Reserved. N/A. 

A_ALMCHANGE
F_ALMCHANGE

Reserved. N/A. 

A_ALMDELETE
F_ALMDELETE

Reserved. N/A. 

A_ALMGEN
F_ALMGEN

Reserved. N/A. 

A_ALMRESET
F_ALMRESET

Reserved. N/A. 

A_ALMUPDATE
F_ALMUPDATE

Reserved. N/A. 

A_PUBLISH
F_PUBLISH

Reserved. N/A. 
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A_WRITABLE
F_WRITABLE

Reserved. N/A. 

 

Analog Output Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Text, up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_COLD The initial value the block outputs on star-
tup. 

A numeric value within the 
EGU range. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
E_EHI
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.
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A_ELO 
E_ELO
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. Enable or Disable. 

A_HILIM 
E_HILIM
F_HILIM 

The highest value that the block can 
receive from   another block or from an oper-
ator. 

A numeric value within the 
EGU range. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_

The Collector deadband setting. A positive numeric value (0 or 
greater).
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DEADBAND

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

N/A. This is a display only 
field. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_IOAD The block's I/O address. Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IODV The name of the block's I/O driver. Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOHT The I/O driver's hardware options. Depends on your driver. Refer 
to your driver manual   for more 
information. 
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A_IOSC The type of signal conditioning used by the 
block.   

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_ISCAN The initial scan status (on or off) of the 
block.   

N/A. This is a display only 
field. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_LOLIM 
E_LOLIM
F_LOLIM 

The lowest value that the block can 
receive from another   block or from an oper-
ator. 

A numeric value within the 
EGU range. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_ Reserved for future use.
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LATCHDATA
F_PDR_
LATCHDATA

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_RATE 
E_RATE
F_RATE 

The maximum, acceptable change in the 
block's value   that can occur between scan 
periods. Enter 0 to allow any amount of 
change.   

A numeric value within the 
EGU range. 

A_ROUT Yes, when the block inverts its current 
value and   outputs it, or No, when the block 
outputs its current value unchanged.   

Yes or No. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCALE_
CLAMP
F_SCALE_
CLAMP

Whether the data received or sent will be 
limited   to the ranges specified in the fol-
lowing fields:

 l A_/E_/F_SCALE_HIGH

 l A_/E_/F_SCALE_LOW

 l A_/E_/F_SCALE_RAWHIGH

 l A_/E_/F_SCALE_RAWLOW

Yes (1) or No (0).

A_SCALE_
ENABLED
F_SCALE_
ENABLED

Whether linear scaling is enabled. Yes (1) or No (0).

A_SCALE_HIGH
E_SCALE_HIGH
F_SCALE_HIGH

The high limit of the sent values. A numeric value.

A_SCALE_LOW
E_SCALE_LOW
F_SCALE_LOW

The low limit of the sent values. A numeric value.

A_SCALE_
RAWHIGH
E_SCALE_
RAWHIGH
F_SCALE_
RAWHIGH

The high limit of the received values. A numeric value.
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A_SCALE_
RAWLOW
E_SCALE_
RAWLOW
F_SCALE_
RAWLOW

The low limit of the received values. A numeric value.

A_SCALE_
USEEGU
F_SCALE_
USEEGU

Whether Engineering Units are used for 
scaling block   output.

Yes (1) or No (0).

A_SCAN The on/off scan status of the block. N/A. This is a display only 
field. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Analog Register Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 

© 2020 General Electric Company. All rights reserved. 77



backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
E_EHI
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
E_ELO
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_EOUT Yes, if the block writes data to the process 
hardware,   or No, if the block does not. 

Yes or No.

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 
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A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. Enable or Disable. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.
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in seconds.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_IOAD The block's I/O address. Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IODV The name of the block's I/O driver. Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOHT The I/O driver's hardware options. Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOSC The type of signal conditioning used by the 
block.   

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_ISCAN The initial scan status (on or off) of the 
block.

On or Off.

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area N/A. This is a write only field.
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database.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_NUMS Whether the starting address is an octal, 
decimal   or hexadecimal value. 

Hex, Octal, or Decimal. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_OUT Yes, if the block writes data to the process 
hardware   or 
No, if the block does not. 

Yes or No. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved. N/A.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved. N/A.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved. N/A.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved. N/A.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved. N/A.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved. N/A.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 
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A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCALE_
CLAMP
F_SCALE_
CLAMP

Whether the data received or sent will be 
limited   to the ranges specified in the fol-
lowing fields:

 l A_/E_/F_SCALE_HIGH

 l A_/E_/F_SCALE_LOW

 l A_/E_/F_SCALE_RAWHIGH

 l A_/E_/F_SCALE_RAWLOW

Yes (1) or No (0).

A_SCALE_
ENABLED
F_SCALE_
ENABLED

Whether linear scaling is enabled. Yes (1) or No (0).

A_SCALE_HIGH
E_SCALE_HIGH
F_SCALE_HIGH

The high limit of the sent values. A numeric value.

A_SCALE_LOW
E_SCALE_LOW
F_SCALE_LOW

The low limit of the sent values. A numeric value.

A_SCALE_
RAWHIGH
E_SCALE_
RAWHIGH
F_SCALE_
RAWHIGH

The high limit of the received values. A numeric value.

A_SCALE_
RAWLOW
E_SCALE_
RAWLOW
F_SCALE_
RAWLOW

The low limit of the received values. A numeric value.

A_SCALE_
USEEGU
F_SCALE_
USEEGU

Whether Engineering Units are used for 
scaling block   output.

Yes (1) or No (0).

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 
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A_ALMACK
F_ALMACK

Reserved. N/A.

A_ALMCHANGE
F_ALMCHANGE

Reserved. N/A.

A_ALMDELETE
F_ALMDELETE

Reserved. N/A.

A_ALMGEN
F_ALMGEN

Reserved. N/A.

A_ALMRESET
F_ALMRESET

Reserved. N/A.

A_ALMUPDATE
F_ALMUPDATE

Reserved. N/A.

A_PUBLISH
F_PUBLISH

Reserved. N/A.

A_WRITABLE
F_WRITABLE

Reserved. N/A.

 

Boolean Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for backward 
compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's 
alarm extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the 
block generated the   alarm. 

N/A. This is a display only field. 

A_
ALMLASTTIME 

The time and date at which the 
block last generated   an alarm. 

N/A. This is a display only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block 
goes in and out of alarm   before it 
is acknowledged.

N/A. This is a display only field.

A_ALMSN The serial number of the alarm 
area database. 

N/A. This is a display only field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the 
block. 

ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual 
status of the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only field. 

A_CLOSE The first seven characters of the N/A. This field is provided for backward 
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block's close label.   compatibility.   

A_CLOSEDESC Text in the block's Close field. Up to 16 characters. 

A_CUALM The block's current alarm. N/A. This is a display only field. 

A_CV 
E_CV
F_CV

The block's current value. Numeric value within the EGU range. 

A_DALM
F_DALM

Whether to delete alarm from 
summary queue after acknow-
ledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Descrip-
tion field. 

Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag 
without entering a signature, 
even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when 
using an electronic signature. 

Enable: Yes (1), or Disable: No (0). 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is 
enabled for this tag. 

Yes or No. 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are 
accepted or rejected by   this tag 
or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this 
tag. 

None, PERFONLY, or PERFVERI. 

A_EVENT The initial event messaging 
status. 

N/A. This is a display only field. 

A_EXP The block's output value (true or 
false). 

N/A. This is a display only field. 

A_GETF1 
through 
A_GETF8 

The block's input values. 1 (true), 0 (false), A SIM register with 
the format,   register:bit, a digital block 
name, or an alarm in the format block-
:alarm.   If the block is in alarm, the input 
value is true. Otherwise, it is false.   

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is 
under collection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_

Sets whether or not compression 
is used by the Collector.

Enable (1) or Disable (0).
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COMPRESS

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time 
out.

A positive numeric value (0 or greater), 
in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband 
setting.

Absolute (0) or Percentage (1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this 
block. The value   of this field 
must be greater than the value of 
the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to 
determine if the entered   value is 
acceptable for this field.

A_/F_HIST_INTERVAL > A_/F_
HIST_OFFSET * 1000 

NOTE: The values for the A_
HIST_OFFSET and F_HIST_
OFFSET   fields are in seconds. 

A float value, in milliseconds. Values 
must be entered   in increments of 100. 
Minimum value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The 
value of this field   must be less 
than or equal to the value of the 
A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to 
determine if the entered   value is 
acceptable for this field.

A_/F_HIST_OFFSET ≤ A_/F_
HIST_INTERVAL / 1000   

NOTE: The values for the A_
HIST_INTERVAL and F_HIST_
INTERVAL   fields are in mil-
liseconds. 

A numeric value, in seconds. Must use 
whole numbers.   

A_HIST_
TIMERES
F_HIST_

The collection time resolution. Milliseconds (0) or Seconds (1).
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TIMERES

A_IAM The initial Automatic/Manual 
status of the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only field. 

A_ISCAN The initial scan status (on or off) 
of the block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the 
current alarm is displayed. 

N/A. This is a display only field. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only field. 

A_NAREA Enters a new alarm area in the 
alarm area database.

N/A. This is a write only field.

A_NAME The block's type, for example AI 
for an Analog Input   block. 

N/A. This is a display only field. 

A_NEXT The name of the next block in the 
chain. 

N/A. This is a display only field. 

A_OPCLIMIT The hardware options of the 
OPC server. 

N/A. This is a display only field. 

A_OPCQLTY The quality status of the OPC 
server. 

N/A. This is a display only field. 

A_
OPCSUBSTAT 

The quality substatus of the 
OPC server. 

N/A. This is a display only field. 

A_OPCTIME The time and date from the OPC 
server. 

N/A. This is a display only field. 

A_OPEN The first seven characters of the 
block's open label.   

N/A. This field is provided for backward 
compatibility.   

A_OPENDESC Text in the block's Open field. Up to 16 characters. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT

Reserved for future use.
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F_PDR_
DISABLEOUT

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the upstream block. N/A. This is a display only field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only field. 

A_SA1 
through 
A_SA3 

The security areas assigned to 
the block. 

Up to three security area names. 

A_SCAN The on/off scan status of the 
block. 

On or Off. 

A_SCANT The block's scan time and 
phase. 

E for exception-based processing, 0 for 
one shot processing,   or time:phase for 
time-based processing. 

A_TAG The block's name. N/A. This is a display only field. 

A_TV1 
through 
A_TV8 

The block's input values. The 
field's first character   displays: 
R if the value is retrieved from a 
block. 
L if the value is local. 

1 (true), 0 (false), A SIM register with 
the format,   register:bit, a digital block 
name, or an alarm in the format block-
:alarm.   If the block is in alarm, the input 
value is true. Otherwise, it is false.   

A_WARM Yes or No. N/A. This is a display only field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.
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Calculation Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
E_EHI
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
E_ELO
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB The block's alarm status. Enable: Yes (1), or Disable: 
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F_ENAB No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_EXP The block's output value. N/A. This is a display only 
field. 

A_GET1 
through 
A_GET8 

The block's input values. A numeric constant, a block 
name, or a block and field   
name pair. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).
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A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an N/A. This is a display only 
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Analog Input   block. field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 
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A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 
through 
A_TV7 

E_TV1
through
E_TV7

F_TV1 
through 
F_TV7 

The block's input values. The A_ version 
of the field   displays as its first character: 
R if the value is retrieved from a block. 
L if the value is local. 

A numeric constant, a block 
name, or a block and field   
name pair. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Dead Time Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   
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A_ALMEXT1
A_ALMEXT2

The text entered in the block's alarm exten-
sion fields.

Up to 79 characters.

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME

The time and date at which the block last 
generated   an alarm.

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 
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COMMENT

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_ The collection offset time. The value of A numeric value, in seconds. 
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OFFSET
F_HIST_
OFFSET

this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME

Reserved for future use.
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F_PDR_
ACCESSTIME

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TIME The block's dead time value. 1.255 seconds. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.
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A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Device Control Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_BSTAT The block's current status. Possible status 
include   debug, delay, off, and wait. 

N/A. This is a display only 
field. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_COLD The initial value the block outputs on star-
tup. 

An eight-character contact 
pattern. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV The block's current value. Numeric value within the 
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EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_ The collection interval for this block. The A float value, in mil-
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INTERVAL
F_HIST_
INTERVAL

value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

liseconds. Values must be 
entered   in increments of 100. 
Minimum value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAD1 
through 
A_IAD16 

The I/O address for the block's digital 
inputs. 

Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_IODV1 The name of the I/O driver used by the 
block's input   addresses. 

Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IODV2 The name of the I/O driver used by the 
block's output   addresses. 

Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IOHT1 The hardware options for the I/O driver spe-
cified   in the field A_IODV1. 

Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IOHT2 The hardware options for the I/O driver spe- Depends on your driver. 

© 2020 General Electric Company. All rights reserved. 99



cified   in the A_IODV2 field. Refer to your driver manual   
for more information. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OAD1 
through 
A_OAD8 

The I/O address for the block's outputs. Depends on your driver. 
Refer to your driver manual   
for more information. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA

Reserved for future use.
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F_PDR_
LATCHDATA

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block. N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_STP0 
through 
A_STP11 

The command for the specified pro-
gramming statement.   

N/A. This is a display only 
field. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 The current programming statement that is 
executing.   

0 to 11. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.
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Digital Alarm Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_AACK A block and field name pair to use for 
alarm acknowledgment.   

Block.field 

A_ADI The block's alarm areas. N/A. This field is 
provided for backward 
compatibility.   

A_ALMCK The block's alarm condition. None, Close, Open, or 
Change of State. 

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display 
only field. 

A_ALMLASTTIME The time and date at which the block last 
generated   an alarm. 

N/A. This is a display 
only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display 
only field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display 
only field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display 
only field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display 
only field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display 
only field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display 
only field. 

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display 
only field. 

A_ALM_
SUSPENDMODE

F_ALM_
SUSPENDMODE

Configures Event messaging (Suspend 
mode), which applies to the process 
alarm limit as an event.

Enable: Yes (1), or Dis-
able: No (0). 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 
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A_ASUSP A block and field that controls whether 
the Digital   Alarm block processes 
alarms. 

NOTE: If   you use this field, you sub-
sequently cannot use the A_ENAB or F_
ENAB field   to disable or enable an alarm 
status. The A_ASUSP field takes pre-
cedence   over the A_ENAB or F_ENAB 
fields. 

Block.field 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual 
(0). 

A_CCALM The digital block to close when an alarm 
occurs. 

FIX32.node.block.field. 

A_CCMOD When to open the block's contact Acknowledge, Return, 
All Clear, or Never. 

A_CHALM The chain's most severe alarm. N/A. This is a display 
only field. 

A_CLOSE The first seven characters of the block's 
close label.   

N/A. This field is 
provided for backward 
compatibility.   

A_CLOSEDESC Text in the block's Close field. Up to 16 characters. 

A_COMM_
SURPRESS
F_COMM_
SURPRESS

Sets whether COMM alarms are sup-
pressed for this block.   

When selected, this option separates the 
original   alarm condition from the COMM 
alarm, and returns the block to the same   
state as it was prior to a COMM alarm. 
For example, if prior to the COMM   alarm, 
the AA block was an active alarm but 
already acknowledged, that   is the state it 
should return to after communication is 
restored.

If disabled, AA blocks handle one alarm 
at a time.   As a result, it is possible that 
acknowledgement of a COMM alarm 
could   cause the ACK bit in the PLC to be 
written, and the original alarm condition,   if 
already acknowledged, could re-alarm.

Enable (1) or Disable (0).

A_CTK_PERSIST
F_CTK_PERSIST

Sets whether blocks allow write attempts 
to the contact(s)   with every scan, even if 
the value being written is unchanged. 

When disabled, the AA block only 
attempts to write   to the defined contact 
tag when a value has changed and it 
needs to be   written to the PLC. The write 

Enable (1) or Disable (0).
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is a one-time attempt, so if it fails, the   
write will not be retried until the block 
needs to write a new value.

NOTE: There   are four modes for the con-
tacts - “Acknowledge”, “Return”, “All 
Clear”,   and “Never” - that control when 
the contact is cleared. Since the contact   
mode of “Never” does not reset the con-
tact, the Continuous Output option   is not 
supported for this contact mode. 

A_CUALM The block's current alarm. N/A. This is a display 
only field. 

A_CV 
F_CV 

The block's current value. A numeric value within 
the EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DELAY The length of time to wait before gen-
erating an alarm.   

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. 

NOTE: The   A_ASUSP field takes pre-
cedence over the A_ENAB or F_ENAB 
fields. In other   words, after you use the 
A_ASUSP field, you cannot use the A_
ENAB or F_ENAB   field to disable or 
enable an alarm status.

Enable: Yes (1), or Dis-
able: No (0). 

A_EOUT Yes, if the block writes data to the pro-
cess hardware   or 
No, if the block does not. 

Yes or No. 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering 
a signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 
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A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display 
only field. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Per-
centage (1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A float value, in mil-
liseconds. Values must 
be entered   in increments 
of 100. Minimum value: 
100 ms.

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use 
whole numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds(0) or 
Seconds (1).
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A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display 
only field. 

A_INV Yes, if the block inverts its output value 
or 
No, if the block does not invert its output 
value. 

Yes or No. 

A_IOAD The block's I/O address. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IODV The name of the block's I/O driver. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOHT The I/O driver's hardware options. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unacknowledged 
alarm exists, the current alarm is dis-
played. 

N/A. This is a display 
only field. 

A_NALM F_NALM Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display 
only field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display 
only field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display 
only field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display 
only field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display 
only field. 

A_OPCSUBSTAT The quality substatus of the OPC server. N/A. This is a display 
only field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display 
only field. 

A_OPEN The first seven characters of the block's 
open label.   

N/A. This field is 
provided for backward 
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compatibility.   

A_OPENDESC Text in the block's Open field. Up to 16 characters. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved. N/A.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved. N/A.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved. N/A.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved. N/A.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved. N/A.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved. N/A.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display 
only field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display 
only field. 

A_REALM The length of time to wait before re-issu-
ing an alarm.   

Any time from 
00:00:00:00 to 
03:00:00:00 (up to 3   
days, in the time format 
of  dd:hh:mm:ss).   

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based 
processing, 0 for one 
shot processing,   or 
time:phase for time-
based processing. 

A_TAG The block's name. N/A. This is a display 
only field. 

A_WARM Yes or No. N/A. This is a display 
only field. 

A_ALMACK Reserved. N/A.
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F_ALMACK

A_ALMCHANGE
F_ALMCHANGE

Reserved. N/A.

A_ALMDELETE
F_ALMDELETE

Reserved. N/A.

A_ALMGEN
F_ALMGEN

Reserved. N/A.

A_ALMRESET
F_ALMRESET

Reserved. N/A.

A_ALMUPDATE
F_ALMUPDATE

Reserved. N/A.

A_PUBLISH
F_PUBLISH

Reserved. N/A.

A_WRITABLE
F_WRITABLE

Reserved. N/A.

 

Digital Output Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is 
provided for back-
ward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm extension fields.   Up to 79 char-
acters. 

A_ALMINTIME The time and date at which the block generated the   
alarm. 

N/A. This is a dis-
play only field. 

A_
ALMLASTTIME 

The time and date at which the block last generated   
an alarm. 

N/A. This is a dis-
play only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and out of alarm   
before it is acknowledged.

N/A. This is a dis-
play only field.

A_ALMSN The serial number of the alarm area database. N/A. This is a dis-
play only field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm 
area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the block.   Automatic (1) or 
Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a dis-
play only field. 

A_CLOSE The first seven characters of the block's close label.   N/A. This field is 
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provided for back-
ward compatibility.   

A_
CLOSEDESC 

Text in the block's Close field. Up to 16 char-
acters. 

A_COLD The initial value the block outputs on startup. A numeric value 
within the EGU 
range. 

A_CUALM The block's current alarm. N/A. This is a dis-
play only field. 

A_CV 
F_CV 

The block's current value. A numeric value 
within the EGU 
range. 

A_DALM
F_DALM

Whether to delete alarm from summary queue after 
acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 char-
acters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or 
Disable: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknowledge 
alarms   for this tag without entering a signature, even 
if this tag requires electronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this tag. Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an electronic sig-
nature. 

Enable: Yes (1), or 
Disable: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or rejected by   
this tag or accepted and logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, 
or PERFVERI. 

A_EVENT The initial event messaging status. Enable or Disable. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under collection.   Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by the Col-
lector.

Enable (1) or Dis-
able (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric 
value (0 or greater), 
in milliseconds.

A_HIST_ The type of Collector deadband setting. Absolute (0) or Per-
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COMPTYPE
F_HIST_
COMPTYPE

centage (1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric 
value (0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 
128 characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The value   of this 
field must be greater than the value of the A_HIST_
OFFSET and   F_HIST_OFFSET fields.

Use the following formula to determine if the entered   
value is acceptable for this field.

A_/F_HIST_INTERVAL > A_/F_HIST_OFFSET * 
1000 

NOTE: The   values for the A_HIST_OFFSET and F_
HIST_OFFSET fields are in seconds.   

A float value, in mil-
liseconds. Values 
must be entered   in 
increments of 100. 
Minimum value: 
100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The block's collection offset time.The value of this   
field must be less than or equal to the value of the A_
HIST_INTERVAL and   F_HIST_INTERVAL fields.

Use the following formula to determine if the entered   
value is acceptable for this field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_INTERVAL / 
1000   

NOTE: The   values for the A_HIST_INTERVAL and 
F_HIST_INTERVAL fields are in milliseconds.   

A numeric value, in 
seconds. Must use 
whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of the block.   Automatic or 
Manual. 

A_IENAB The initial alarm status. N/A. This is a dis-
play only field. 

A_ISCAN The initial scan status (on or off) of the block.   N/A. This is a dis-
play only field. 

A_INV Yes, if the block inverts its output value or 
No, if the block does not invert its output value. 

Yes or No. 

A_IOAD The block's I/O address. Depends on your 
driver. Refer to your 
driver manual   for 
more information. 
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A_IODV The name of the block's I/O driver. Depends on your 
driver. Refer to your 
driver manual   for 
more information. 

A_IOHT The I/O driver's hardware options. Depends on your 
driver. Refer to your 
driver manual   for 
more information. 

A_IOSC The type of signal conditioning used by the block.   Depends on your 
driver. Refer to your 
driver manual   for 
more information. 

A_LAALM The block's most severe unacknowledged alarm. If 
no   unacknowledged alarm exists, the current alarm is 
displayed. 

N/A. This is a dis-
play only field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged alarms or   
No or 0, if the block has no unacknowledged alarms. 

N/A. This is a dis-
play only field. 

A_NAME The block's type, for example AI for an Analog Input   
block. 

N/A. This is a dis-
play only field. 

A_NAREA Enters a new alarm area in the alarm area database. N/A. This is a write 
only field.

A_NEXT The name of the next block in the chain. N/A. This is a dis-
play only field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a dis-
play only field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a dis-
play only field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a dis-
play only field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a dis-
play only field. 

A_OPEN The first seven characters of the block's open label.   N/A. This field is 
provided for back-
ward compatibility.   

A_OPENDESC Text in the block's Open field. Up to 16 char-
acters. 

A_PREV The name of the previous block in the chain. N/A. This is a dis-
play only field. 

A_PRI The block's alarm priority. Low, Medium, or 
High. 

A_PRIM The block's name. N/A. This is a dis-
play only field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security 
area names. 
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A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-
based processing, 
0 for one shot pro-
cessing,   or 
time:phase for time-
based processing.

A_TAG The block's name. N/A. This is a dis-
play only field. 

A_WARM Yes or No. N/A. This is a dis-
play only field. 

A_
WRITEONDIFF
F_
WRITEONDIFF

Sets whether writes are prevented by the DO block   if 
the value in the driver is the same as the value that is 
to be written.   When enabled, the DO block will read 
the bit from the driver and if different,   execute the 
write. If the values are the same, no value is written 
on   this scan.

Yes (1) or No (0).

A_ALMACK
F_ALMACK

Reserved for future use.

A_
ALMCHANGE
F_
ALMCHANGE

Reserved for future use.

A_
ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_
ALMUPDATE
F_
ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Digital Input Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.
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The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward com-
patibility.   

A_ALMCK The block's alarm condition. None, Close, Open, or 
Change of State. 

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual 
(0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CLOSE The first seven characters of the block's 
close label.   

N/A. This field is provided 
for backward com-
patibility.   

A_CLOSEDESC Text in the block's Close field. Up to 16 characters. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
F_CV 

The block's current value. A numeric value within the 
EGU range. 
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A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_EOUT Yes, if the block writes data to the pro-
cess hardware   or 
No, if the block does not. 

Yes or No. 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag without 
entering a signature, even if this tag 
requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. Enable or Disable. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than 
the value of the A_HIST_OFFSET and   
F_HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.
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A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INV Yes, if the block inverts its output value 
or 
No, if the block does not invert its output 
value. 

Yes or No. 

A_IOAD The block's I/O address. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IODV The name of the block's I/O driver. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOHT The I/O driver's hardware options. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOSC The type of signal conditioning used by 
the block.   

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 
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A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM F_NALM Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_OPEN The first seven characters of the block's 
open label.   

N/A. This field is provided 
for backward com-
patibility.   

A_OPENDESC Text in the block's Open field. Up to 16 characters. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved. N/A.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved. N/A.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved. N/A.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved. N/A.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved. N/A.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved. N/A.
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A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved. N/A.

A_ALMCHANGE
F_ALMCHANGE

Reserved. N/A.

A_ALMDELETE
F_ALMDELETE

Reserved. N/A.

A_ALMGEN
F_ALMGEN

Reserved. N/A.

A_ALMRESET
F_ALMRESET

Reserved. N/A.

A_ALMUPDATE
F_ALMUPDATE

Reserved. N/A.

A_PUBLISH
F_PUBLISH

Reserved. N/A.

A_WRITABLE
F_WRITABLE

Reserved. N/A.

 

Digital Register Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1 The text entered in the block's alarm exten- Up to 79 characters. 
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A_ALMEXT2 sion fields.   

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CLOSE The first seven characters of the block's 
close label.   

N/A. This field is provided 
for backward compatibility.   

A_CLOSEDESC Text in the block's Close field. Up to 16 characters. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_EOUT Yes, if the block writes data to the process 
hardware,   or No, if the block does not. 

Yes or No.

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 
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A_EVENT The initial event messaging status. Enable or Disable. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

A numeric value, in 
seconds. Must use whole 
numbers.   
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NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INV Yes, if the block inverts its output value or 
No, if the block does not invert its output 
value. 

Yes or No. 

A_IOAD The block's I/O address. Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IODV The name of the block's I/O driver. Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IOHT The I/O driver's hardware options. Depends on your driver. 
Refer to your driver manual   
for more information. 

A_IOSC The type of signal conditioning used by the 
block.   

Depends on your driver. 
Refer to your driver manual   
for more information. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_NUMS Whether the starting address is an octal, 
decimal   or hexadecimal value. 

Octal, Decimal, or Hex. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
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field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_OPEN The first seven characters of the block's 
open label.   

N/A. This field is provided 
for backward compatibility.   

A_OPENDESC Text in the block's Open field. Up to 16 characters. 

A_OUT Yes, if the block writes data to the process 
hardware   or 
No, if the block does not. 

Yes or No. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
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cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Event Action Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1
A_ALMEXT2

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters.

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 The alarm areas assigned to the block. ALL or an alarm area name. 
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through A_
AREA15 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_BSTAT The block's current status. Possible status 
include   debug, delay, off, and wait. 

N/A. This is a display only 
field. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_COND0 The block's first test condition. Text 

A_COND1 The block's second test condition. Text 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_FAL0 The command to execute if the block's first 
test condition   is false. 

RUN block 
STOP block 
CLOSE block 
OPEN block 

A_FAL1 The command to execute if the block's 
second condition   is false. 

RUN block 
STOP block 
CLOSE block 
OPEN block 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).
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A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).
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F_HIST_
TIMERES

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM F_
NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.
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A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TRU0 The command to execute if the block's first 
test condition   is true. 

RUN block 
STOP block 
CLOSE block 
OPEN block 

A_TRU1 The command to execute if the block's 
second test   condition is true. 

RUN block 
STOP block 
CLOSE block 
OPEN block 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.
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A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Extended Trend Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1
A_ALMEXT2

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters.

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_BC Whether the block clears its data buffers 
when the   block goes on scan. 

Yes or No. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
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3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GET1 The name of the block and field being 
trended. 

block.F_field 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_ The Collector deadband setting. A positive numeric value (0 or 
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DEADBAND
F_HIST_
DEADBAND

greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

A numeric value, in seconds. 
Must use whole numbers.

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INP 
F_INP 

The value of the block and field entered in 
the A_GET1   field. 

N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 
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A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
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field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TIME The number of samples the block collects 
and averages   for each of the 600 values it 
stores. 

1 to 255 

A_WARM Yes or No. N/A. This is a display only 
field. 

T_DATA The trend chart. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Fanout Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   
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A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).
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A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).
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F_HIST_
TIMERES

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.
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A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_PUT1 
through 
A_PUT4 

The block's four additional destinations. A block and field name pair. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

© 2020 General Electric Company. All rights reserved. 135



 

Histogram Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_AUTOC Yes, if the block clears the bar graph when 
the upstream   block goes on scan, or 
No, if the block retains the old values 
when the upstream block goes on   scan. 

Yes or No. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.
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A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

   

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GROUP The number of values the block collects 
before displaying   or updating the bar 
graph. 

1 to 1000. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).
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A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INTER The range of values represented by each 
column in   the bar graph. 

A numeric value. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-

N/A. This is a display only 
field. 
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knowledged alarms. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 

The security areas assigned to the block. Up to three security area 
names. 
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A_SA3 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

T_DATA Frequency distribution chart. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Lead Lag Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 
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A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 
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A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A numeric value, in seconds. 
Must use whole numbers.   
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A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_K The scaling factor used to modify the lead 
lag curve.   

-100.00 to 100.00 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_LAG The block's lag time constant. 0 to 100.00. 

A_LEAD The block's lead time constant. 0 to 100.00. 

A_NALM  
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_ Reserved for future use.
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ARRAYLENGTH
F_PDR_
ARRAYLENGTH

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.
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A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Multistate Digital Input Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward com-
patibility.   

A_AE0 
through 
A_AE7 

Whether the block generates an alarm 
for the selected   values. 

Yes or No. 

A_ALMEXT1
A_ALMEXT2

The text entered in the block's alarm 
extension fields.   

Up to 79 characters.

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 
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A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual 
(0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CLOSE The first seven characters of the block's 
A_TS fields.   

N/A. This field is provided 
for backward com-
patibility.   

A_CLOSEDESC Text in the block's Close field. Up to 16 characters. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_DIAD0 
through 
A_DIAD2 

The I/O address of each digital input. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_DIDV0 
through 
A_DIDV2 

The name of the I/O drivers used by 
each digital input.   

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_DIHT0 
through 
A_DIHT2 

The hardware options for each digital 
input. 

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag without 
entering a signature, even if this tag 
requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 
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A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than 
the value of the A_HIST_OFFSET and   
F_HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).
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A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_IO0 
through 
A_IO2 

Whether the block receives data from 
each digital   input. 

Yes or No. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_OPEN The first seven characters of the block's 
A_TS fields.   

N/A. This field is provided 
for backward com-
patibility.   

A_OPENDESC Text in the block's Open field. Up to 16 characters. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for future use.
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A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_REALM Whether the block re-issues an alarm 
when it changes   alarm states. 

Yes or No. 

A_RV The block's raw value. This value 
determines the block's   current alarm 
state. 

0 to 7. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TS0 
through 
A_TS7 

The descriptive labels for the block's 
alarm states.   

Up to nine characters. 

A_WARM Yes or No. N/A. This is a display only 
field. 

F_CV0 
through 
F_CV2 

The value of each digital input. 0 or 1. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN Reserved for future use.
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F_ALMGEN

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

On-Off Control Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_C1ENA Yes, if the high contact is enabled or 
No, if the high contact is disabled. 

Yes or No. 

A_C2ENA Yes, if the low contact is enabled or 
No, if the low contact is disabled. 

Yes or No. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV The block's current value. A numeric value within the 
EGU range. 
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A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HI1 
F_HI1 

The block's high limit for the high contact. A numeric value within the 
EGU range. You can write   to 
the A_HI1 field. The F_HI1 
field is read-only. 

A_HI2 
F_HI2 

The block's high limit for the low contact. A numeric value within the 
EGU range. You can write   to 
the A_HI2 field. The F_HI2 
field is read-only. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

© 2020 General Electric Company. All rights reserved. 151



A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).
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F_HIST_
TIMERES

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INV Yes, if the block inverts its output value or 
No, if the block does not invert its output 
value. 

Yes or No. 

A_IOAD1 The block's I/O address for the high con-
tact. 

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOAD2 The block's I/O address for the low con-
tact. 

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IODV1 The name of the I/O driver for the high con-
tact. 

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IODV2 The name of the I/O driver for the low con-
tact. 

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOHT1 The I/O driver's hardware options for the 
high contact.   

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_IOHT2 The I/O driver's hardware options for the 
low contact.   

Depends on your driver. Refer 
to your driver manual   for more 
information. 

A_ISCAN The initial scan status (on or off) of the 
block.   

N/A. This is a display only 
field. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_LO1 
F_LO1 

The block's low limit for the high contact. A numeric value within the 
EGU range. You can write   to 
the A_LO1 field. The F_LO1 
field is read-only. 

A_LO2 
F_LO2 

The block's low limit for the low contact. A numeric value within the 
EGU range. You can write   to 
the A_LO2 field. The F_LO2 
field is read-only 

A_NALM F_
NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 
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A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_ONCE Yes, if the block only activates the high 
and low   contact fields once or 
No, if the block activates the high and low 
contact continually. 

Yes or No. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 The security areas assigned to the block. Up to three security area 
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through 
A_SA3 

names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Pareto Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text you enter about the block. By 
default, these   fields are blank. 

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR The number of times a block goes in and N/A. This is a display only 
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F_ALMOCCUR out of alarm   before it is acknowledged. field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV1 
through 
A_CV8 

The block's current value for its sorted 
inputs. 

A numeric value. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_DSC1 
through 
A_DSC8 

The text describing the block's inputs. Up to 30 characters.  

A_EF The number of decimal points to display for 
input   values. 

0 to 6. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GET1 
through 
A_GET8 

The names of the block inputs. A block name. 
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A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 100. 
Minimum value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_

A numeric value, in seconds. 
Must use whole numbers.   
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INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds.

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_ID1 
through 
A_ID8 

The block's internal identifiers for its inputs. A to H. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PCT1 
through 
A_PCT8 

The percentage of occurrences for the 
block's inputs.   

A numeric value. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.
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A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_SDSC1 
through 
A_SDSC8 

The text describing the block's sorted 
inputs. 

Up to 30 characters.  

A_SID1 
through 
A_SID8 

The block's internal identifiers for its sorted 
inputs.   

A to H. 

A_SORT The sort criteria. Ascend, Descend, or None. 

A_SPCT1 
through 
A_SPCT8 
and 
F_SPCT1 
through 
F_SPCT8 

The percentage of occurrences for the 
block's sorted   inputs. 

A numeric value. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 The block's current value for its sorted A numeric value. 
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through 
A_TV8 

inputs. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

PID Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in 
and out of alarm   before it is acknow-
ledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED Indicates whether a specified alarm is N/A. This is a display only 
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F_ALMSHELVED shelved (YES/NO). field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_ALMSN The serial number of the alarm area 
database. 

N/A. This is a display only 
field. 

A_ALPHA The amount of derivative filtering 
applied to the   PID algorithm. 

0.0 to 0.125 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_BETA The PID proportional action constant. 0.0 to 1.0. 

A_BUMP The block's transfer option. Balance, Track, or None. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DBAND The maximum fluctuation the block 
accepts without   re-issuing an alarm. 

A numeric value within the 
EGU range. 

A_DESC The text in the block's Description 
field. 

Up to 256 characters.  

A_DEV The block's deviation alarm limit. A numeric value within the 
EGU range. 

A_EHI 
F_EHI 

The block's high input EGU limit. A numeric value. The range 
between the low and high   
values value cannot 
exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low input EGU limit. A numeric value. The range 
between the low and high   
values value cannot 
exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 
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A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag 
without entering a signature, even if 
this tag requires electronic   signatures 
for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
input engineering   units label. 

N/A. This field is provided 
for backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GAMMA The PID derivative action constant. 0.0 to 1.0. 

A_GAP A deadband value used to compensate 
for controller   error in updating the PID 
algorithm. 

A numeric value. 

A_GET1 The block's set point value. block.field or a numeric 
value. 

A_GET2 The block's feedback tag. block.field 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. 
The value   of this field must be greater 
than the value of the A_HIST_OFFSET 
and   F_HIST_OFFSET fields.

Use the following formula to determine 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.
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if the entered   value is acceptable for 
this field.

A_/F_HIST_INTERVAL > A_/F_
HIST_OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine 
if the entered   value is acceptable for 
this field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IEGUDESC The block's input engineering units 
label. 

Up to 33 characters. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INPUT 
F_INPUT 

The current value of the input into the 
PID block.   

A numeric value. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the N/A. This is a display only 
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chain. field. 

A_OEGUDESC The block's output engineering units 
label. 

Up to 33 characters. 

A_OEHI 
F_OEHI 

The block's high output EGU limit. A numeric value. 

A_OELO 
F_OELO 

The block's low output EGU limit. A numeric value. 

A_OETAG The first four characters of the block's 
output engineering   units label. 

N/A. This field is provided 
for backward compatibility.   

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC 
server. 

N/A. This is a display only 
field. 

A_PBAND 
F_PBAND 

The block's proportional band value. 1.00 to 900.00. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for internal use. N/A.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for internal use. N/A.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for internal use. N/A.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for internal use. N/A.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for internal use. N/A.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for internal use. N/A.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_RATE The block's derivative time constant. 1 to 20 minutes. 
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F_RATE 

A_RESET 
F_RESET 

An integral time constant. 0.000 to 99.000 minutes. 

A_ROUT Yes, if the block inverts its output or 
No, if the block does not invert its out-
put. 

Yes or No. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_SPHI The highest value an operator can enter 
for a set   point. 

A numeric value. 

A_SPLO The lowest value an operator can enter 
for a set point.   

A numeric value. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 
F_TV1 

The block's current set point value. A numeric value. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for internal use. N/A.

A_ALMCHANGE
F_ALMCHANGE

Reserved for internal use. N/A.

A_ALMDELETE
F_ALMDELETE

Reserved for internal use. N/A.

A_ALMGEN
F_ALMGEN

Reserved for internal use. N/A.

A_ALMRESET
F_ALMRESET

Reserved for internal use. N/A.

A_ALMUPDATE
F_ALMUPDATE

Reserved for internal use. N/A.

A_PUBLISH
F_PUBLISH

Reserved for internal use. N/A.

A_WRITABLE
F_WRITABLE

Reserved for internal use. N/A.

 

Program Block Fields
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The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward com-
patibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual 
(0). 

A_BSTAT The block's status. Debug, Delay, Off, Wait, 
or Run. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 
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A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag without 
entering a signature, even if this tag 
requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ESIGACK 
F_ESIGACK 

The initial event messaging status. N/A. This is a display only 
field. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than 
the value of the A_HIST_OFFSET and   
F_HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.
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OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

N/A. This is a write only 
field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 
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A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_STP0 
through 
A_STP19 

The block command for the specified 
step. 

Text. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 The step that the block is executing. 0 to 19. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

© 2020 General Electric Company. All rights reserved. 169



A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Ramp Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CSTEP The current ramp stage being executed. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
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field. 

A_CV
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM 
F_DALM 

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GET1 
through 
A_GET3 

The source of block's target values. A block name or a numeric 
value within the EGU range.   

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_ Sets whether or not compression is used Enable (1) or Disable (0).
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COMPRESS
F_HIST_
COMPRESS

by the Collector.

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_

The collection time resolution. Milliseconds (0) or Seconds 
(1).
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TIMERES

A_HOLD1 
through 
A_HOLD2 

The block's hold times. A numeric value specified in 
hours. 

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_

Reserved for future use.
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DISABLEOUT

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_RATE1 
through 
A_RATE3 

The block's ramp rates. A numeric value specified in 
hours. 

A_RHT The remaining hold time. A numeric value. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 
through 
A_TV3 and 
F_TV1 
through 
F_TV3 

The block's target values. A numeric value. 

A_TVHI The largest target value an operator can 
enter. 

An alphanumeric value. 

A_TVLO The lowest target value an operator can 
enter. 

An alphanumeric value. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE Reserved for future use.
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F_ALMDELETE

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Ratio Bias Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 
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A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GET1 The source of block's bias value. block.field or a numeric value 
within the EGU range.   

A_GET2 The source of the block's offset. block.field or a numeric value 
within the EGU range.   

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).
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A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 
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A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

N/A. This is a write only field.

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_ Reserved for future use.
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UPDATERATE
F_PDR_
UPDATERATE

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_RATIO The block's ratio value. A numeric value. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV1 
F_TV1 

The block's bias value. A numeric value. 

A_TV2 
F_TV2 

The block's offset. A numeric value. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Signal Select Block Fields
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The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 
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A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. Enable or Disable. 

A_GET1 
through 
A_GET5 

The input value or the block and field spe-
cified for   Inputs 2 through 6. 

block.field or numeric value 
within the EGU range.   

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
value: 100 ms.
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field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds.

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
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field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_SEL The block's Selected Mode. Avg, Good, Hi, Lo, Sum, 
Input 1 through Input 6. 

A_TAG The block's name. N/A. This is a display only 
field. 
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A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

SQL Data Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
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field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_DIR01 
through 
A_DIR20 

Whether the block reads (In) or writes (Out) 
to the   relational database for the each block 
and field pair. 

In or Out. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).
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F_HIST_
DEADBAND

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-

N/A. This is a display only 
field. 
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knowledged alarms. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_RST01 
through 

The reset values of each block and field 
pair. 

None, Blank, or Zero. 
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A_RST20 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TF01 
through 
A_TF20 

The block and field name pairs to which the 
SQL Data   block reads and writes. 

block.A_field 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

SQL Trigger Block Fields 

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry 

A_ADI The block's alarm areas. N/A. This field is 
provided for backward 
compatibility.   

A_ALMEXT1 The text entered in the block's alarm extension fields.   Up to 79 characters. 
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A_ALMEXT2 

A_ALMINTIME The time and date at which the block generated the   
alarm. 

N/A. This is a display 
only field. 

A_ALMLASTTIME The time and date at which the block last generated   
an alarm. 

N/A. This is a display 
only field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and out of alarm   
before it is acknowledged.

N/A. This is a display 
only field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved alarm. N/A. This is a display 
only field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is shelved 
(YES/NO).

N/A. This is a display 
only field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display 
only field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is enabled (YES/NO) 
for a block. 

N/A. This is a display 
only field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display 
only field. 

A_ALMSN The serial number of the alarm area database. N/A. This is a display 
only field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the block.   Automatic (1) or Manual 
(0). 

A_BACK Whether the block backs up process data if it detects   
a problem with the relational database. 

Enable or Disable. 

A_CHALM The chain's most severe alarm. N/A. This is a display 
only field. 

A_CMDTP Whether the block executes SQL commands or 
stored   procedures. 

SQL or PROC. 

A_COLS The number of columns to select when a SELECT 
command   executes. 

A numeric value. 

A_CONTG The block and field used by your process hardware   to 
verify the SQL Trigger block ran. 

block.F_field. 

A_CUALM The block's current alarm. N/A. This is a display 
only field. 

F_CUALM Float value of A_CUALM. 0 indicates alarm is OK 
or OFF. 

A_CV The block's transaction sequence. 0 to 255. 

F_CV The state of an executed procedure or command. 
Also   specifies if the error is SQLST, DBERR, 

N/A. This is a display 
only field. 
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CUALM or a combination of these   three states. The 
value displayed in this field is derived from a com-
bination   of these three states. 

A_DBERR A number to indicate if the last SQL command 
executed   successfully. Zero indicates no error. A 
non-zero number indicates the   specific command 
that failed. 

N/A. This is a display 
only field. 

F_DBERR Float value of A_DBERR 0 indicates no error. 

A_DBID The name of the relational database accessed by the   
block. 

Text. 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknowledge 
alarms   for this tag without entering a signature, even 
if this tag requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this tag. Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an electronic sig-
nature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or rejected by   
this tag or accepted and logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVDT1 The block's event start date. 1-31, ALL, NONE, or 
SUN-SAT. 

A_EVDT2 The block's event end date. 1-31, ALL, NONE, or 
SUN-SAT. 

A_EVENT The initial event messaging status. N/A. This is a display 
only field. 

A_EVPD The trigger time. When this time elapses, the block   
triggers. 

00:00:00-23:59:59 or a 
blank entry. 

A_EVTAG The block and field that triggers the SQL Trigger   
block. 

block.F_field. 

A_EVTM1 The block's event start time. 00:00:00-23:59:59 or a 
blank entry. 

A_EVTM2 The block's event end time. 00:00:00-23:59:59 or a 
blank entry. 

A_EVTYP The event that triggers the block. COV (change of value), 
HTL (High to Low), or 
LTH (Low to High) 

190 © 2020 General Electric Company. All rights reserved.



A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under collection.   Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is used by the Col-
lector.

Enable (1) or Disable 
(0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric 
value (0 or greater), in 
milliseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Per-
centage (1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric 
value (0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The value   of this 
field must be greater than the value of the A_HIST_
OFFSET and   F_HIST_OFFSET fields.

Use the following formula to determine if the entered   
value is acceptable for this field.

A_/F_HIST_INTERVAL > A_/F_HIST_OFFSET * 
1000 

NOTE: The values for the A_HIST_OFFSET and F_
HIST_OFFSET   fields are in seconds. 

A float value, in mil-
liseconds. Values must 
be entered   in incre-
ments of 100. Minimum 
value: 100 ms.

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of this field   must 
be less than or equal to the value of the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields.

Use the following formula to determine if the entered   
value is acceptable for this field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_INTERVAL / 
1000   

NOTE: The values for the A_HIST_INTERVAL and 
F_HIST_INTERVAL   fields are in milliseconds. 

A numeric value, in 
seconds. Must use 
whole numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of the block.   Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display 
only field. 

A_ISCAN The initial scan status (on or off) of the block.   On or Off. 

A_LAALM The block's most severe unacknowledged alarm. If 
no   unacknowledged alarm exists, the current alarm is 
displayed. 

N/A. This is a display 
only field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged alarms or   
No or 0, if the block has no unacknowledged alarms. 

N/A. This is a display 
only field. 

A_NAME The block's type, for example AI for an Analog Input   N/A. This is a display 
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block. only field. 

A_NEXT The name of the next block in the chain. N/A. This is a display 
only field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display 
only field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display 
only field. 

A_OPCSUBSTAT The quality substatus of the OPC server. N/A. This is a display 
only field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display 
only field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PDTMR The length of time remaining before the block trig-
gers.   

N/A. This is a display 
only field. 

A_PREV The name of the previous block in the chain. N/A. This is a display 
only field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display 
only field. 

A_ROWS The number of rows to retrieve when a SELECT com-
mand   executes. 

A numeric value. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security 
area names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based 

192 © 2020 General Electric Company. All rights reserved.



processing, 0 for one 
shot processing,   or 
time:phase for time-
based processing. 

A_SEQ The block's transaction sequence. iFIX uses the num-
ber   to identify each block. 

N/A. This is a display 
only field. 

A_SQL The SQL command to execute. Text. 

A_SQLST A five-character value that indicates an error returned   
by the database engine due to the SQL statement fail-
ure at the database   engine level. The field is blanked 
out when the block triggers. 

N/A. This is a display 
only field. 
00000 = no error. 
07001 = wrong number 
parameter. 
IM001 = memory error. 
S1001 = driver does not 
support this function. 

F_SQLST Float value of A_SQLST. 0 if A_SQLST is 00000 
1 if A_SQLST is "" 
(indicates executing) 
2 if A_SQLST is any 
alphanumeric string. 

A_STATE The block's state. N/A. This is a display 
only field. 

A_TAG The block's name. N/A. This is a display 
only field. 

A_TMODE The block's selection mode. SINGLE, MULTIPLE, 
or ARRAY. 

A_TRIP Whether the block is running. 0 (not running) or 
1 (running). 

A_WARM Yes or No. N/A. This is a display 
only field. 

A_XTIME The time of the last transaction. N/A. This is a display 
only field. 

A_XDATE The date of the last transaction. N/A. This is a display 
only field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.
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A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Statistical Data Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_A1R Whether an alarm occurred for the N 
Point Alarm on   RBAR value. 

Yes or No. 

A_A1X Whether an alarm occurred for the N 
Point Control   Limit Alarm on XBAR 
value. 

Yes or No. 

A_A3X Whether an alarm occurred for the N 
Point Warning   Limit Alarm on XBAR 
value. 

Yes or No. 

A_ADI The blocks alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the blocks alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in 
and out of alarm   before it is acknow-
ledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 
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F_IALMSHLVENAB

A_ALMSN The serial number of the alarm area 
database. 

N/A. This is a display only 
field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_ASD Whether an alarm occurred for the N 
Point Alarm on   SBAR value. 

Yes or No. 

A_ASP Whether an alarm occurred for the N 
Point Specification   Limit on XBAR 
alarm. 

Yes or No. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_AUTOX Whether the block recalculates 
XBARBAR, RBAR, and   SBAR values 
after startup. 

STARTUP, ALWAYS, or 
NEVER. 

A_CGRP The current number of group collected. 12 to 50. 

A_CHALM The chains most severe alarm. N/A. This is a display only 
field. 

A_COBS The current number of observations. 1 to 25. 

A_CPK 
F_CPK 

The blocks process capability index. N/A. This is a display only 
field. 

A_CRITX The value of the N Point Critical Runs 
on XBAR alarm.   

A numeric value. 

A_CRX Whether an alarm occurred for the N 
Point Critical   Runs on XBAR alarm. 

Yes or No. 

A_CTLR The value of the N Point Alarm on 
RBAR limit. 

A numeric value. 

A_CTLS The value of the N Point Alarm on 
SBAR limit. 

A numeric value. 

A_CTLX The value of the N Control Limit Alarm 
on XBAR limit.   

A numeric value. 

A_CUALM The blocks current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The blocks current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the blocks Description field. Up to 256 characters.  

A_EA1R Whether the N Point Alarm on RBAR 
limit is enabled.   

Yes or No. 

A_EA1X Whether the N Point Control Limit 
Alarm on XBAR limit   is enabled. 

Yes or No. 

A_EA3X Whether the N Point Warning Limit Yes or No. 
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Alarm on XBAR limit   is enabled. 

A_EASD Whether the N Point Alarm on SBAR 
limit is enabled.   

Yes or No. 

A_EASP Whether the N Point Specification 
Limit Alarm on XBAR   limit is enabled. 

Yes or No. 

A_ECRX Whether the N Point Critical Runs on 
XBAR alarm is   enabled. 

Yes or No. 

A_EGUDESC The blocks engineering units label. Up to 33 characters. 

A_EHI
F_EHI 

The blocks high EGU limit. A numeric value. The range 
between the low and high   
values value cannot 
exceed 
3.40282300000000e+38.

A_ELO 
F_ELO

The blocks low EGU limit. A numeric value. The range 
between the low and high   
values value cannot 
exceed 
3.40282300000000e+38.

A_ELRX Whether the Length of Runs Alarm is 
enabled. 

Yes or No. 

A_ENAB 
F_ENAB 

The blocks alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag 
without entering a signature, even if 
this tag requires electronic   signatures 
for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the blocks 
engineering   units label. 

N/A. This field is provided 
for backward compatibility.   

A_ETRX Whether the Trend of Run Alarm is 
enabled. 

Yes or No. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_FCOMP The forced computation of the control DONE 
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limits. 

A_GET1 The name of the block that the Stat-
istical Data uses   as its input. 

A block name. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. 
The value   of this field must be greater 
than the value of the A_HIST_OFFSET 
and   F_HIST_OFFSET fields.

Use the following formula to determine 
if the entered   value is acceptable for 
this field.

A_/F_HIST_INTERVAL > A_/F_
HIST_OFFSET * 1000 

NOTE: The   values for the A_HIST_
OFFSET and F_HIST_OFFSET fields 
are in seconds.   

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_OFFSET
F_HIST_OFFSET

The block's collection offset time.The 
value of this   field must be less than or 
equal to the value of the A_HIST_
INTERVAL and   F_HIST_INTERVAL 
fields.

Use the following formula to determine 
if the entered   value is acceptable for 
this field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The   values for the A_HIST_
INTERVAL and F_HIST_INTERVAL 
fields are in milliseconds.   

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 
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A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The blocks most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_LCALC Whether the block recalculates control 
limit (XBAR,   R, and S) values after star-
tup. 

STARTUP, ALWAYS, or 
NEVER. 

A_LCLR 
F_LCLR 

The R value lower control limit. A numeric value. 

A_LCLS 
F_LCLS 

The S value lower control limit. A numeric value. 

A_LCLX 
F_LCLX 

The X value lower control limit. A numeric value. 

A_LRX Whether an alarm occurred for the 
Length of Runs Alarm.   

Yes or No. 

A_LSLX 
F_LSLX 

The blocks lower specification limit. A numeric value. 

A_LWLX 
F_LWLX 

The blocks lower warning limit. A numeric value. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The blocks type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

 

A_NEXT The name of the next block in the 
chain. 

N/A. This is a display only 
field. 

A_NGRP The total number of groups to collect 
before calculating   limits. 

1 to 25. 

A_NOBS The total number of observations per 
group. 

12 to 520. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC 
server. 

N/A. This is a display only 
field. 
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A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The blocks alarm priority. Low, Medium, or High. 

A_PRIM The blocks name. N/A. This is a display only 
field. 

A_R 
F_R 

The previous groups R value. A numeric value. 

A_RBAR 
F_RBAR 

The blocks RBAR value. A numeric value. 

A_RUNX The value of the Length of Runs Alarm. A numeric value. 

A_S 
F_S 

The previous groups S value. A numeric value. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SBAR 
F_SBAR 

The average standard deviation. A numeric value. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The blocks scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_SDEV 
F_SDEV

The standard deviation. A numeric value. 

A_SPECX The value of the N Point Specification 
Limit Alarm   on XBAR limit. 

A numeric value. 

A_SQ The name of a digital block that con-
trols when to   sample input values. 

A block name. 

A_TAG The blocks name. N/A. This is a display only 
field. 

A_TRNDX The value of the Trend of Runs Alarm. A numeric value. 

A_TRX Whether an alarm occurred for the 
Trend of Runs Alarm.   

Yes or No. 

A_UCLR 
F_UCLR 

The R value upper control limit. A numeric value. 

A_UCLS 
F_UCLS 

The S value upper control limit. A numeric value. 

A_UCLX 
F_UCLX 

The X value upper control limit. A numeric value. 

A_USLX 
F_USLX 

The blocks upper specification limit. A numeric value. 

A_UWLX 
F_UWLX 

The blocks upper warning limit. A numeric value. 

A_WAIT The time that the block waits between 0 to 32767 seconds. 
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collecting data   between groups. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_WARNX The value of the N Point Warning Limit 
Alarm on XBAR   limit. 

A numeric value. 

A_XBAR 
F_XBAR 

The previous groups XBAR value. A numeric value. 

A_XBB 
F_XBB 

The XBARBAR value. A numeric value. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Statistical Control Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALM Whether the block suppresses alarms. Yes or No. 

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.
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A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CDLAY The time left until the next adjustment. 1 to 32767 seconds. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_DEV The block's deviation constant. A floating-point value. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).
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A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   fields 
are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 
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A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_ Reserved for future use.
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UPDATERATE
F_PDR_
UPDATERATE

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_PUT1 The name of the block that receives the 
Statistical   Control block's adjustment. 

A block name. 

A_RCALC Whether the upstream Statistical Data 
block recalculates   the upper and lower lim-
its after an adjusting a value and the delay 
time   elapses. 

Yes or No. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_SENT 
F_SENT 

The adjustment sent to the block specified 
in the   A_PUT1 field. 

N/A. This is a display only 
field. 

A_SHOW Whether the block calculates an adjust-
ment on every   scan. 

Yes or No. 

A_SLOPE The block's slope constant. A floating-point value. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_TIME   

A_TRACK Whether the block sends a message to its 
alarm destination   every time it adjusts a 
value. 

Yes or No. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.
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A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Text Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward com-
patibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO The current automatic/manual status of Automatic (1) or Manual 
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F_AUTO the block.   (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag without 
entering a signature, even if this tag 
requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIG_COMMENT

F_ESIG_COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. Enable or Disable. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than 
the value of the A_HIST_OFFSET and   
F_HIST_OFFSET fields.

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.
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Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_IOAD The block's I/O address. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IODV The name of the block's I/O driver. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOHT The I/O driver's hardware options. Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_IOSC The type of signal conditioning used by 
the block.   

Depends on your driver. 
Refer to your driver 
manual   for more inform-
ation. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 
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A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_LEN The maximum length of text that the 
block reads and   writes. 

1 to 80. 

A_NALM
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_NTFY Whether the block's event messaging 
status. 

Enable or Disable. 

A_OPCLIMIT The hardware options of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.
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A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing. 

A_TAG The block's name. N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Timer Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward com-
patibility.   
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A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm 
extension fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block 
generated the   alarm. 

N/A. This is a display only 
field. 

A_ALMLASTTIME The time and date at which the block 
last generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_
ALMSHELFREMTIME

F_
ALMSHELFREMTIME

The remaining time left for a shelved 
alarm.

N/A. This is a display only 
field. 

A_ALMSHELVED

F_ALMSHELVED

Indicates whether a specified alarm is 
shelved (YES/NO).

N/A. This is a display only 
field. 

A_
ALMSHELVEPOLICY

The name of alarm shelving policy. N/A. This is a display only 
field. 

A_ALMSHLVENAB

F_ALMSHLVENAB

Defines whether alarm shelving is 
enabled (YES/NO) for a block. 

N/A. This is a display only 
field. 

A_IALMSHLVENAB 

F_IALMSHLVENAB

The initial alarm shelving status 
(ENABLE/DISABLE) for a block.

N/A. This is a display only 
field. 

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area 
name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual 
(0). 

A_CCALM The name of the digital block that closes 
when the   Timer block reaches its target 
value. 

The name of a digital 
block. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_COND When iFIX processes the next block in 
the Timer block's   chain. 

Always or Time. 

A_CS Whether the Timer block saves its last 
value when   loading the process data-
base. 

Yes or No. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 
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A_DESC The text in the block's Description field. Up to 256 characters.  

A_DIRN Whether the block decrements (down) or 
increments   (up) its value. 

Up or Down. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to 
acknowledge alarms   for this tag without 
entering a signature, even if this tag 
requires electronic   signatures for data 
entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for 
this tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an 
electronic signature. 

Enable: Yes (1), or Dis-
able: No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted 
or rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, 
REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_COLLECT
F_HIST_COLLECT

Sets whether or not this block is under 
collection.   

Yes (1) or No (0).

A_HIST_COMPRESS
F_HIST_COMPRESS

Sets whether or not compression is 
used by the Collector.

Enable (1) or Disable (0).

A_HIST_COMPTIME
F_HIST_COMPTIME

The Collector compression time out. A positive numeric value 
(0 or greater), in mil-
liseconds.

A_HIST_COMPTYPE
F_HIST_COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_DEADBAND
F_HIST_DEADBAND

The Collector deadband setting. A positive numeric value 
(0 or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_INTERVAL
F_HIST_INTERVAL

The collection interval for this block. The 
value   of this field must be greater than 
the value of the A_HIST_OFFSET and   
F_HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.
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OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields 
are in seconds. 

A_HIST_OFFSET
F_HIST_OFFSET

The collection offset time. The value of 
this field   must be less than or equal to 
the value of the A_HIST_INTERVAL 
and F_HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_TIMERES
F_HIST_TIMERES

The collection time resolution. Milliseconds (0) or 
Seconds (1).

A_HOLD The name of the digital block used to 
suspend the   Timer block's counting tem-
porarily. 

block.F_CV 

A_IAM The initial Automatic/Manual status of 
the block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unac-
knowledged alarm. If no   unac-
knowledged alarm exists, the current 
alarm is displayed. 

N/A. This is a display only 
field. 

A_MODE When to open the digital block displayed 
in the A_CCALM   field. 

Acknowledge, Return, All 
Clear, or Never. 

A_NALM 
F_NALM 

Yes or 1, if the block has unac-
knowledged alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm 
area database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC N/A. This is a display only 
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server. field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_OPCSUBSTAT The quality substatus of the OPC 
server. 

N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_DEADBAND
F_PDR_DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_LATCHDATA
F_PDR_LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_PV 
F_PV 

The block's initial value. For A_ fields, 
this value   appears in the format ddd:h-
h:mm:ss. For F_ fields, the value is the 
total   number of seconds. 

N/A. This is a display only 
field. 

A_RESET The name of the block used to reset the 
Timer block.   

The name of a Digital 
Input, Digital Alarm, 
Digital   Output, or Boolean 
block. 

A_SA1 
through 
A_SA3 

The security areas assigned to the 
block. 

Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
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cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TV 
F_TV1 

The block's target value. For A_ fields, 
the value   appears in the format ddd:h-
h:mm:ss. For F_ fields, the value is the 
total   number of seconds. 

N/A. This is a display only 
field. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Totalizer Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

The field... Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided 
for backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR The number of times a block goes in and N/A. This is a display only 
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F_ALMOCCUR out of alarm   before it is acknowledged. field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of the 
block.   

Automatic (1) or Manual (0). 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV 
E_CV
F_CV
L_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EF Number of decimal places to display in the 
WorkSpace.   

0 to 15. 

A_EGUDESC The engineering units label. Up to 33 characters. 

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 

A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's engin-
eering   units label. 

N/A. This field is provided 
for backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).
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F_HIST_
COLLECT

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used by 
the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 
or greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 
or greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 
characters.

A_HIST_
INTERVAL
F_HIST_
INTERVAL

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_
HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

A float value, in mil-
liseconds. Values must be 
entered   in increments of 
100. Minimum value: 100 
ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of this 
field   must be less than or equal to the value 
of the A_HIST_INTERVAL and F_HIST_
INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and 

A numeric value, in 
seconds. Must use whole 
numbers.   

A_HIST_ The collection time resolution. Milliseconds (0) or Seconds 
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TIMERES
F_HIST_
TIMERES

(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM 
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an Ana-
log Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.

 

A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.
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A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TIME The time used by the Totalizer block to 
adjust its   total. 

A time in HH:MM:SS 
format. 

A_WARM Yes or No. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.
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Trend Block Fields

The following table lists the fields available for this block, what   each field displays, as well as the valid 
entries for each field in the   list.

Name Displays... Valid Entry

A_ADI The block's alarm areas. N/A. This field is provided for 
backward compatibility.   

A_ALMEXT1 
A_ALMEXT2 

The text entered in the block's alarm exten-
sion fields.   

Up to 79 characters. 

A_ALMINTIME The time and date at which the block gen-
erated the   alarm. 

N/A. This is a display only 
field. 

A_
ALMLASTTIME 

The time and date at which the block last 
generated   an alarm. 

N/A. This is a display only 
field. 

A_ALMOCCUR
F_ALMOCCUR

The number of times a block goes in and 
out of alarm   before it is acknowledged.

N/A. This is a display only 
field.

A_ALMSN The serial number of the alarm area data-
base. 

N/A. This is a display only 
field. 

A_AREA1 
through A_
AREA15 

The alarm areas assigned to the block. ALL or an alarm area name. 

A_AUTO 
F_AUTO 

The current automatic/manual status of 
the block.   

Automatic (1) or Manual (0). 

A_BC Whether the block clears its data buffers 
when the   block goes on scan. 

Yes or No. 

A_CHALM The chain's most severe alarm. N/A. This is a display only 
field. 

A_CUALM The block's current alarm. N/A. This is a display only 
field. 

A_CV
E_CV 
F_CV 

The block's current value. A numeric value within the 
EGU range. 

A_DALM
F_DALM

Whether to delete alarm from summary 
queue after acknowledgment.

0 (false) or 1 (true). 

A_DESC The text in the block's Description field. Up to 256 characters.  

A_EGUDESC The block's engineering units label. Up to 33 characters. 

A_EHI 
F_EHI 

The block's high EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ELO 
F_ELO 

The block's low EGU limit. A numeric value. The range 
between the low and high   val-
ues value cannot exceed 
3.40282300000000e+38.

A_ENAB 
F_ENAB 

The block's alarm status. Enable: Yes (1), or Disable: 
No (0). 
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A_ESIGACK 
F_ESIGACK 

Whether operators are allowed to acknow-
ledge alarms   for this tag without entering a 
signature, even if this tag requires elec-
tronic   signatures for data entry. 

Yes or No. 

A_ESIGCONT 
F_ESIGCONT 

If allow continuous use is enabled for this 
tag. 

Yes or No. 

A_ESIGREQ_
COMMENT

F_ESIGREQ_
COMMENT

A comment is required when using an elec-
tronic signature. 

Enable: Yes (1), or Disable: 
No (0). 

A_ESIGTRAP 
F_ESIGTRAP 

Whether unsigned writes are accepted or 
rejected by   this tag or accepted and 
logged. 

ACCEPT, LOG, REJECT. 

A_ESIGTYPE 
F_ESIGTYPE 

The signing requirements for this tag. None, PERFONLY, or 
PERFVERI. 

A_ETAG The first four characters of the block's 
engineering   units label. 

N/A. This field is provided for 
backward compatibility.   

A_EVENT The initial event messaging status. N/A. This is a display only 
field. 

A_GET1 The name of the block and field that the 
block trends.   

block.F_field 

A_HIST_
COLLECT
F_HIST_
COLLECT

Sets whether or not this block is under col-
lection.   

Yes (1) or No (0).

A_HIST_
COMPRESS
F_HIST_
COMPRESS

Sets whether or not compression is used 
by the Collector.

Enable (1) or Disable (0).

A_HIST_
COMPTIME
F_HIST_
COMPTIME

The Collector compression time out. A positive numeric value (0 or 
greater), in milliseconds.

A_HIST_
COMPTYPE
F_HIST_
COMPTYPE

The type of Collector deadband setting. Absolute (0) or Percentage 
(1).

A_HIST_
DEADBAND
F_HIST_
DEADBAND

The Collector deadband setting. A positive numeric value (0 or 
greater).

A_HIST_DESC The GE Historian description. String; maximum of 128 char-
acters.

A_HIST_
INTERVAL
F_HIST_

The collection interval for this block. The 
value   of this field must be greater than the 
value of the A_HIST_OFFSET and   F_

A float value, in milliseconds. 
Values must be entered   in 
increments of 100. Minimum 
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INTERVAL HIST_OFFSET fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_INTERVAL > A_/F_HIST_
OFFSET * 1000 

NOTE: The values for the A_HIST_
OFFSET and F_HIST_OFFSET   fields are 
in seconds. 

value: 100 ms.

A_HIST_
OFFSET
F_HIST_
OFFSET

The collection offset time. The value of 
this field   must be less than or equal to the 
value of the A_HIST_INTERVAL and F_
HIST_INTERVAL   fields.

Use the following formula to determine if 
the entered   value is acceptable for this 
field.

A_/F_HIST_OFFSET ≤ A_/F_HIST_
INTERVAL / 1000   

NOTE: The values for the A_HIST_
INTERVAL and F_HIST_INTERVAL   
fields are in milliseconds. 

A numeric value, in seconds. 
Must use whole numbers.   

A_HIST_
TIMERES
F_HIST_
TIMERES

The collection time resolution. Milliseconds (0) or Seconds 
(1).

A_IAM The initial Automatic/Manual status of the 
block.   

Automatic or Manual. 

A_IENAB The initial alarm status. N/A. This is a display only 
field. 

A_INP 
F_INP 

The value of the block and field entered in 
the A_GET1   field. 

N/A. This is a display only 
field. 

A_ISCAN The initial scan status (on or off) of the 
block.   

On or Off. 

A_LAALM The block's most severe unacknowledged 
alarm. If no   unacknowledged alarm exists, 
the current alarm is displayed. 

N/A. This is a display only 
field. 

A_NALM
F_NALM 

Yes or 1, if the block has unacknowledged 
alarms or   
No or 0, if the block has no unac-
knowledged alarms. 

N/A. This is a display only 
field. 

A_NAME The block's type, for example AI for an 
Analog Input   block. 

N/A. This is a display only 
field. 

A_NAREA Enters a new alarm area in the alarm area 
database.
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A_NEXT The name of the next block in the chain. N/A. This is a display only 
field. 

A_OPCLIMIT The hardware options of the OPC server. N/A. This is a display only 
field. 

A_OPCQLTY The quality status of the OPC server. N/A. This is a display only 
field. 

A_
OPCSUBSTAT 

The quality substatus of the OPC server. N/A. This is a display only 
field. 

A_OPCTIME The time and date from the OPC server. N/A. This is a display only 
field. 

A_PDR_
ACCESSTIME
F_PDR_
ACCESSTIME

Reserved for future use.

A_PDR_
ARRAYLENGTH
F_PDR_
ARRAYLENGTH

Reserved for future use.

A_PDR_
DEADBAND
F_PDR_
DEADBAND

Reserved for future use.

A_PDR_
DISABLEOUT
F_PDR_
DISABLEOUT

Reserved for future use.

A_PDR_
LATCHDATA
F_PDR_
LATCHDATA

Reserved for future use.

A_PDR_
UPDATERATE
F_PDR_
UPDATERATE

Reserved for future use.

A_PREV The name of the previous block in the 
chain. 

N/A. This is a display only 
field. 

A_PRI The block's alarm priority. Low, Medium, or High. 

A_PRIM The block's name. N/A. This is a display only 
field. 

A_SA1 
through 
A_SA3 

The security areas assigned to the block. Up to three security area 
names. 

A_SCAN The on/off scan status of the block. On or Off. 

A_SCANT The block's scan time and phase. E for exception-based pro-
cessing, 0 for one shot pro-
cessing,   or time:phase for 
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time-based processing.

A_TAG The block's name. N/A. This is a display only 
field. 

A_TIME The number of samples the block collects 
and averages   for each of the 80 values it 
stores. 

1 to 255. 

A_WARM Yes or No. N/A. This is a display only 
field. 

T_DATA The trend chart. N/A. This is a display only 
field. 

A_ALMACK
F_ALMACK

Reserved for future use.

A_ALMCHANGE
F_ALMCHANGE

Reserved for future use.

A_ALMDELETE
F_ALMDELETE

Reserved for future use.

A_ALMGEN
F_ALMGEN

Reserved for future use.

A_ALMRESET
F_ALMRESET

Reserved for future use.

A_ALMUPDATE
F_ALMUPDATE

Reserved for future use.

A_PUBLISH
F_PUBLISH

Reserved for future use.

A_WRITABLE
F_WRITABLE

Reserved for future use.

 

Typical Uses of Database Blocks
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Click one of the blocks listed below to get more information on the   individual block. 

A

Analog   Alarm

Analog   Input

Analog   Output

Analog   Register

B-C

Boolean

Calculation

D

Dead   Time

Device   Control

Digital   Alarm

Digital   Input

Digital   Output

Digital   Register

E-L

Event   Action

Extended   Trend

Fanout

Histogram

Lead   Lag

M-Q   

Multi-State   Digital Input

On-Off   Control

Pareto

PID

Program
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R-S   

Ramp

Ratio   Bias

Signal   Select

SQL   Data

SQL   Trigger

Statistical   Control

Statistical   Data

T-Z 

Text

Timer

Totalizer

Trend

 

Analog Alarm Block –   Typical Uses

You can use the Analog Alarm block to:  

 l Read and write analog   values at set time intervals from an I/O address, such as a PLC register.   

 l Perform smoothing,   signal conditioning, and alarm-limit checking. 

 l Define an alarm value   and priority for each type of alarm. 

 l Close a Digital block   when an alarm occurs. 

 l Re-issue an alarm   within the time defined in the Re-alarm Time field, as long as the block   is still 
in a valid alarm state OR the Re-alarm Time is not disabled.

 l Provide intelligent   alarming by suspending alarm processing within this block or multiple   blocks 
based on a process condition. 

 l Acknowledge alarms   from a remote site. 

 l Enable a block to   attempt to write the contacts with every scan, even if the value being   written is 
unchanged. 

 l Separate the original   alarm condition from the COMM alarm, and return the AA block to the same   
state as it was prior to a COMM alarm. 

 l Assist in control   situations such as direct digital control when chained to a PID or On-Off   Control 
block. 

 l Pass values to other   blocks through the Next Block field. 

 

Analog Input Block –   Typical Uses
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You can use the Analog Input block to:  

 l Read and write analog   values at set time intervals or by exception from an I/O address, such   as a 
PLC register. 

 l Perform smoothing,   signal conditioning, and alarm-limit checking. 

 l Assist in control   situations such as direct digital control when chained to a PID or On-Off   Control 
block. 

 l Initiate the processing   of other blocks through the Next Block field. 

 

Analog Output Block –   Typical Uses 

You can use the Analog Output block to:  

 l Send values to an   I/O address. 

 l Connect to modulated   control valves and motor speed controllers. 

 l Receive values from   the operator display and most primary, secondary, and control blocks,   
including the PID and Ramp blocks. 

 l Pass values to other   blocks through the Next Block field. 

 

Analog Register Block –   Typical Uses

You can use the Analog Register block to:  

 l Read and write to   multiple I/O locations as long as those locations share the same engineering   
unit limits and signal conditioning. 

 l Reduce system memory   requirements when alarming and background monitoring are not neces-
sary.   

 l Upload and download   infrequently-viewed or semi-static values from PLC memory. 

 

Boolean Block –   Typical Uses 

You can use the Boolean block to:  

 l Perform binary operations   and calculations. 

 l Calculate compound   alarm conditions. 

 l Monitor multiple   I/O points to obtain the status of a large device. 

 l Create state rings   for synchronizing and controlling batch processes. 

 l Process other blocks   through the Next Block field. 
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Calculation Block –   Typical Uses

You   can use the Calculation block to: 

 l Perform complex or multiple equations by chaining one Calculation   block to another or to a Fan-
out block.     

 l Verify the validity of manufactured parts by doing a calculation   on dimensions. You can use this 
feature to count faulty parts.     

 l Find the average reading when a large number of sensors (Analog   Input blocks) monitor the same 
parameter. For example, the Analog Input   blocks could measure the steam temperature at vari-
ous points in a pipe,   whose temperature is expected to remain the same.  

 

Dead Time Block –   Typical Uses

You can use the Dead Time block to:  

 l Set a transportation   delay between the sensor and the mechanism. For example, it could act   as a 
variable-speed conveyor belt. 

 l Simulate communication   or process delays with the hardware when you are first setting up your   
system offline. 

 

Device Control Block –   Typical Uses

You can use the Device Control block to:  

 l Monitor a number   of digital-input points and open a particular valve when all of the points   report 
that they are in a specified state. 

 l Specify other control   parameters, such as how long the block should wait for a digital-input   point 
to switch from closed to open before continuing with the next programming   statement. 

 l Control a solenoid   (digital output) that opens and closes a valve. 

 l Open and close limit   switches that confirm the operation of a valve. 

 

Digital Alarm Block –   Typical Uses

You can use the Digital Alarm block to:  

 l Detect alarm conditions   of a digital state (either level or transition). 

 l Represent items such   as limit switches, valves, alarm contacts, or motor auxiliary contacts.   

 l Assign descriptive   labels to digital values through the Open (Labels) and Close (Labels)   fields to 
make them more meaningful to the operator. 
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 l Define the alarm   value and priority for the block. 

 l Close a digital block   when an alarm condition occurs. 

 l Re-issue an alarm   within the time defined in the Re-alarm Time field, as long as the block   is still 
in a valid alarm state OR the Re-alarm Time is not disabled.   

 l Suspend alarm processing   within this block or multiple blocks based on a process condition. 

 l Acknowledge alarms   from a remote site. 

 l Enable a block to   attempt to write the contacts with every scan, even if the value being   written is 
unchanged.

 l Separate the original   alarm condition from the COMM alarm, and return the DA block to the same   
state as it was prior to a COMM alarm. 

 l Assist in control   situations such as direct digital control when chained to a PID or On-Off   Control 
block. 

 l Pass values to other   blocks through the Next Block field. 

 

Digital Input Block –   Typical Uses 

You can use the Digital Input block to:  

 l Provide alarming.   

 l Represent items such   as limit switches, valves, alarm contacts, and motor auxiliary contacts.   

 l Assign descriptive   labels to digital values through the Open (Labels) and Close (Labels)   fields to 
make these values more meaningful to the operator. 

 l Assist in control   situations such as direct digital control when chained to a PID or On-Off   Control 
block. 

 l Pass values to other   blocks through the Next Block field. 

 

Digital Output Block –   Typical Uses 

You can use the Digital Output block to:  

 l Establish steady-state   conditions using the Initial Value field by automatically sending a value   to 
the hardware the first time SAC processes the block during database   initialization. 

 l Connect to digital   devices, such as motor starters, horns, and solenoid valves. 

 l Assign descriptive   labels to digital values through the Open (Labels) and Close (Labels)   fields to 
make them more meaningful to the operator. 

 l Assist in control   situations such as direct digital control when chained to a PID or On-Off   Control 
block. 

 l Pass values to other   blocks through the Next Block field. 
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 l Prevent a write if   the value in the driver is the same as the value that is to be written.   The DO 
block will read the bit from the driver and if different, execute   the write. If the values are the same, 
no value is written on this scan.

 

Digital Register Block –   Typical Uses

You can use the Digital Register block to:  

 l Reduce system memory   requirements when alarming and background monitoring are not neces-
sary.   

 l Read and write to   multiple I/O locations in one poll record as long as those points share   the same 
engineering unit range and signal conditioning. 

 l Control digital input   processes such as limit switches, alarm contacts, and motor auxiliary   con-
tacts. 

 l Control digital output   processes such as motor starters, annunciators, horns, and solenoid 
valves.   

 

Event Action Block –   Typical Uses

You can use the Event Action block to:  

 l Send an Open/Close   output to a digital block. 

 l Place a primary block   or a chain on or off scan. 

 l Pass values to other   blocks through the Next Block field. 

 

Extended Trend Block –   Typical Uses

You can use the Extended Trend block to display real-time analog or   digital trends over an extended 
period of time.  

NOTE: If you want to   trend data for archival purposes, it is recommended that you use the Historical   Collect 
application. 

 

Fanout Block –   Typical Uses

You can use the Fanout block to:  

 l Send a set point   value to the PID block. 

 l Send a target value   to the Ramp block. 
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 l Send an analog value   to several different points from one block. 

 l Process other blocks   through the Next Block field. 

 

Histogram Block –   Typical Uses

You can use the Histogram block to:  

 l Receive process information,   such as temperatures, when upstream primary blocks are oper-
ating in Automatic   mode. 

 l Receive operator   information, such as weights, when upstream primary blocks are operating   in 
Manual mode. 

 l Process other blocks   through the Next Block field. 

 

Lead Lag Block –   Typical Uses 

You can use the Lead Lag block to:  

 l Implement feed-forward   control strategies when combined with a PID block. 

 l Process other blocks   through the Next Block field. 

 

Multistate Block –   Typical Uses

You can use the Multistate Digital Input block to:  

 l Monitor the pending   and on/off status of a device. 

 l Provide alarming.   

 l Represent items such   as motor-operated valves that have contacts at the open and close pos-
itions.   

 l Provide more meaningful   descriptions of raw values for operators by assigning labels to these   val-
ues. 

 l Pass values to other   blocks through the Next Block field. 

 

On-Off Block –   Typical Uses

You can use the On-Off Control block to:  

 l Perform actual control   for such items as heaters or pumps. 

 l Provide special alarm   handling. 
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 l Process other blocks   through the Next Block field. 

 

Pareto Block –   Typical Uses

You can use the Pareto block to record the number and percentage of   process or manufacturing defects. 

If you only want to track the total of all defects, use a Calculation   block instead of a Pareto block. 

 

PID Block –   Typical Uses

You can use the PID block to:  

 l Perform Gap Action   control in pH control processes. 

 l Provide feedback   control. 

 l Provide feed-forward   control. 

 l Provide anti-reset   windup capability to ensure that the controller output does not get saturated   
under conditions of windup. 

 l Execute bumpless   transfers by making the set point equal to the measurement (balancing)   when 
an operator switches the block from Manual to Automatic mode. 

 l Generate alarms on   set point deviations. 

 l Process other blocks   through the Next Block field. 

 

Program Block –   Typical Uses 

You can use the Program block to:  

 l Set up a master Program   block that CALLS other blocks. 

 l Provide complete   startup, shutdown, and sequencing of batch and continuous processes. 

 l Allow operators to   enter sequences of operations and tests in a simple, logical fashion.   

 

Ramp Block –   Typical Uses

You can use the Ramp block to:  

 l Start up ramp and   soak (hold) processes that require acceleration control. 

 l Process start up,   including temperature and speed ramping. 
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Ratio Bios Block –   Typical Uses

You can use the Ratio Bias block to:  

 l Blend elements requiring   a specific ratio to define their combination. 

 l Process other blocks   through the Next Block field. 

 

Signal Select Block –   Typical Uses

You can use the Signal Select block to:  

 l Support redundant   sensors. 

 l Monitor and control   large devices with multiple analog sensors. 

 l Perform selective   control, in which two PID blocks manipulate the same final control element,   
such as a valve. 

 l Process other blocks   through the Next Block field. 

 

SQL Data Block –   Typical Uses

You can use the SQL Data block to:  

 l Identify the block   and field pairs (data points) from which to read and write data. 

 l Set the direction   of the data transfer. The SQL Data block read or write values between   the iFIX 
process database and your relational database. 

 l Reset data points   when the SQL Data block executes. 

 l Connects to other   SQL Data blocks to form an extended chain. 

 

SQL Trigger Block –   Typical Uses 

You can use the SQL Trigger block to:  

 l Start the transfer   of process data to a relational database or to blocks in the process database.   
Data transfer is based upon a time, an event, or a combination of both.   

 l Confirm the transfer   of data. 

 l Provide operator   information in the iFIX WorkSpace. You can display the block's   time, date, 
event triggering parameters, and SQL commands through Data   links, allowing operators to 
change this values as needed. 

 l Manually trigger   the transfer of data from an operator display. 
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Statistical Control Block –   Typical Uses

You can use the Statistical Control block to:  

 l Perform automatic   adjustments to a value from another block if the upstream Statistical   Data 
block generates an alarm. The monitored value can be anything such   as a temperature or a pres-
sure. 

 l Adjust values such   as PID set points, Ramp block target values, or Analog Output values to   
optimize plant operating conditions. 

 

Statistical Data Block –   Typical Uses

You can use the Statistical Data block to:  

 l Measure process values   such as density, weight, and size. 

 l Sample event-triggered   values such as weights. 

 l Sample operator information   such as times in Manual mode through a Data link in the iFIX 
WorkSpace.   

 l Calculate control   limits and XBARBAR, RBAR, and SBAR values at startup after collecting   a 
pre-determined number of groups or based upon a moving average. 

 l Process other blocks   through the Next Block field. 

 

Text Block –   Typical Uses

You can use the Text block to:  

 l Provide operators   with messaging capabilities by entering the text string into a Data link.   

 l Send text (recipes)   to a device controller. 

 l Prompt operators   with text messages or alarms generated by your process hardware or OPC   
server. 

 

Timer Block –   Typical Uses

You can use the Timer block to:  

 l Record the duration   of a process. 

 l Monitor the length   of time a digital contact remains opened or closed. 

 l Track the amount   of time a piece of equipment has been in use. 
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 l Count up or down   to a specific value and trigger an alarm or close a contact. 

 l Track time-based   batch process steps. 

 

Totalizer Block –   Typical Uses

You can use the Totalizer block to:  

 l Maintain a running   total. For example, if you enter 00:00:00 in the block's PER field, the   block 
adds each value it receives to its previous value. 

 l Act as a counter.   For example, if you set the scan time of an upstream Analog block and   the 
Totalizer block's PER field to one, the Totalizer block increments   by one each time SAC scans 
the Analog block. 

 l Monitor production   levels based upon shifts or time periods. 

 l Process other blocks   through the Next Block field. 

 

Trend Block –   Typical Uses 

You can use the Trend block to:  

 l Display real-time   analog or digital trends. 

 l Process other blocks   through the Next Block field. 

NOTE: It is   recommended that you use the Historical Collect application for long-term data   storage 
needs.

 

Database Block Examples
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Click one of the blocks listed below for an example implementation.   

A 

Analog   Alarm

Analog   Input

Analog   Output

Analog   Register

B-C   

Boolean

Calculation

D 

Dead   Time

Device   Control

Digital   Alarm

Digital   Input

Digital   Output

Digital   Register

E-L   

Event   Action

Extended   Trend

Fanout

Histogram

Lead   Lag

M-Q   

Multistate   Digital Input

On-Off   Control

Pareto

PID

Program
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R-S   

Ramp

Ratio   Bias

Signal   Select

SQL Data

SQL   Trigger

T-Z 

Text

Timer

Trend

 

Analog Alarm Block Example

You can use the Analog Alarm block to obtain temperature readings of   an oven. When the oven is off and 
cooling, the operator can suspend alarms.   The following figure shows an example of how to use an Ana-
log Alarm block.   

When the oven is first turned on, Low Low and Low alarms could be delayed   to allow the oven to heat up. 
High and High High alarms could be reissued   until the operator turns down the temperature. If the block 
remains in   a High alarm for more than a predefined time interval, you could assign   a Digital Output block 
as a contact to trigger an alert and notify the   operator to reduce the oven temperature. If the block then 
generated a   High High alarm, you could assign a different Digital Output block as   a contact to auto-
matically reduce the oven temperature. 

 

Analog Input Block Example

The Analog Input block can receive temperature readings from a rotary   kiln that has a specified I/O 
address and then pass these values on to   the Histogram block. The following figure shows how to use 
an Analog Input   block in a chain.  
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A histogram designed in the iFIX WorkSpace could then display   the frequency distribution of the read-
ings. The Analog Input block could   also generate alarms. For example, if you set the High High alarm 
value   to 212 degrees, the block would generate a High High alarm with a reading   of greater than 212 
degrees. 

 

Analog Output Block Example

The Analog Output block receives values from its upstream block and   sends them to its I/O driver or 
OPC server. One way you might use this   capability is to adjust the temperature of a tank heater by con-
verting   the heater's temperature with a Calculation block and sending the converted   value to an Analog 
Output block. Once the value is received, the Analog   Output block sends it to its I/O driver, which writes 
the value to the   heater's I/O controller. You could also enter a value in the Initial Value   field to output a 
temperature set point during database initialization.   The following figure illustrates how to use an Analog 
Output block in   a chain. 

Another way you might use the Analog Output block is as a stand-alone   block to allow an operator, other 
blocks, or the initialization of the   database to control the values sent to the heater. The following figure   
shows how to use an Analog Output block as a stand-alone block. 

 

Analog Register Block Examples

You can display multiple I/O points with an Analog Register block by   adding Data links to a picture. The 
data source you specify for each Data   link is a specified number of values past the block's I/O Address. 
You   can enter A_ or F_ values in the data source, according to your needs.   

For example, suppose the poll record you want to access starts at address   4001. Also, suppose that the 
poll record contains 100 integers. 
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To access this poll record, you enter 4001 as the block's I/O address.   Then you can create Data links to 
access individual poll record values   by entering an A_ or F_ field as the data source. For example, to 
access   the 50th integer in the record, you would specify the 49th element past   the I/O address. As a res-
ult, you would enter A_49 or F_49 as the field   in the data source. 

Likewise, if the I/O address of the poll record is 1075 and you want   to access the first value, use the field 
A_0 or F_0 in the data source.   

 

Boolean Block Examples

The Boolean block can monitor the state of a tank by turning on a siren   on the plant floor if a problem 
arises. For example, suppose that the   following conditions indicate a problem:  

As these diagrams illustrate, a problem could be identified if either   of two situations is true. The first situ-
ation requires that two conditions   be true: the motor is on and the level is low. The second situation 
requires   that only one condition be true: the operator has put the unit on hold.   

Using these conditions, you would create a database block to monitor   each condition. DI1 to monitor the 
motor, AI1 to monitor the level, and   DOHOLD to place the tank on hold. 
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Once you create these blocks, you can use the Boolean block to send   a True (1) or False (0) signal to a 
Digital Output block, ALMDO, by entering   these blocks as input to the Boolean block and specifying an 
equation.   If the equation evaluates to true, the block sends a 1 to ALMDO and the   siren is turned on. If 
the equation is false, the block sends a 0 to ALMDO   and the siren remains turned off. 

 

Calculation Block Example

One way you might use the Calculation block is to convert a temperature   from Fahrenheit to Celsius. To 
do this, you would assign an Analog Input   block to read the temperature and pass it to the Calculation 
block as   the following figure shows: 

Once the Calculation block receives the temperature from the Analog   Input block it converts the value 
using the following equation: 

C=( F-32)*5/9   

To specify this equation to the Calculation block, assign each value   to one of the block's inputs and then 
enter the equation in the block's   Output field using the input letters. For example, to represent the pre-
vious   equation you would enter: 

((A-B)*(C/D)) 

where A is the input from the upstream Analog Input block, B is 32,   C is 5, and D is 9.  

 

Dead Time Block Example

The Dead Time block is a secondary block you can use to delay the information   to other blocks. Each 
Dead Time block can delay up to 255 seconds. If   your process requires longer delays, you can chain two 
or more Dead Time   blocks together as the following figure shows: 
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In this example, the input value received by the first Dead Time block   delays 255 seconds before send-
ing its value to the second Dead Time block.   In turn, the second Dead Time block delays an additional 
45 seconds, resulting   in a total delay of 300 seconds (5 minutes).  

 

Device Control Block Example

The Device Control block can fill a vat with substances from multiple   sources. Assume the vat contains 
five valves that must be opened or closed   based upon the status of the other valves, as shown in the fol-
lowing figure.   

The Device Control block's WAITOR command ensures that Valve A closes   before any other valve 
opens. By specifying digital output addresses in   the block's dialog box, you can use output commands 
to open Valves B,   C, D, and E according to your control scheme.  

  

Digital Alarm Block Example

You might use a Digital Alarm block to monitor whether or not a pump   is running. When the pump shuts 
off, it sends a digital signal to the   Digital Alarm block, which then generates an alarm. If the alarm is crit-
ical,   the block could re-issue the alarm after a predefined time interval. The   block could also close a con-
tact to trigger a shutdown procedure. The   following figure illustrates how to use a Digital Alarm block.  

 

Digital Input Block Example
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The Digital Input block can monitor whether a circulating pump is running   and generate an alarm when 
the pump stops (open). In this situation, you   would select the alarm condition Change from Normal Open 
so that should   the pump stop (change from a 1 to a 0), the Digital Input block generates   an alarm.  

 

Digital Output Block Examples 

The Digital Output block operates in a chain by sending digital values   to an I/O address based on the 
value it receives from its upstream block.   For example, the Digital Output block can control the status of 
an electric   motor by passing the 1 or 0 value it receives from an upstream Boolean   block's equation, as 
shown in the following figure.  

Using the block's Open or Close (Labels) fields, you can enter the words   OFF and ON to represent the 
motor's status and can display   this text to operators when they view the status in the iFIX WorkSpace.   

The Digital Output block, when used as a stand-alone block, allows either   its Initial Value field, other 
blocks, or an operator to control the values   sent to the I/O address. The following figure shows this con-
figuration.   

 

Digital Register Block Example

You can display multiple I/O points with a Digital Register block by   adding Data links to a picture. The 
data source you enter is a specified   number of values past the block's I/O Address. You can enter A_ or 
F_   values in the data source, according to your needs.  

For example, suppose the poll record you want to access starts at address   4001:0 and this record is 
composed of 16 bits (4001:0 to 4001:15). 
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To access this poll record, you enter 4001:0 as the block's I/O address.   Then you can create Data links 
to access individual poll record values   by entering an A_ or F_ field as the data source. For example, to 
access   the 9th bit in the record, you would specify the 8th element past the   I/O address. As a result, you 
would enter A_8 or F_8 as the field in the   data source. 

Likewise, if the I/O address of the poll record is 1075:0 and you want   to access the first value, use the 
field A_0 or F_0 in the data source.   

 

Event Action Block Example

The Event Action block can control a digital output based upon an analog   value received from an 
upstream block. For example, suppose your process   requires that a 100-gallon floating roof tank to be 
80% full at all times.   Using an Analog Input block, you can measure the level of the tank and   pass this 
value to the Event Action block. The Event Action block then   tests the analog value to determine if it 
should:  

 l Open or close the   digital valve controlling the liquid flow. 

 l Run a program that   opens an emergency drain and sequentially shuts down the pumps. 

The following figure shows how you can use an Event Action block to   control digital points. 

 

Extended Trend Block Example
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Using the Extended Trend block, you can trend a value over a period   of time. For example, suppose you 
want to trend an oven temperature for   an hour using the configuration shown in the following figure. 

You can accomplish this by creating an Analog Input block that receives   its value from the oven tem-
perature and an Extended Trend block to trend   the data. Be sure to connect the two blocks by entering 
the name of the   Extended Trend block into the Next field of the Analog Input block. This   ensures the 
Extended Trend block receives data from the upstream Analog   Input block. 

Once you finish configuring the process database, create a chart to   the T_DATA field of the Extended 
Trend block. 

 

Fanout Block Example

The Fanout block can send one analog value to different blocks, while   passing the same value onto the 
next block in the chain. For example,   if you need to use an analog value as an input to a Calculation 
block   and you also need it as the source of a PID set point, the Fanout block   can pass the same value to 
both chains as shown in the following figure.    

You can configure the Fanout block in this manner by: 

 1. Entering the Calculation   block's name in the Fanout block's Next field. 

 2. Entering the PID   block's name and the target field, F_TV1, in the Fanout block's Destination   A 
field. 

 

Histogram Block Example
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An Analog Input block can send temperature readings to the Histogram   block to track the frequency of 
the temperatures in a forced-air heat   exchanger as shown in the following figure. 

In this example, every time iFIX scans the Analog Input block, it sends   a temperature to the Histogram 
block. The Histogram block collects these   values according to its Group field. This field determines the 
number   of values it collects from the upstream block.  

 

Lead Lag Block Example 

When combined with a PID block, you can use the Lead Lag block in feed-forward   control strategies 
where you are using the same process variable at two   different points. For example, suppose that more 
water must be sent to   a heat exchanger prior to increasing the fuel supply to prevent flooding   the sys-
tem. You must control the flow rate of the water, but you cannot   manipulate it directly since the valve is 
non-linear and subject to external   influences.  

In this example, you can use a Lead Lag block to anticipate the change   and make faster adjustments to 
the water supply. 

 

Multistate Block Example 

With the Multistate Digital Input block configured as a stand alone   block, you can monitor the status of a 
mechanical valve (VALVE1) with   contacts at the open and close positions. Usually, you would create a   
Digital Input block to provide simple ON/OFF digital status. However,   with the Multistate Digital Input 
block, you can monitor and display to   operators the pending, or middle, status of VALVE1 as well as the 
ON/OFF   status.  

The operators can use a Multistate Digital Input block to retrieve the   open and close digital values from 
the PLC and configure one of four raw   values that represent the status of VALVE1. The following figure 
illustrates   this concept. 
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On-Off Control Block Example

The On-Off Control block uses contact inputs to implement on-off control   based on an analog value. For 
example, as the following figure shows,   the High Contact Data fields can open a valve to add hot water 
to a tank   when the temperature reading falls below a specified value. In turn, the   block can turn off the 
hot water when the temperature reaches a specified   value.  

In addition, the Low Contact Data fields can trigger a cold water valve   to close when the temperature 
falls below a specified value and to open   when the reading rises above the value. 
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Pareto Block Example

A milk packaging plant could use a Pareto block to record the number   of rejected milk cartons. A carton 
can be rejected because of a puncture,   it is the wrong size, it has a bad seal, or it is poorly labeled. To 
tally   each defect requires four Analog Input blocks. You can use these four   blocks as inputs into the 
Pareto block. The following figure illustrates   the flow of information to the Pareto block. 

 

PID Block Examples 

The PID block can prevent reset-windup through the use of the Feedback   Tag. Reset-windup typically 
occurs when there is a hardware failure in   the measurement device. This causes the deviation to be lar-
ger than the   parameters of the block would normally produce in a full output swing.    

The following figure illustrates how the Feedback Tag ensures that the   controller does not get saturated 
under these conditions. By indicating   that the PID block's output is not maintaining the set point, the 
Feedback   Tag can help to avert serious control upsets. 
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If your processing scheme requires a cascade loop, the PID block can   include master and slave PID 
blocks, as the following figure shows. The   slave PID block can fetch the master PID block's adjusted 
output value   for its set point. 

The cascade loop, shown in the preceding figure, illustrates control   in which the output of one PID block 
(master) provides the set point value   for another PID block (slave). The Master PID block drives the set 
point   of the slave PID block, which, in turn, controls the flow of fuel oil   based upon the readings from a 
temperature transmitter. To accomplish   this, specify the master block's name and the F_CV field in the 
slave   block's Set Point Value field. 

NOTE: If you specify   the slave block in the master's Next Block field, the master can only   send the slave a 
value as a variable and cannot output a value to the   process.

 

Program Block Example

You can use the Program block as a master program to develop flexible,   generic subprograms. By con-
necting a master Program block with subroutines   in other Program blocks, you can use the blocks in 
many different applications.   

CALL commands are very useful for setting up this type of batch process.   For example, you could have 
a master program with the following CALL commands:   
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00 CALL STARTUP 
01 CALL PROCESS 
02 CALL SHUTDOWN 

In this example, STARTUP, PROCESS, and SHUTDOWN are other Program blocks   that perform spe-
cific functions. PB01 executes each subprogram sequentially.   For example, PROCESS cannot start 
until STARTUP has executed. 

Another master Program block for a second process could use the same   startup and shutdown sub-
programs, but replace PROCESS with PROCESS1. 

 

Ramp Block Example

The Ramp block can ensure the stability of a motor that is essential   to a start up process. The block 
assists in the ramp and soak methods   used to bring the motor up to full speed by directing the increase 
and   hold time in RPMs during three defined stages:  

In the first stage, the block ramps up to the Target 1 value based upon   the increments specified in the 
Ramp Rate 1 field. When the Target 1 value   is reached, the block continues to output the Target 1 value 
for the period   specified in the Hold Time 1 field. After this period has expired, the   block repeats the pro-
cess for ramp stages 2 and 3. 

NOTE: If a Ramp rate   is 0.00, the stage is not executed. 

 

Ratio Bias Block Example

The Ratio Bias block can control blending systems that require predetermined   proportions for an 
optimum flow rate. For example, suppose the blending   of additives to gasoline require controlled blend-
ing so that the octane   number remains steady. 
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Using the Ratio Bias block, you establish a consistent ratio that controls   the flow of additives to the gas-
oline based upon the Ratio, Bias, and   Input entries.  

 

Signal Select Block Example

The Signal Select block can maintain the stability of large devices   with multiple analog devices. For 
example, the block can control the temperature   of a large furnace with three temperature sensors: 

In this example, the Signal Select block takes the average of the three   sensor readings from Analog 
Input blocks and passes the new value onto   the PID block. Using this value, the PID block controls the 
heat of the   furnace through the Analog Output block.  

 

SQL Data Block Example

You can provide better control over monitoring SQL data by displaying   to operators the actual values that 
the SQL Data block retrieves. The   block reads these values each time the upstream SQL Trigger block 
executes.   

You can display the retrieved data to operators by adding Data links   that reference the fields A_TF01 
through A_TF20. These fields correspond   to the 20 block and field pairs (data points) listed in the SQL 
Data block.   

You may also want to configure the Reset field of each data point to   BLANK or ZERO. Selecting these 
values clears the A_TS fields prior to   retrieving a new value and ensures that operators always see the 
latest   values. You can configure the Reset field in the block's dialog box or   by creating Data links to the 
A_RST01 to A_RST20 fields. 

Keep in mind that when block and field name pairs have a direction of:   

 l In   – the   Reset To field clears the value before the SQL Data block executes. 

 l Out   – the   Reset To field clears the value after it is retrieved. 

 

SQL Trigger Block Example
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The SQL Trigger block execute SQL commands based on a specific time   and date or an event. Using 
this feature, the block can select data from   a relational database for use in the process database or save 
process   data in your relational database at predefined intervals. 

You can also configure the SQL Trigger block for manual use by allowing   operators to manually trigger it. 
By manually triggering the block, operators   can update the relational database or retrieve data from it on 
an as-needed   basis. To configure the block for manual use, place the block in Manual   mode and create a 
Data link to the field A_TRIP. After completing these   tasks, operators can manually trigger the block by 
entering a 1 into the   field.  

 

Text Block Example

The Text block can read hardware messages from the plant floor. Using   a script, iFIX could then com-
pare each text string against a list of possible   values and take the appropriate action. For example, if the 
Text block   receives a High alarm string, the script could close a valve or trigger   a event schedule, as 
needed.  

 

Timer Block Example

The Timer block can monitor the amount of time a piece of equipment,   for example a mixer, has been run-
ning. When the block reaches a predefined   value, it could trigger an alarm to notify the operator to per-
form preventive   maintenance.  

 

Trend Block Example

You can chain together Trend blocks to trend more than 80 values. The   following steps illustrate the 
design of the following chain:  

To chain Trend blocks together:

 1. Add a Trend block   to the process database. 

 2. Enter the name of   the second Trend block in the Next Block field of first Trend block. 

 3. Add the second Trend   block to the process database. 
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 4. Enter the name of   the first Trend block followed by the F_INP field into the Input field   of second 
Trend block. 

You could continue and add a third Trend block to become part of a chain   similar to the one identified in 
the following table. This table shows   the key fields to complete. 

Block Type Block Name INPUT Field Next Block field AVG/COMPRESS Field 
Analog Input AI1 N/A TR1 N/A 
Trend TR1 AI1.F_CV TR2 5
Trend TR2 TR1.F_INP TR3 5* 
Trend TR3 TR2.F_INP AO1 5* 
Analog Output AO1 N/A blank N/A 

* NOTE: You can   enter any number from 1 to 255 into the Average Compress field; however,   when you chain 
multiple Trend blocks together, the value you enter for   the second and subsequent Trend blocks should be 
the same as the first   Trend block's. If the values in the Average Compress fields do not match,   the visual pat-
tern of trended data displayed in the iFIX WorkSpace   is different and possibly confusing to operators. 

If the Input field of trailing Trend blocks is blank, these blocks trend   the value passed to them. For 
example, using the values from the preceding   table, if the Input fields of TR1 and TR2 are blank , all 
three Trend   blocks would trend the same 80 values sent by AI1 instead of a chain of   240 values. 

 

Commands Available from Database Blocks

The following database blocks allow you to use enter commands:

 l Device   Control Block (DC)

 l Event   Action Block (EV)

 l Program   Block (PG)

For information on the supported commands available from each of these   blocks, refer to the following 
sections:

 l Device   Control Block Commands

 l Event   Action Block Commands

 l Program   Block Commands

 

Device Control Block Commands

You can include up to 12 programming statements in a Device Control   block. These statements let you 
control the block and often require a   contact pattern to wait for or to output. 

The Device Control block processes the statements in order. Each statement   can contain up to 34 char-
acters. The following table lists the commands   you can use with the Device Control block. 

Execution Control Commands   Wait Commands Test and Jump Commands
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CLRDEBUG DELAY GOCLR
CLRERR WAITAND GOSET
CLRF WAITOR GOTO
END   
NUL   
OUTPUT   
SETDEBUG   
SETERR   
SETF   

 

CLRDEBUG Command

Purpose

Exits the debug mode. 

Syntax

CLRDEBUG 

 

CLRERR Command

Purpose

Clears the alarm status of the Device Control block. 

Syntax

CLRERR 

 

CLRF Command 

Purpose

Clears the bit of the specified register. This command is used only   with the SIM driver provided with 
iFIX. This driver lets you access a   digital point by specifying a register and a bit. SIM registers range   
from 0 to 2000 and bits range from 0 to 15. 

Syntax

CLRF register:bit

Example

To clear the 12th bit of the tenth SIM register, enter: 

CLRF 10:12 
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DELAY Command

Purpose

Delays the execution of the next command for the specified number of   seconds. You can specify to 
delay the command from 0 to 32767 seconds.   The exact time you enter should be a multiple of the 
chain's scan time.   

Syntax

DELAY time 

Example

To delay the next command for 20 seconds enter: 

DELAY 20 

 

END Command 

Purpose

Causes the Device Control block to go off scan. 

Syntax

END 

 

GOCLR Command

Purpose

Executes a specified statement if the digital points bit is 0 (clear).   This command is used only with the 
SIM driver provided with iFIX. SIM   registers range from 0 to 2000 and bits range from 0 to 15. The state-
ment   number can reference any programming statement in the block. 

Syntax

GOCLR register:bit statement#

Example

To examine the fifth bit in the 44th register and determine if the bit   is clear (equal to 0), enter: 

GOCLR 44:5 5 

If the bit is clear, the Device Control block executes statement 05.   

 

GOSET Command
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Purpose

Executes a specified statement if the digital points bit is 1 (set).   This command is used only with the 
SIM driver provided with iFIX. SIM   registers range from 0 to 2000 and bits range from 0 to 15. The state-
ment   number can reference any programming statement in the block. 

Syntax

GOSET register:bit statement#

Example

To examine the second bit in the 30th register and determine if the   bit is set (equal to 1), enter: 

GOSET 30:2 09 

If the bit is set, the Device Control block executes statement 09. 

 

GOTO Command

Purpose

Continues executing commands at the specified programming statement   number. The statement num-
ber can reference any programming statement in   the block. 

Syntax

GOTO statement#

Example

To continue executing commands with statement 08, enter: 

GOTO 08 

 

NUL Command

Purpose

Causes no operation. Use NUL as a placeholder for deleted commands,   unused command lines, or for 
use during debugging. 

Syntax

NUL 

 

OUTPUT Command 

Purpose

Sends the output contact pattern to the digital output points when this   statement is executed. 
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Syntax

OUTPUT pattern

Example

This an example of the command:

OUTPUT CCCOOOXX 

In this example, the Device Control block switches each digital output   point to the status shown below. 

Output Address Status 
07 Close 
06 Close 
05 Close 
04 Open 
03 Open 
02 Open 
01 Current state 
00 Current state 

 

SETDEBUG Command

Purpose

Enters debug mode and traces execution through messages sent to alarm   destinations. 

Syntax

SETDEBUG 

 

SETERR Command

Purpose

Generates an alarm from the Device Control block to all enabled alarm   destinations. The alarm contains 
the text "ERROR" and you can   view the alarm in an Alarm Summary object. You can clear the alarm 
with   the CLRERR command. 

Syntax

SETERR 

 

SETF Command
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Purpose

Sets the bit of the specified register. This command is used only with   the SIM driver provided with iFIX. 
SIM registers range from 0 to 2000   and bits range from 0 to 15. 

Syntax

SETF register:bit

Example

To set the 15th bit in the fifth SIM register to 1, enter: 

SETF 5:15 

 

WAITAND Command 

Purpose

Waits for all of the digital input addresses to match the specified   contact pattern before continuing to the 
next statement. If the condition   does not occur within the specified time parameter, this command con-
tinues   to the statement specified by the statement number. 

You can enter a wait time from 0 to 32767 seconds. Entering 0 makes   the block wait indefinitely. 

The contact pattern must include a letter (O, C, X) for each digital   input address as the following figure 
shows: 

The statement number can reference any programming statement in the   block. 

Syntax

WAITAND time pattern statement#

Example

To wait 20 seconds for a specific contact pattern to occur, enter: 

WAITAND 20 000CCXXXXXXXXXXX 10 

If the contact pattern does not occur within 20 seconds, the Device   Control block proceeds to statement 
10. 

 

WAITOR Command
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Purpose

Waits for any of the digital input addresses to match the specified   contact pattern before continuing to 
the next statement. If the condition   does not occur within the specified time parameter, this command 
continues   to the statement specified by the statement number. 

You can enter a wait time from 0 to 32767 seconds. Entering 0 makes   the block wait indefinitely. The 
contact pattern must include a letter   (O, C, X) for each digital input address as the following figure 
shows:   

The statement number can reference any programming statement in the   block. 

Syntax

WAITOR time pattern statement#

Example

To wait 20 seconds for any one of the points specified in the input   address fields, 15 to 00, to match the 
corresponding contact pattern,   enter: 

WAITOR 20 OOCCCCCXXXXXXXXX 7 

If the contact pattern does not occur within 20 seconds, the Device   Control block proceeds to statement 
07. 

 

Event Action Block Commands

You can use the following commands with THEN or ELSE operations: 

Command Description 
RUN block Turns the block on scan. 
STOP block Turns the block off scan. 
CLOSE 
block 

Sets a digital block to CLOSE. Digital Input and Digital   Alarm blocks must be in Manual 
mode. 

OPEN block Sets a digital block to OPEN. Digital Input and Digital   Alarm blocks must be in Manual 
mode. 

 

Event Action Block –   Operators and Conditions

The Event Action block tests the value or alarm condition of the previous   block using IF-THEN-ELSE 
logic. In the IF portion of the logic, you can   specify the value or alarm condition for which you want to 
test. 
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Enter... To test the... Example 
VALUE operator condition Current value of the upstream block. VALUE = 75.4 
ALARM operator condition Current alarm condition of the upstream block. ALARM = LOLO 

If the condition is true, the block's THEN logic executes. If the condition   is false, the block's ELSE logic. 
Valid operators and conditions include:   

If you use... Then the operator can   be... And the condition can   be... 
A value > (Greater than) 

< (Less than) 
= (Greater than or equal to) 
<= (Less than or equal to) 
= (Equal to) 
!= (Not equal to) 

A constant 
A data source 
OPEN/CLOSE 

An alarm > (Greater than) 
< (Less than) 
>= (Greater than or equal to) 
<= (Less than or equal to) 
= (Equal to) 
!= (Not equal to) 

Any   valid alarm. 

 

Program Block Commands

                         

You can include up to 20 programming statements in a Program block.   These statements let you control 
the block. Click any command from the   following list to display detailed information. 

A-B

ADDOUT

ADDTAR

C-D

CALL

CLOSE

CLRDEBUG

CLRERROR

DELAY

E-L

END

GOTO
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IF

IFTIME GOTO

M-Q

MAXWAIT

MSG

NUL

OPEN

PLAYSOUND

R-S

RUN

RUNTASK

SETAUTO

SETDEBUG

SETERROR

SETLIM

SETMAN

SETOUT

SETSEL

SETTARG

SETTIME

STOP

SUBOUT

SUBTAR

T-Z

WAITFOR

WAITSTAT

 

Using Programming Commands

SAC and the Program Block 

When SAC scans a Program block, it generally runs all of the block's   commands within one scan period. 
After scanning the Program block, SAC   does not scan it again unless: 
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 l The block is placed   on scan again by the operator or another block, such as an Event Action   
block or another Program block. 

 l The database is reloaded.   

 l The block contains   a test or wait command, and the specified condition is not met. For example,   
if you have an IF command that tests for a specific level and issues a   GOTO command to a pre-
vious step if the level is not met, SAC continues   to scan the block until the condition is met. 

 l GOTO 0 is the Program   block's last statement. In this case, the block continually loops and   SAC 
scans the block according to the specified scan time. 

Delaying Program Commands 

Certain commands limit a test command's duration. For example, you may   want to use the WAITFOR 
command to have the Program block wait for an   Analog Input block to receive a value of 50 before it pro-
ceeds to the   next command. However, if the Analog Input block never receives a value   of 50, the remain-
ing commands never execute. To avoid this result, you   can use the MAXWAIT command. This 
command specifies how long the block   waits before it automatically goes onto the next command. You 
could then   use the GOTO command to tell the Program block to jump to a particular   command found 
later in the programming sequence. For example: 

09 MAXWAIT 60 
10 WAITFOR AI1 = 50 
11 GOTO 16 

In this example, the block waits 60 seconds before executing the GOTO   command. The GOTO com-
mand specifies that step 16 is the next step to execute.   

If you set up a command that waits a long time to complete, you should   also include a command that 
notifies you when the wait ends. This method   allows you to determine if an event has occurred. For 
example: 

04 WAITFOR AI1 = 50 
05 MSG AI1 IS NOW 50 

In this example, the message "AI1 IS NOW 50" prints only when   AI1 has successfully reached a value 
of 50. If AI1 never reaches 50, the   message is not sent to the enabled alarm destinations. 

Clamping Values 

If the Program block sends a value to another block and the value exceeds   a target block's EGU range, 
iFIX clamps the value to the block's high   and low EGU limits. For example, if you SETOUT a value of 
150 to a block   whose EGU range is 0 to 100, the setout value is clamped at 100. 

Execution Errors 

The Program block goes off scan whenever it cannot execute a command.   Prior to going off scan, the 
block sends a message to all the enabled   alarm services in its alarm areas. The off scan message 
explains at what   line the block stopped and why. 

Make sure you test your Program blocks thoroughly before placing it   in actual operation. You can use the 
debugging commands, SETDEBUG and   CLRDEBUG, to help test your Program blocks before placing 
them online.   

 

Using Command Arguments

260 © 2020 General Electric Company. All rights reserved.



Every step of a Program block contains at least one command. Each command   is made up of the com-
mand keyword (for example SETOUT or MAXWAIT) and   zero or more command arguments. You can 
use values or expressions as command   arguments. 

Values 

Values are either a constant number or a block name. Numbers can be   positive or negative integers or 
floating point values. A block name is   the name of any block within the process database. Most com-
mands are used   in conjunction with a block. 

Expressions 

Expressions compare values in the IF and WAITFOR commands. An expression   has the syntax: 

operand1RelationalOperatoroperand2

Operand1 can be: 

Operand1 Example 
A block name AGITSTART 
TIME, DATE, or DAY (must be used with a constant)   IF TIME = 12:00:00 GOTO 05 
OPEN/CLOSE register:bit OPEN 23:14 

Operand2 can be: 

Operand2 Example 
Floating-point or integer values SETOUT 

AI1 34.56 
OPEN/CLOSE WAITFOR 

DI1=OPEN 
A block name AGITSTART 
MM-DD-YY, SUN, MON, TUE, WED, THU, FRI, SAT, or HH:MM:SS   for TIME, 
DATE, and DAY operands only. International time formats are   also accepted. 

IF DAY = 
FRI GOTO 
08 

All relational operators are   legal for floating-point and integer values. However other values, such   as day 
of the week, are restricted to = (Equals) and != (Not equal). Supported   relational operators described in 
the following table. 

Operator Function 
> Greater than 
< Less than 
<= Less than or equal to 
>= Greater than or equal to 
!= Not equal 
= Equals 

NOTE: When using the   IF or WAITFOR commands to compare values, consider using the SETLIM command   
to create a limit of precision for the comparison. In some cases, 10 might   not equal 10, since the block might 
really be comparing 10.0001 to 10.0003.   The SETLIM command lets you assign an inclusion limit for the com-
parison,   such as +/-0.1. Please refer to the SETLIM command for more information.   

 

ADDOUT Command
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Purpose

Adds a specified value to the current value of another block. 

Syntax

ADDOUT value TO block 

Example

To add 34 to the current value of the block AI2, enter: 

ADDOUT 34 TO AI2 

NOTE: Be sure to include   a DELAY command after an ADDOUT command when it adds a value to an Analog   
Output block. Using the DELAY command ensures the Analog Output block   can properly process the data it 
receives from the Program block. 

 

ADDTAR Command

Purpose

Adds the current value of one block to the TARGET value of another block.   You can also use this com-
mand to set the target for any of the three stages   of the Ramp block. 

Syntax

ADDTAR block TO block 

NOTE: When specifying   a Ramp block, ADDTAR adds the value to the first target value of the block,   
ADDTAR2 adds the value to the second target value, and ADDTAR3 adds the   value to the third target value. If 
a target value that is outside the   Ramp block's EGU range, the Ramp block clamps the value to its low and   
high EGU limits. AO blocks to not have target values. When using blocks   like AO or AI, which do not have tar-
get values, use ADDOUT command. 

Example

To add the current value of the block AI3 to the block PID5, enter:   

ADDTAR AI3 TO PID5 

To add the current value of the block AI10 to the second target value   of RAMP6, enter: 

ADDTAR2 AI10 TO RAMP6 

 

CALL Command 

Purpose

Places another block (usually another Program block, Device Control   block, or Boolean block) on scan, 
while the original Program block pauses.   The command returns to the original block and resumes exe-
cution when the   called block completes its operation. If you want the Program block making   the call to 
continue running, use the RUN command instead. 
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Syntax

CALL block 

Example

To place the block PROG2 on scan, enter: 

CALL PROG2 

NOTE: When making a   CALL to a Program block, make sure you take into account any previous   MAXWAIT 
commands. In addition, you cannot use the CALL command in a Program   block that is part of an exception-
based chain. 

Called blocks should be off scan until called. If the block calls a   block that is already on scan, the call is 
ignored. 

 

Purpose

Closes a digital block (sets the value equal to 1). The block reflects   the new value based on its own scan 
period. 

You can also close SIM registers. SIM registers range from 0 to 2000.   Bit values range from 0 to 15. 

Syntax

CLOSE block 
CLOSE register:bit 

Example

To close the Digital Output block DO1, enter: 

CLOSE DO1 

To close SIM register 28:4, enter: 

CLOSE 28:4 

NOTE: When using the   CLOSE command to set a Digital Input block, the block must be in Manual   mode. If 
you attempt to set a Digital Input block that is in Automatic   mode with a CLOSE command, iFIX generates an 
error message and takes the   Program block off scan.

 

CLRDEBUG Command

Purpose

Exits the debug mode and resumes normal execution. Refer to the SETDEBUG   command for more 
information on debug mode. 

Syntax

CLRDEBUG 
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CLRERROR Command

Purpose 
  Clears the error condition (alarm) that was established by a preceding   SETERROR command.   

Syntax 

CLRERROR 

 

DELAY Command

Purpose

Delays the execution of the remaining steps in the block for the specified   number of seconds. 

Syntax

DELAY value 

Parameter

value – specifies   the number of seconds (0-32767 seconds) you want to delay execution. The   value you 
enter should be an exact multiple of the chain's scan time.   If it is not, the value is rounded to the next 
highest multiple of the   block's scan time at runtime. Use the following formula to determine the   cor-
rect value for the DELAY command: 

  For example, if you enter a value of 10 (seconds) and the block has a scan   time of 5 seconds, the 
DELAY command delays the block for two scan periods.   If the value you specify is not evenly divisible 
by the scan time, the   calculation is rounded to the next highest multiple of the scan time.     

Example

To delay execution of the remaining steps for 10 seconds, enter: 

DELAY 10 

NOTE: You cannot use   the DELAY command in a block that is exception-based. 

 

END Command

Purpose

Places the block executing this command off scan. 

Syntax

END 

 

GOTO Command
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Purpose

Allows the program to continue execution at the designated step number.   

Syntax

GOTO step# 

Parameters

step# – specifies   the step number you want to go to. If the designated step number is less   than the cur-
rent step number (making a backward jump), iFIX suspends processing   the Program block and the 
jump occurs during the next scan period. If   the designated step number is greater than the current 
step number (making   a forward jump), execution continues at the next step without interruption.   

Example

To continue execution at the step 14, enter: 

GOTO 14 

 

IF Command 

Purpose

Tests a condition and then specifies a statement number to go to. 

Syntax

IF expression GOTO step # 

Parameters

expression – compares   values in the IF command. The syntax of an expression for these commands   is: 

operand1 relationaloperator operand2 

For more information on these arguments,   refer to the topic Using Command   Arguments. 

GOTO step# – specifies   the step number you want to go to when the expression is TRUE. If the   des-
ignated step number is less than the current step number (making a   backward jump), iFIX suspends 
processing the Program block and the jump   occurs during the next scan period. If the designated 
step number is greater   than the current step number (making a forward jump), execution continues   at 
the next step without interruption. 

TIP: In rare instances,   you can have a Program block that waits for a specific value from a block   to test 
a condition, but because of the unavoidable round-off errors that   occur in digital systems, the block con-
sistently sends out a slightly   different value that never satisfies the condition. For example, 10 might   not 
equal 10, since the block might really be comparing 10.0001 to 10.0003.   The easiest way around this 
problem is to add a SETLIM   command to create a limit of precision on the value that is received   from the 
block. This command lets you assign an inclusion limit for the   comparison, such as +/- 0.1. 

Examples

You can use the IF command to test for a condition and then jump to   a specific command. For example, 
if the value of the Analog Input block,   LEVEL, is greater than 3000, then proceed to step 12 uses the fol-
lowing   statement: 
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08 IF LEVEL > 3000 GOTO 12 

Operands

The IF command can also use the operands: 

 l DATE

 l DAY 

 l TIME 

IF DATE 

To test that the date is June 29, 1997 before executing step 12, enter:   

04 IF DATE > 06-29-97 GOTO 12 

If the date is any other date, then step 05 executes. 

IF DAY 

To test for the correct day, use the following statements: 

Step# Command Action 

3 IF DAY=SUN GOTO 06 If it is Sunday, go to Step 6. 

4 WAITFOR TIME =23:59:59 If it is not Sunday, wait = 23:59:59 until the next   day. 

5 GOTO 3 Check again to see if it is Sunday. 

6 CALL PM Call Program block for preventive maintenance cycle.   

NOTE: You can only   use = and != for operators with the DAY operand. Legal identifiers for   days of the week 
are SUN, MON, TUE, WED, THU, FRI, and SAT. 

IF TIME 

The TIME operand executes the designed step number according to the   time of day. This command dif-
fers from the IFTIME GOTO command in that   you do not have to use it in conjunction with a WAITSTAT 
command. To make   the distinction between the commands, use a space between the IF command   and 
the TIME operand.

The IF TIME command uses the block's scan time as a +/- dead band if   you are using the Equals (=) 
operator. You can enter the time in a 24-hour   format, HH:MM:SS. 

Consider the following command: 

07 IF TIME = 12:00:00 GOTO 4 

If the block has a scan time of 2 minutes, the command evaluates to   true at any time between 11:58:00 
and 12:02:00 as shown below. 

Therefore, even if the block is not scanned at exactly 12:00:00, the   IF TIME command still executes as 
close to 12:00 as the scan time allows.   
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However, because of the deadband, it is possible for the IF TIME command   to execute more than once. 
For example, if iFIX scans the block with the   - scan time to the + scan time range, it is scanned twice, 
as shown below:

If the block is scanned exactly on the edge of the deadband, iFIX scans   the block three times, as shown 
below: 

To prevent multiple executions, the IF command could be used with TIME   and GOTO as follows: 

Step# Command Comments 

14 IF TIME-
E=12:00:00 
GOTO 16 

12:00 is half an hour prior to plant shutdown; start   shutdown pro-
cedures. 

15 WAITFOR 
TIME 
=23:59:59 

If time is outside the deadband range, return to step   0 and start 
another run. 

16 GOTO 3 Reminder to operator to start shutdown procedures.   

17 CALL PM Delay for three times the scan time (2 minutes in   this case) to pre-
vent the IF TIME command from executing more than once.   

 

IFTIME GOTO Command

Purpose

Waits for a preceding WAITFOR or WAITSTAT command to timeout before   proceeding to a step num-
ber other than the one that follows either command.   

Syntax

IFTIME GOTO step# 

Example

Use the following example, to provide a processing check: 

Step Command Action 

08 MAXWAIT 60 Set the maximum wait time. 

09 WAITFOR AI1 > 90 Wait for the temperature to exceed 90 degrees. 

10 IFTIME GOTO 14 If the temperature is not greater than 90 degrees   after 60 seconds, go to step 
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14; otherwise, proceed to the next step.   

11 MAXWAIT 0 Reset MAXWAIT before making a call. 

12 CALL PROCESS Call a Program block that runs the actual process.   

13 END End the program. 

14 CALL WARMUP Call a Program block that increases the temperature.   

15 GOTO 8 Return to step 8. 

NOTE: In this   example, the MAXWAIT command determines how long the block waits for the   temperature to 
exceed 90. Yet whether the process times out or the condition   set by WAITFOR is fulfilled, the block continues 
to the next step. This   means that in the event of an equipment failure another process operation   is executed in 
response to the failure. 

By including the IFTIME GOTO command, you provide an alternative path   if the WAITFOR condition is 
not fulfilled. 

 

MAXWAIT Command

Purpose

Defines the time the block waits for the condition specified in a subsequent   WAITFOR or WAITSTAT 
command to occur. 

Syntax

MAXWAIT value 

Parameter

value – specifies   the number of seconds (0-32767 seconds) you want to wait. The value you   enter 
should be an exact multiple of the chain's scan time. If it is not,   the value is rounded to the next 
highest multiple of the block's scan   time at run-time. Note that the value 0 means to wait forever. 

  For example, if you specify a MAXWAIT of 60 seconds and the block has a   scan block of 25 seconds, 
the MAXWAIT command suspends the block for 75   seconds because the MAXWAIT period extended 
into the block's third scan   period.   

Examples

The MAXWAIT command applies to all subsequent WAITSTAT and WAITFOR commands   unless 
another MAXWAIT command occurs. For example: 

MAXWAIT 60 
WAITSTAT PID1 AUTO 
WAITFOR AI1 10 
MAXWAIT 5 
WAITSTAT SUBPROG1 ON 

In this program, the block waits a maximum of 60 seconds for PID1 to   be switched to Automatic mode 
and another 60 seconds for the output of   AI1 to equal 10. But the block only waits a maximum of 5 
seconds for SUBPROG1   to be placed on scan. 

The MAXWAIT command also applies to called Program blocks. For example:   
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MAXWAIT 60 
CALL PROG2 
SETAUTO AI1 

These commands instruct the Program block to wait a maximum of 60 seconds   before it switches AI1 to 
Automatic mode. The SETAUTO command is then   processed within 60 seconds regardless of whether 
PROG2 has processed   all of its commands. 

 

MSG Command

Purpose

Prints the specified text to the enabled alarm destinations in the block's   alarm areas. 

Syntax

MSG string 

 

NUL Command

Purpose

Causes no operation; this is a place-holder for deleted commands or   for use during debugging. 

Syntax

NUL 

 

OPEN Command

Purpose

Opens a digital block (sets the value equal to 0). The block reflects   the new value based on its own scan 
period. 

You can also open SIM registers. SIM registers range from 0 to 2000.   Bit values range from 0 to 15. 

Syntax

OPEN block 
OPEN register:bit 

NOTE: When using the   OPEN command to set a Digital Input block, the Digital Input block must   be in Manual 
mode before it can be set. If you attempt to set a Digital   Input block that is in Automatic mode with an OPEN 
command, iFIX generates   an error message and takes the Program block off scan. 

 

PLAYSOUND Command
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Purpose

Works in conjunction with iFIX sound support to play sound files you   create with Microsoft-supported 
sound software. 

Syntax

PLAYSOUND sound file 

Parameters

sound file – specifies   the name of the sound file you want to play. Sound files should have an   extension 
of .WAV and are created using Microsoft-supported sound software.   The PLAYSOUND command 
looks in Picture path for sound files. However,   you also can define the location of the sound files 
along with the sound   file name. For example: 

PLAYSOUND C:\SOUNDS\WARNING.WAV 

 

RUN Command

Purpose

Places a block on scan. Note that the command does not wait for the   block to finish processing before 
proceeding to the next command. 

Syntax

RUN block 

Example

To place the block, DOWNRCP, on scan, enter the following: 

RUN DOWNRCP 

NOTE: The block places   other blocks on scan in the order that RUN statements occur. Make sure   you exam-
ine the RUN statements in the block to ensure that they execute   as you intend. 

Keep in mind that the RUN command allows the block to continue processing   its remaining commands 
while the CALL command pauses the block until the   called block finishes. 

 

RUNTASK Command

Purpose

Runs FIX or third-party applications. For example, you can use this   command to automatically download 
a recipe or save the process database.   This command can also launch third-party applications such as 
Windows   Notepad. 

Syntax

RUNTASK executable [command line parameter] 
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Parameters

executable – specifies   the name of the .EXE file for the application you want to run. This parameter   can 
include path information, but not wildcards. For example: 

RUNTASK C:\PROGRAMS\MYPROG.EXE 

command line parameter   – specifies   any applicable command line parameters for the executable, 
enclosed in   quotes. Up to 128 characters can be used to define command line parameters.   Com-
mand line parameters are available for the following iFIX applications:   

 l Database Manager   

 l Recipe 

 

SETAUTO Command

Purpose

Changes the status of the designated block from Manual to Automatic   mode. Note that the command 
has no effect if the block is already in Automatic   mode. 

Syntax

SETAUTO block 

Example

To place the block, AI1, into Automatic mode, enter: 

SETAUTO AI1 

 

SETDEBUG Command

Purpose

Switches the block to debug mode. In debug mode, the block executes   only one command per scan 
period. In general, SAC processes all commands   in a single scan, except in the cases where Wait com-
mands are used. 

NOTE: When the Program   block is in debug mode, you can create a Data link in a picture with the   field F_
TV1 and view which command the block is executing. If the block   encounters an error, you can see the com-
mand that generated the message.

To place the block into debug mode, insert the SETDEBUG command where   you want the debug mode 
to begin, and then place the CLRDEBUG command   where you want the debug mode to end. While in 
debug mode, the Program   block sends the current step number to the enabled alarm services in its   alarm 
areas. 

Syntax

SETDEBUG 
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SETERROR Command

Purpose

Generates an alarm for the block executing this command. The message   contains the block's name and 
description. This command is useful when   you want the block to notify you of an undesirable condition 
that you   have programmed into the block's logic. 

Syntax

SETERROR 

 

SETLIM Command

Purpose

Places a precision limit on the operators used in WAITFOR and IF commands.   Like MAXWAIT com-
mands, a SETLIM command applies to all the commands that   follow it until a new SETLIM command 
occurs. 

Syntax

SETLIM value 

Parameters

value – specifies   the number of engineering units (EGUs) that this command sets as a precision   limit. 
The default value is 1 EGU. 

Example 

Suppose you want place a -2 to +2 limit around the value in a WAITFOR.   The following commands 
accomplish this: 

SETLIM 2 
WAITFOR AI1 = 90 

These commands instruct the block to wait as long as the value of AI1   is between 88 and 92. 

 

SETMAN Command

Purpose

Changes the status of the designated block from Automatic to Manual   mode. Note that the command 
has no effect if the block is already in Manual   mode. 

Syntax

SETMAN block 
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SETOUT Command

Purpose

Sets the current value of the specified block to the designated value   or to the current value of another 
block. 

Syntax

SETOUT block value 
SETOUT block block 

Examples 

To set the current value of the block AI1 to 80, enter: 

SETOUT AI1 80 

To set the current value of AI2 to AI1, enter: 

SETOUT AI2 AI1 

NOTE: Be sure to include   a DELAY command after a SETOUT command when sets the value of an Analog   
Output block. Using the DELAY command ensures that the Analog Output block   has time to process the data 
it receives from the Program block. 

Since the SETOUT command sets the current value of the specified block,   you cannot use this com-
mand with a Text block. 

 

SETSEL Command

Purpose

Sets the selection mode of a Signal Select block to the specified mode.   

Syntax

SETSEL block mode 

The available modes determine how the Signal Select block uses its input   values to calculate its output 
value. These modes are described in the   following table.

The 
mode... 

Outputs the... 

Average Average of all assigned inputs. 

Good First good input. 
Note: A good value is one that iFIX considers valid. For example, if you   have defined the 
engineering units range of the block as 70 to 80 degrees   Celsius, and the sensor registers 60 
degrees, the input is considered   bad or invalid. 

High Highest input. 

Low Lowest input. 

Sum Sum of all the inputs. 

Inputs 1 Corresponding input number. 
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- 6 

NOTE: If one or more   of the inputs are bad or off scan when the selected mode is Average or   Sum, the Signal 
Select block ignores these inputs and continues with the   calculation based on the remaining inputs. 

 

SETTARG Command

Purpose

Defines a PID block's set point value, a Ramp block's target value,   or the bias value of a Ratio Bias 
block to a specified value. 

Syntax

SETTARG block value 

Example

To define the set point value of PID1 to 50, enter: 

SETTARG PID1 50 

NOTE: When specifying   a Ramp block, SETTARG sets the value of the first target value, SETTARG2   sets the 
value of the second target value, and SETTARG3 sets the value   of the third target value. If a target value that 
is outside the Ramp   block's EGU range, the Ramp block clamps the value to its high and low   EGU limits. 

 

SETTIME Command

Purpose

Sets the delay time (1-255 seconds) of a Dead Time block or the hold   time (0-1000 hours) of a Ramp 
block. 

Syntax

SETTIME block value 

Example

To set the delay time of the Dead Time block, DT2, to 60 seconds, enter:   

SETTIME DT2 60 

NOTE: When specifying   a Ramp block, SETTIME sets the hold time for the first stage and SETTIME2   sets the 
hold time for the second stage. 

 

STOP Command

Purpose

Places another block off scan. Use the END command to place the Program   block off scan. 
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Syntax

STOP block 

Example

To place the block, AI2, off scan, enter: 

STOP AI2 

 

SUBOUT Command

Purpose

Subtracts a specified value from the current value of a block. 

Syntax

SUBOUT value FROM block 

Example

To subtract 12 from the current value of the block, AI2, enter: 

SUBOUT 12 FROM AI2 

NOTE: Be sure to include   a DELAY command after a SUBOUT command when it subtracts a value from   an 
Analog Output block. Using the DELAY command ensures the Analog Output   block has time to process the 
data it receives from the Program block.   

 

SUBTAR Command

Purpose

Subtracts the current value of one from the TARGET value of another   block. 

Syntax

SUBTAR block FROM block 

Example

To subtract the current value of AI3 from the target value of PID5,   enter: 

SUBTAR AI3 FROM PID5 

NOTE: When specifying   a Ramp block, SUBTAR subtracts the value from the first target value of   the block, 
SUBTAR2 subtracts the value from the second target value, and   SUBTAR3 subtracts the value from the third 
target value. If a target value   that is outside the Ramp block's EGU range, the Ramp block clamps the   value to 
its high and low EGU limits. AO blocks to not have target values.   When using blocks like AO or AI, which do 
not have target values, use   SUBOUT command. 

 

WAITFOR Command
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Purpose

Waits for a process condition to occur. The Program block checks for   this condition once per scan 
period. If the condition occurs or you have   a previous MAXWAIT command that times out, the Program 
block continues   with the next command. 

Syntax

WAITFOR expression 

Parameter

expression – compares   values in the IF command. The syntax of an expression for these commands   is: 

operand1 relationaloperator operand2 

For more information on these arguments, refer to the topic Using   Command Arguments. 

Example

To wait for the current value of the block, AGITSPEED, to equal 400,   enter: 

WAITFOR AGITSPEED = 400 

TIP: In rare instances,   you can have a Program block that waits for a specific value from a block   to test a con-
dition, but because of the unavoidable round-off errors that   occur in digital systems, the block consistently 
sends out a slightly   different value that never satisfies the condition. For example, 10 might   not equal 10, 
since the block might really be comparing 10.0001 to 10.0003.   The easiest way around this problem is to add 
a SETLIM   command to create a limit of precision on the value that is received.   The SETLIM statement lets you 
assign an inclusion limit for the comparison,   such as +/- 0.1. If you do use the SETLIM command before your 
WAITFOR   command, remember that you must account for the precision limit that you   set for the condition. 

 

WAITSTAT Command

Purpose

Suspends the operation of this block until the specified block is switched   to the specified status. Valid 
status entries are OFF, ON, AUTO, and MANL.   

Syntax

WAITSTAT block status 

Examples

You can use the WAITSTAT command to: 

 l Suspend the operation   of the block. 

 l Limit suspension   time. 

 l Wait for an operator   to change a block's status manually. 

For example, to suspend the operation of the block until a previous   RUN, STOP, SETAUTO, or 
SETMAN command has fully executed, enter: 

SETAUTO AI1 
WAITSTAT AI1 AUTO 
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To limit the suspension time, use the WAITSTAT command with the MAXWAIT   command. When used 
together, the next command is executed only after the   designated status occurs, or when MAXWAIT 
times out. For example, the   following commands prevent the block from moving to the next step until   
PID1 is switched to an Automatic status or until MAXWAIT times out after   5 seconds: 

MAXWAIT 5 
WAITSTAT PID1 AUTO 

To set up the WAITSTAT command to wait for a block's status to change,   use the command with a 
Data link in a picture. For example, the following   command suspends the Program block indefinitely 
unless a previous command   switches AI1 to Manual mode: 

WAITSTAT AI1 MANL 

NOTE: If the   operator places AI1 into Manual mode with a Data link, the block continues   executing the 
remaining steps. 

 

Math Features in Database Blocks

The following table provides more information on the math features available   from the specified blocks.

Block Name Math Features

Boolean Block   (BL)  l Equations

 l Changing   the Order of Precedence

Calculation   Block (CA)  l Equations

 l Changing   the Order of Precedence

Device   Control Block (DC)  l Understanding   Contact Patterns

PID Block (PID)  l Algorithms

 l Using   the Proportional Band

Signal   Select Block (SS)  l Modes

Statistical   Data Block (SD)  l Formulas

 l Constants   and Formulas for Control Charts

 l Factors   for Standard Deviation Control Limits

 

Boolean Block –   Equations

In order for the Boolean block to calculate its output correctly, you   must enter an equation. In general, 
the equation syntax is:  

input operator input

where input is one of the block's inputs and operator   is a Boolean operator. You specify inputs in the 
equation by their letter.   For example, if you enter DI1 into the Boolean block's A Input field,   you would 
refer to it in the equation as A. 
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You can specify any operator listed in the following table: 

Enter... To represent the 
operator...   

Description 

- NOT Inverts the incoming value. If A is true, -A is false.   

* AND Evaluates to true if all inputs are true. If any input   is false, the output is 
false. 

! NAND Evaluates to true if A and B are not both true. Otherwise   the output is 
false. 

+ OR Evaluates to true as long as one or more of the inputs   are true. If all 
inputs are false, the output is false. 

^ XOR Evaluates to true if one input is true and the other   false. If both inputs 
are true or false, the output is false. 

= Equal Evaluates to true if A equals B. Otherwise, the output   is false. 

~ Not Equal Evaluates to true if A does not equal B. Otherwise,   the output is false. 

 

Boolean Block –   Changing the Order of Precedence

The Boolean block defines an order of precedence for each operator to   determine which operators (and 
the values on each side of the operator)   are evaluated first. You can change this order by enclosing part 
of the   equation in parenthesis. The following table lists the order of precedence   for Boolean operators.  

Operator Precedence 
Parenthesis 1
NOT 2
AND 3
XOR 4
OR 5
NAND 6
Equal to 6 
Not Equal to 6 

 

Calculation Block –   Equations

In order for the Calculation block to compute its output correctly,   you must enter an equation. In general, 
the equation syntax is:  

input operator input

where input is one of the block's inputs and operator   is a mathematical symbol. You specify inputs in the 
equation by their   letter. For example, if you enter DI1 into the Calculation block's B Input   field, you would 
refer to it in the equation as B. 

You can enter any operator listed in the following table: 
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Operator Function 

ABS(input) Absolute value 

SQRT(input) Square root 

EXP(input) Anti-log 

LOG(input) Natural log 

LOG10(input) Base-10 log 

INT(input) Changes floating point values to integers 

- Unary minus (example, -A). 

^ Raise to power, exponential. 

* Multiply 

/ Divide 

+ Add 

- Subtract (example, A-B) 

< Less than 

> Greater than 

NOTE: When doing greater   than or less than comparisons, the Calculation block passes a value of   1 to the 
next block if the statement is true. If the statement is false,   the block passes a value of 0. 

 

Calculation Block –   Changing the Order of Precedence

The Calculation block defines an order of precedence for each operator   to determine which operators 
(and the values on each side of the operator)   are evaluated first. You can change this order by enclosing 
part of the   equation in parenthesis. The following table lists the order of precedence   for Calculation block 
operators.  

Operator Priority Level 
( ) 1
ABS(input) 2
SQRT(input) 2 
EXP(input) 2 
LOG(input) 2 
LOG10(input) 2 
INT(input) 2 
- 2 
^ 3
* 4
/ 4
+ 5
- 5 
< 6
> 6 

 

© 2020 General Electric Company. All rights reserved. 279



Device Control Block –   Understanding Contact Patterns 

A contact pattern is a character text string that represents the state   of the digital points controlled and 
monitored by the Device Control block.   You can use a contact pattern to:  

 l Monitor the digital   points specified in the Input box. 

 l Control the digital   points specified in the Output box. 

 l Specify the Initial   Value of the digital points specified in the Output box when SAC is first   started. 

Each letter in a contact pattern corresponds to an output or input address   defined in the block's dialog 
box. The following table lists and describes   the characters used in building the contact pattern. 

The let-
ter... 

Represents... 

O An open digital point. 
Note: Enter the letter O, not a zero (0). 

C A closed digital point. 
X The current state of a digital point. Use this letter   if an output address is not defined 

or if a particular digital point's   state is immaterial. 

You can use contact patterns in conjunction with the Device Control   block's programming statements. 
Programming statements monitor and control   the digital points specified as input and output addresses. 
You can enter   up to 12 programming statements. Each statement can be up to 34 characters   long. 

For example, to control the state of the digital points specified in   the Output Addresses column you 
might enter a contact pattern similar   to the following: 

OUTPUT CCOOXXCO 

The following table identifies the correspondence between each digital   address specified in the Output 
Addresses column and the eight letters   in the sample contact pattern above. 

Output Address Contact Pattern 
07 First character (C) 
06 Second character (C) 
05 Third character (O) 
04 Fourth character (O) 
03 Fifth character (X) 
02 Sixth character (X) 
01 Seventh character (C) 
00 Eighth character (O) 

You can also use a contact pattern to monitor the state of the digital   points specified in the Input 
Addresses box: 
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The correspondence between each digital address specified in the Input   Addresses box and the 16 let-
ters in the contact pattern is similar to   the preceding table. The left-most letter corresponds to the top 
address,   15, and the letter on the far right corresponds to the bottom address,   00. 

 

PID Block –   Algorithms 

The steady state PID block algorithm is:  

The following table identifies the variables for the algorithm. 

Variable Value 
yn - yn-1 where: 
yn is the current output 
yn-1 is the previous output 

Kp 100/PB 
En sp - pv (or the error at current scan time) where:   

sp is the set point 
pv is the current input 

T Scan time (or sample time). 
Fn Feedback tag value. 
En-1 Error at previous scan time (1 scan time prior to   current). 
TI Reset time constant (minutes/repeat). 
TD Derivative time constant (minutes). 

Derivative mode filter 

Proportional action constant 

Derivative action constant 

The new output of the PID block is: 

 

PID Block –   Using the Proportional Band

You can adjust the value in the Proportional Band field to control how   sensitive the PID block is to pro-
cess changes. For example, decreasing   the proportional band generates a high gain and provides sens-
itive, but   unstable control. With this narrow proportional band, a relatively   small change in measurement 
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causes a 100% change in the block's output   travel. This method generally allows the set point to be 
reached faster,   but with more severe fluctuations, as the following picture shows:  

Conversely, increasing the proportional band generates a low controller   gain and provides stable, but 
insensitive control. With this wide   proportional gain, a relatively large change in measurement causes a 
small   change in the block's output travel. This method generally takes longer   to reach the set point, but 
causes fewer fluctuations, as the following   picture shows: 

 

Signal Select Block –   Modes

The Signal Select modes determine how the block handles its input values   and calculates its output 
value. Each modes is described below:  

Alarm 
Type 

Description 

Average Outputs the average of all assigned inputs. Bad or   off scan inputs are not included in the 
calculation. 

Good Outputs the first input that FIX considers valid.   

High Outputs the highest input. 

Low Outputs the lowest input. 

Sum Outputs the sum of all the inputs. Bad or off scan   inputs are not included in the calculation. 

Inputs 1 - 6 Outputs the corresponding input number. 

 

Statistical Data Block –   Formulas

In the following table, n represents the number of observations and   g is the number of groups. 

Formula Abbreviation Description 

XBAR The group average. 

XBARBAR The average of the group average. 
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R=Xmax - Xmin R The range of the group. 

RBAR The average range of all groups. 

S The standard deviation of the group. 

SBAR The average of sample standard deviations. 

UCLX 
LCLX 

The upper and lower control limits*. 

UWLX 
LWLX 

The upper and lower warning limits*. 

UCLR 
LCLR 

The upper and lower control limit for range. 

UCLs 
LCLs 

The upper and lower control limits for the standard   deviation. 

Sigma The process standard deviation. 

 ZU 

ZL 

The upper and lower CPK limit. 

CPK=MIN(ZU,ZL) / 3.0 CPK The process capability index. 

*NOTE: The block   sets the upper (USLX) and lower (LSLX) user specification limits to values   greater and 
less than the upper and lower control limits, respectively,   if you do not specify a value. 

A2 is the factor for control limits for X. D4 and D3 are factors for   control limits for R. C4 is the divisor 
estimate of the standard deviation.   Additional information on the control charts that these values are 
derived   from can be found in the original text: ASTM publication STP-15D, Manual   on the Presentation 
of Data and Control Chart Analysis, 1976; Pages   134-136. 

 

Statistical Data Block –   Constants and Formulas for Control Charts
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Reprinted,   with permission, from the Manual on the   Presentation of Data and Control Chart Analysis, 
copyright © American   Society for Testing and Materials, 1990. 

 

Statistical Data Block –   Factors for Standard Deviation Control Limits

The following table describes the factors for standard deviation control   limits in the Statistical Data 
block. 

Subgroup Size B3 B4 

2 0 3.267 

3 0 2.568 

4 0 2.266 

5 0 2.089 

6 0.030 1.970 
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7 0.118 1.882 

8 0.185 1.815 

9 0.239 1.761 

10 0.284 1.716 

11 0.321 1.679 

12 0.354 1.646 

13 0.382 1.618 

14 0.406 1.594

15 0.428 1.572 

16 0.448 1.552 

17 0.466 1.534 

18 0.482 1.518 

19 0.497 1.503 

20 0.510 1.490

21 0.523 1.477 

22 0.534 1.466 

23 0.545 1.455 

24 0.555 1.445 

25 0.565 1.435 

Reprinted, with permission, from the Manual on the Presentation of   Data and Control Chart Analysis, 
copyright © American Society for   Testing and Materials, 1990. 

 

Additional Information on Alarming

Some blocks require additional information for configuring and understanding   alarms. The following sec-
tions provide more information on alarming:

 l Alarm   Priorities for the Analog Alarm Block

 l Alarm   Transitions for the Analog Alarm Block

 l Alarm   Types for the Analog Alarm Block

 l Alarms   in the Boolean Block

 l Alarm   Handling in the Multistate Digital Input Block

 l Alarming   Considerations in the Statistical Data Block

 l Alarm   States in the Event Action Block

 l Alarm   States, Contacts, and the Digital Alarm Block

 

Alarm Priorities for the Analog Alarm Block
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Before sending an alarm, iFIX compares the alarm priority of each alarm   against the SCADA server's 
alarm priority. If the alarm's priority is   equal to or higher than the SCADA server's priority, iFIX sends the 
alarm   to the enabled alarm destinations in the specified alarm areas. However,   if the alarm's priority is 
less than the SCADA server's, iFIX automatically   acknowledges the alarm and does not send to the 
enabled alarm destinations.   

If multiple alarms occur simultaneously, the lower priority alarm type   is ignored. In this case, the Analog 
Alarm block closes any contacts defined   for the lower priority alarms, but does not send alarms. When 
the block   detects an alarm condition and no other alarms of greater priority are   in effect, the block gen-
erates an alarm and closes the digital block defined   in the Contact Name field.  

NOTE: It is possible   to close more than one digital block if the alarm type increases in priority   without return-
ing to normal. For example, if the block generates a Rate   of Change alarm, it closes the digital block specified 
in the Rate of   Change alarm's Contact Name field. If the block then generates a High   alarm, it closes the 
digital block in the High alarm's Contact Name field.   

Example 

If you assign a high priority to a deviation alarm and a low priority   to a High High alarm, iFIX treats devi-
ation alarms as more severe than   High High alarms. If Deviation and High High alarm conditions are sim-
ultaneously   active, Data links that reference the current and latched alarms display   DEV because the 
deviation alarm has greater priority. 

Assigning the same priority to both the Deviation and High High alarms   causes iFIX to treat the alarms 
according to the default order of alarm   types. 

NOTE: The alarm priority   of the High alarm must be equal to or less than the priority of the High   High alarm. 
Similarly, the alarm priority of the Low alarm must be equal   to or less than priority of the Low Low alarm. 

iFIX automatically acknowledges any alarm below the computer's alarm   priority. This means that if the 
associated contact is set to clear on   Acknowledge, it opens when iFIX acknowledges the alarm. 
Contacts set to   clear in All Clear mode open when the block value falls within defined   limits. 

 

Alarm Transitions for the Analog Alarm Block

When an alarm occurs, the Analog Alarm block generates an alarm and   closes the associated contact 
(digital block). For example, when a High   alarm occurs, the block sends a High alarm to the alarm des-
tinations defined   in the SCU and closes the contact you defined for the High alarm. 

The block handles each type of alarm independently of other alarms.   For example, if a Rate of Change 
(ROC) and a High alarm occur simultaneously,   the Analog Alarm block generates both alarms and 
closes the specified   contacts.  

Some alarm transitions generate only one alarm. For example, when the   Analog Alarm block goes from a 
normal state to a High High alarm, the   contacts for the High and High High alarms close. The block gen-
erates   a High High alarm and suppresses the High alarm. Transitions from a normal   state to a Low Low 
alarm work in a similar manner. The Low and Low Low   alarm contacts close. The block generates a Low 
Low alarm and suppresses   the Low alarm. 
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Block Mode 

The block's Out Mode determines how it responds to certain alarm transitions.   Possible Out Mode val-
ues are: 

Entry Description 
Acknowledge Opens the digital block when the operator acknowledges   the alarm. 
Return Opens the digital block when the alarm is cleared.   
All Clear Opens the digital block when the alarm is acknowledged   and cleared. 
Never Does not open the digital block. 

For example, when the block's Out Mode is set to Return and the current   alarm changes from a Low or 
Low Low alarm to a High High alarm, the block   generates a High High alarm only after opening the Low 
and Low Low contacts   and closing the High and High High contacts. Similarly, if the Out Mode   is set to 
Return and the current alarm changes from a High or High High   alarm to a Low Low alarm, the High and 
High High contacts open, the Low   and Low Low contacts close, and the block generates a Low Low 
alarm. 

The block's Out Mode also determines how the block responds to less   abrupt alarm transitions. For 
example, when the current alarm changes   from a High High alarm to a High alarm, the High High alarm 
contact opens   depending on the alarm's mode. The block does not generate a High alarm   and the state 
of the High alarm contact is unchanged because the block   is still in an High alarm state. The transition 
from Low Low to Low works   in a similar manner. The Low Low alarm contact opens, depending on the   
alarm's mode, the block does not generate a Low alarm, and the state of   the Low alarm contact is 
unchanged. You can configure the Analog Alarm   block to generate an alarm for either transition, by using 
a short re-alarm   time for the High and Low alarm. 

Using Contacts   

You can specify the same contact for multiple alarms. When you do this,   the contact closes when any 
alarm condition that uses the contact occurs.   The contact remains closed until each alarm returns to nor-
mal. For example,   if the High and High High alarms use the same contact, and a High High   alarm 
occurs, the contact remains closed until the block's value falls   below the High alarm limit. 

 

Alarm Types for the Analog Alarm Block

The Analog Alarm Block generates the following alarm types, represented   in the order of decreasing pri-
ority:  

Alarm 
Type 

Description 

Other An alarm that is not one of those listed elsewhere   in this table. Possible values include Comm 
(for communication errors),   Over (when the blocks value is greater than the High Limit value), 
or   Under (when the blocks value is less than the Low Limit value). 

High 
High 

A critically high alarm. 

Low Low A critically low alarm. 
High A high alarm. 
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Low A low alarm. 
Rate of 
Change 

A rate of change alarm. This alarm indicates that   the block's value exceeds an acceptable 
rate of change. 

Deviation A deviation alarm. This alarm occurs when the current   value of the block varies from the Tar-
get Value field by an amount greater   than the deviation alarm's value. 

NOTE: If multiple alarms   occur simultaneously, the lower priority alarm type is ignored. The block   closes any 
contacts defined for the lower priority alarms, but does not   send alarms. When it detects an alarm of greater 
priority, the block generates   an alarm and closes the digital block defined in the Contact Name field.   

 

Alarms in the Boolean Block

To include an alarm as an input in a Boolean block calculation, you   must use the following format:  

tag name:alarm type 

Valid alarm types and their priorities include the following: 

Priority Alarm Type Description
1 COMM Communication Error (BAD value).
1 OCD Open circuit detected.
1 IOF General I/O Failure.
1 FLT Floating Point Error.
1 OVER Over Range.
1 UNDER Under Range.
1 ERROR Any Statistical Data block alarm.
2 CFN Change from normal alarm (digital blocks only).
2 COS Change of State alarm (digital blocks only).
2 HIHI Block in HIHI alarm state.
2 LOLO Block in LOLO alarm state.
3 RATE Value exceeds rate-of-change setting.
3 HI Block in HI alarm state.
3 LO Block in LO alarm state.
4 DEV Deviation Alarm.
5 OK Block in normal state.

 

Alarm Handling in the Multistate Digital Input Block

The Multistate Digital Input Block generates Change from Normal (CFN)   alarms only on a transition 
between alarm status and no alarm status.   Transitions between different alarm states do not generate 
new alarms.   

When you select the Re-alarm check box, the block re-issues alarms every   time the block changes 
alarm states (even if the block is already in alarm).   iFIX treats these alarms as unacknowledged alarms.  
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Alarming Considerations in the Statistical Data Block

The Statistical Data block supports out of control alarming on   the following limits: 

 l XBAR, Range, and   Standard Deviation control limits.  

 l Warning limits for   XBAR plots. 

 l Trend Alarm.  

 l Length of Runs Alarm.   

 l Crossings of the   Mean Alarm. 

Statistical Data block alarms are based on groups. Group alarming occurs   if a user-defined group 
exceeds any limit. These alarms include the following   limits: 

Control Limits – defines the   limits as within plus or minus three (+/- 3) standard deviations (also   called 
sigma). 

Warning Limits – defines the   limits as within plus or minus two (+/- 2) standard deviations (XBAR plot   
only). 

At run-time, the Statistical Data block calculates all control limits   and statistical values after collecting 
the first n groups, where   n is the number of groups specified in the block's dialog box.   

You can specify alarm limits through Data links to the following fields.   The block supports both A_ and 
F_ versions of these fields. 

LCLR LCLS LCLX LSLX 

LWLX RBAR SBAR UCLR 

UCLS UCLX USLX UWLX 

XBB    

If you manually input limit values, verify that the values are very   close to the ones the block would cal-
culate. Otherwise, the validity of   statistical alarms and control charts is questionable. You should also   
select NEVER for the block's Auto Limits and Auto Calculations fields   when you manually enter limit val-
ues. This selection lets the block calculate   alarm limits, XBAR, R, and S values based upon defaults 
and lets you enter   values at any time before or after startup. Operators can also change   the setting of 
Auto Calculations or Auto Limits through Data links to   the fields A_AUTOX and A_LCALC, respectively. 

 

Alarm States in the Event Action Block

You can include any of the following alarm states in an Event Action   IF statement:  

Priority Alarm Type Description 
1 COMM Communication Error ("BAD" value). 
1 OCD Open circuit detected. 
1 OVER Over Range. 
1 UNDER Under Range. 
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1 ERROR Any Statistical Data block alarm. 
2 CFN Change from normal alarm (digital blocks only). 
2 COS Change of State alarm (digital blocks only). 
2 HIHI Block in HIHI alarm state. 
2 LOLO Block in LOLO alarm state. 
3 RATE Value exceeds rate-of-change setting. 
3 HI Block in HI alarm state. 
3 LO Block in LO alarm state. 
4 DEV Deviation Alarm. 
5 OK Block in normal state. 

 

Alarm States, Contacts, and the Digital Alarm Block

The Digital Alarm block opens and closes contacts based on its alarm   state. When the block detects an 
alarm of the type specified in the Alarm   Type area, it closes the contact specified in the Contact Name 
field.   The contact opens based on the Contact Mode area. Possible values are:    

Button Description 
Acknowledge Opens the digital block when the operator acknowledges   the alarm. 
Return Opens the digital block when the alarm returns to   normal. 
All Clear Opens the digital block when the alarm is acknowledged   and cleared. 
Never Requires the operator to open the contact manually   or via other program logic. 

iFIX automatically acknowledges any alarm below the node's alarm priority.   This means that if the asso-
ciated contact is set to clear on Acknowledge,   it opens when iFIX acknowledges the alarm. Contacts 
set to clear in All   Clear mode open when the block's current value falls within the defined   limits.

 

About Alarm Shelving

Alarm shelving empowers your operators to make informed decisions by providing the ability to manually 
remove alarms from the active alarm list for a set period. This helps improve the display of alarm inform-
ation on screen, and lets operators focus on only the most important alarms. Alarm shelving in iFIX was 
built taking into consideration ISA 18.2 Shelving, providing you a thorough alarm management solution.

With alarm shelving enabled in iFIX, you can temporarily suppress alarms from the Alarm Summary 
object's active alarm list for a predefined period.  To configure alarm shelving, in the iFIX Database Man-
ager, first you must define your alarm shelving policies with the preset time choices and maximum dur-
ation for shelving. Next, you must enable each tag that you want to enable alarm shelving on. After you 
do that, in WorkSpace configure mode, you need to configure the Alarm Summary object to display the 
Alarm Shelving fields. 
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How to Configure Alarm Shelving in the Database Manager

Before you enable alarm shelving for your blocks, you need to define your alarm shelving policies. 
Policies for the preset time choices available to an operator, along with the maximum amount of time an 
alarm can be shelved, are created in the Shelve Policies dialog box, accessed from the Shelve Polices 
button in the iFIX Database Manager. For more information, refer to the Alarm Shelving Policies topic.

Next, alarm shelving can be enabled on the block. You can enable alarm shelving on the following 
blocks types in the Database Manager:

 l Analog Alarm (AA)
 l Analog Input (AI)
 l Digital Alarm (DA)
 l Digital Input (DI)
 l Multistate Digital Input (MDI)
 l Program Block (PG)
 l PID or Proportional-Integral-Derivative (PID)
 l Statistical Data (SD)
 l SQL Trigger (SQT)
 l Timer (TM)
 l Text (TX)

Additional Database Dynamos (loadable blocks added with Database Dynamo Configuration Utility, 
BTKCFG.exe, that support the alarm shelving feature include:

 l Analog Input with Freeform Scaling (AIS)
 l Transition Counter (CTR)
 l 16 Bit Digital Status (D16)
 l Improved PID (PI2)

Alarm Shelving is enabled on the Alarms tab for each individual block you want to configure, as shown in 
the following figure. From here you can also choose the policy that you want to assign to this block.
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How Alarm Shelving is Setup in the WorkSpace Configure Mode

To view whether alarms are shelvable in the Alarm Summary object in the iFIX WorkSpace, you first 
need to add the alarm shelving columns to your Alarm Summary display. From the Alarm Summary Con-
figuration, select the Column tab. Move the Shelvable and Shelve Duration (HHH:MM) columns to the 
Selected Columns list as shown in the following figure and click Apply.

If you want to view only the shelved alarms in the Alarm Summary object, make a copy of your Alarm 
Summary object. On the Filter tab, select Display only Shelved Alarms and click Apply, as shown in the 
following figure. This will allow you to view alarms as you move them between the active alarm list and 
the shelved alarm list. 
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Run Mode Alarm Shelving for the Operator

When in WorkSpace run mode, select the alarm or alarms you want to shelve from the Alarm Summary 
object. Then, with the alarms highlighted, use the right-click menu to access the pop-up menu and select 
the Shelve option. 

Three shelve options are available: 

 l Custom duration
 l Maximum duration (limited to 999 hours)
 l Preset duration. 

After you select the duration and click Shelve, the alarm (or alarms) temporarily gets removed from the 
alarm list. When the duration is expired, if the alarm is still active, it will pop back into the Alarm Sum-
mary list.

To remove an alarm before a shelving period expires, right-click the selected the alarm or alarms and 
select Unshelve. This brings the alarm back in to the active alarm display.
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NOTE: Be aware that the shelve durations are based off the system clock and not a timer.

 

Alarm Shelving Policies

Alarm Shelving Policies help you manage the options available to operators in run mode when choosing to 
shelve alarms. In the iFIX Database Manager, on the Home tab, select the Shelve Policies button to open 
the Alarm Shelve Policies dialog box. From here, you can define up to 20 alarm shelving policies. 

Each policy that you create contains preset durations for alarms to be shelved, along with the maximum 
shelf duration for which an operator can shelve an alarm. For each policy, one or several presets (up to 5) 
can be defined. The following figure displays an example of an alarm shelving policy named POLICY1 with 
3 presets defined, and a maximum duration of 24 hours. 
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Policy definitions are editable only through the Database Manager and EDA functions. You can also access 
shelve policy values  using the system database fields. For more information, refer to the Alarm Shelving 
System Fields section. All shelve policy system fields can be accessed through datalinks in the 
iFIX WorkSpace, and are read-only.

Policies are set at the block level. If you enable alarm shelving for the block when configuring your blocks in 
the iFIX Database Manager, you also select the policy that you want to apply to that database tag. The fol-
lowing example shows a Shelve Policy of POLICY2 that applies to the tag.
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SQL Use in Database Blocks

The following database blocks can be used if you want to interface between   your iFIX process database 
and a SQL relational database:

 l SQL   Data Block (SQD)

 l SQL   Trigger Block (SQT)

The SQD block acts as the actual interface, while the SQT block runs   the SQL commands. When work-
ing with these block types, you should be aware   of the following information:

 l Reading   and Writing Data of SQL Data

 l Behavior   of SQL Data Blocks While Off Scan

 l Keywords   Available for use in the SQL Data Block

 l Direction   of SQL Data Block

 l SQL   Trigger Block States

 l SQL   Trigger Blocks in Manual Mode

 

Reading and Writing of SQL Data
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The SQL Data block can read data from the iFIX process database or your   relational database. After 
reading the data, the SQL Data block can write   it to either database depending on the SQL command 
that executes. 

If the SQL command is...   The block... 
SELECT Reads values from the relational database and writes   them to the process 

database. 
INSERT, UPDATE, or 
DELETE 

Writes process data values to the relational database   

A SELECT command with a Where clause instructs the block to read and   write data to both databases. 
For values in the Where clause, the block   reads from the process database and writes them to the rela-
tional database.   However, for the values not in the Where clause, the block reads from   the relational 
database and writes to the process database. 

 

Behavior of SQL Data Blocks While Off Scan

The SQL Data block identifies the blocks that transfer to or receive   data from your relational database. 
The block, however, does not monitor   a block's status or mode. If a block is off scan, when the 
upstream SQL   Trigger block starts, the SQL task substitutes a null value for the off-scan   block's current 
value. If the target column in the relational database   cannot accept a null value, the INSERT or 
UPDATE fails and the SQL Trigger   block generates an alarm.  

 

Keywords Available for use in the SQL Data Block

You can use any of the following keywords in place of a block and field   pair. 

 l NODENAME   – The   node name of the local SCADA server. 

 l SQTBLK   – The   name of the SQT block. 

 l TMDT   – The   current time and date. 

 l TIME   – The   current time. 

 l DATE   – The   current date. 

For example, to save the time and date of each relational database transaction,   enter the keyword 
TMDT in the SQL Data block.  

 

Direction of SQL Data Block

The value of the Direction field also determines whether values are   read or written to the relational data-
base as follows: 
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Out –   Send the values of the specified block and field name pairs to the relational   database. These val-
ues update existing values, are inserted in the relational   database, or used in a Where clause. Typ-
ically, the number of Out fields   equals the number of parameters in INSERT or UPDATE commands. 

In –   Receive the values of the specified block and field name pairs from the   relational database. Typ-
ically, the number of In fields equals the number   of columns specified in the SELECT commands. 

For example, using the command shown below, you can add a new record   in the relational database:

INSERT into TBL1 (COL1, COL2, COL3) values (?, ?, ?) 

The direction for each value in this example is set to OUT.  

 

SQL Trigger Block States

SQL Trigger blocks can be in any of the following states:  

The state... Indicates the block is... 
MANUAL In Manual mode. 
OFF Off scan or not connected to a relational data-

base.   
TIME Waiting for a time event. 
EV SET Waiting for a low to high event. 
EV CLR Waiting for a high to low event. 
EV CHG Waiting for the block event to change. 
PERIOD Waiting for the next event period. 
W EV CLR Waiting for the event to clear. 
W CONF Waiting for the confirmation tag to set. 
IDLE Not waiting for an event. 

 

SQL Trigger Blocks in Manual Mode 

SQL Trigger blocks automatically execute SQL commands when placed in   Automatic mode, not in 
Manual mode. However, an operator can manually   trigger a SQL Trigger block through a Data link that 
uses the A_TRIP field   or through the Database Manager. When manually triggered, the block executes   
SQL commands as if it were in Automatic mode. 

If an SQL Trigger block is monitoring the CLOSE to OPEN state of a digital   block, the SQL Trigger block 
activates when the digital block opens. If   the SQL Trigger block is placed in Manual mode before the 
digital block   opens, the SQL Trigger block does not activate until it is switched to   Automatic mode.  

 

System Fields
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System fields display internal database, SAC, and network information.   To use these fields in a data 
source, use SYSTEM as the block name, as   follows: 

Fix32.node.SYSTEM.field 

For example, to display the local time of the SCADA server MIXER, use   the syntax: 

Fix32.MIXER.SYSTEM.A_NTIME 

To display redundancy information use NSD as the block name, as follows:   

Fix32.node.NSD.field 

For example, to display the physical node name of the local node, use   the syntax: 

Fix32.MIXER.NSD.A_LOCALNAME 

 

Database and SAC System Fields

The following table lists the system fields for the iFIX database and   the Scan, Alarm, and Control (SAC) 
program, and what each field displays.   

The 
field... 

Parameter... Displays...

A_
BLKS 

Total number 
of tags pro-
cessed 

The number of blocks that SAC processed since iFIX   started. 

A_BPS Number of 
tags pro-
cessed per 
second 

The number of blocks that SAC processed in the last   second. 

A_CPM SAC cycles 
per minute 

The number of scans that SAC completes per minute   with no over-
runs. SAC attempts to complete 60 scans per minute or 1200   scans if 
you are using subsecond processing. If the number in this field   is less 
than 60 or 1200, your SCADA server is overloaded. 

A_CPS SAC cycles 
per second 

The number of scans SAC completes per second with   no overruns. 
SAC attempts to complete 1 scan per second or 20 scans if   you are 
using subsecond processing. If the number in this field is less   than 1 
or 20, your SCADA server is overloaded. 

A_
DBNAM 

Database 
name 

The name of the database on the local SCADA server.   

A_
NDATE 

Node date The current date of the local SCADA server. 

A_
NODE 

Node name The name of the local SCADA server. 

A_
NTIME 

Node time The time of the local SCADA server. 

A_
PDBSN 

Database 
serial number 

The serial number of the process database. 

A_
SACOU 

SAC output 
status 

Enable, if SAC writes operator entries to the process   hardware, or 
Disable if SAC writes operator entries to the process database and 
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not   to the process hardware. 
A_
SACOV 

Number of 
SAC over-
runs 

The number of times that the Scan, Alarm, and Control   (SAC) program 
could not execute all requests during a scan. The count   begins from 
the time the SCADA server started. 

A_
SACPR 

Alarm priority 
level 

The SCADA server's alarm priority: INFO, LOLO, LOW,   MEDIUM, 
HIGH, HIHI, or CRITICAL. 

A_
SACST 

SAC scan 
status 

RUN if SAC is scanning the process database, or STOP   if SAC is not 
running. 

 

Redundancy System Fields

For information on NSD fields, refer to the Enhanced  Failover electronic book.

 

Alarm Shelving System Fields

The Alarm Shelving policy values can be accessed using the following database fields. Up to 20 shelve 
policies can be defined.

IMPORTANT: All shelve policy fields when accessed through the datalinks are read-only. Policy definitions 
are editable only through the iFIX Database Manager and EDA functions.

Field Description 

A_SHELVEPOLICY0-19 Shelve policy name (64 char-
acters).

A_SHELVPOLICYDESC0-19 Shelve policy description (256 
characters).

F_MAXSHELVETIME0-19 Shelve policy maximum duration 
(with a maximum shelve duration 
value of 999 hours).

A_SP0-19_CHOICEDESC0-4 Shelve policy preset description 
(64 characters).

A_SP0-19_CHOICETIME0-4 Shelve policy preset duration 
value (from 1 minutes to the max-
imum shelve duration value).

A_SP0-19_CHOICEDEF0-4 Shelve policy preset definition 
default state. The preset default 
state of yes is  selected by 
default in run mode.
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Accessing Alarm Shelving System Fields

All the shelve policy fields can be accessed in the iFIX WorkSpace through a datalink. For example, cre-
ate a datalink and define the source as:

Fix32.FIX.SYSTEM.A_SHELVEPOLICY

where FIX is the node name, and A_SHELVEPOLICY is the field. 

NOTE: When accessed through a datalink, all shelve policy fields are read-only.

SIM Signal Generation Registers

SIM registers generate a repeating pattern of random and predefined values.  To select a register, enter 
the respective two-letter acronym in the I/O Address field. These registers are listed below: 

 l RA SIM register
 l RB SIM Register
 l RC SIM register
 l RD SIM register
 l RE SIM register
 l RF SIM register
 l RG SIM register

 l RH SIM register
 l RI SIM register
 l RJ SIM register
 l RK SIM register
 l RX SIM register
 l RY SIM register
 l RZ SIM register

 

RA SIM Register

The RA SIM register ramps a value from 0 to 100% of the EGU range at a rate controlled by the RY 
register. RA register values are read-only.   

Use the RX register to enable the generation of values in the RA register. 

 

RB SIM Register

The RB SIM register counts from 0 to 65535 at a rate of twenty counts per second. RB register values 
are read-only.   

Use the RX register to enable the generation of values in the RB register. 

 

RC SIM Register

The RC SIM register shifts one bit through a 16-bit word at a rate controlled by the RZ register. RC 
register values are read-only.   

Use the RX register to enable the generation of values in the RC register. 
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RD SIM Register

The RD SIM register generates a sine wave from 0 to 100% of the EGU   range at a rate controlled by the 
RY   register. RD register values are read-only. 

Use the RX register to enable   the generation of values in the RD register. 

 

RE SIM Register

The RE SIM register generates a sine wave from 0 to 100% of the EGU range at a rate controlled by the 
RY register. The sine wave is delayed 90 degrees relative to the RD register. RE register values are 
read-only.  

Use the RX register to enable the generation of values in the RE register. 

 

RF SIM Register

The RF SIM register generates a sine wave from 0 to 100% of the EGU range at a rate controlled by the 
RY register. The sine wave is delayed 180 degrees relative to the RD register. RF register values are 
read-only.  

Use the RX register to enable the generation of values in the RF register. 

 

RG SIM Register

The RG SIM register generates random values between 25% and 75% of the EGU range. RG register 
values are read-only values.  

Use the RX register to enable the generation of values in the RG register. 

 

RH SIM Register

The RH SIM register ramps a value from 0 to 100% of the EGU range and then ramps down to 0 again at 
a rate controlled by the RJ register. RH register values are read-only.   

Use the RK register to enable the generation of values in the RH register. 
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RI SIM Register

The RI SIM register controls the direction the value in the RH register ramps. The value automatically 
changes when RH reaches 0 or 100% or its EGU value.

From the run-time environment, you can enter 1 to ramp up the register or 0 to ramp down the register. 

 

RJ SIM Register

The RJ SIM register controls the speed (in cycles per hour) at which the value in the RH register ramps. 
The default value is 60 (1 cycle per minute). 

From the run-time environment, you can enter a value from 2 to 3600. 

 

RK SIM Register

The RK SIM register enables or disables the generation of values in the RH register. From the run-time 
environment, you can enter 1 to enable ramp and 0 to disable ramp.  

Use the RX register to enable the RK register. 

 

RX SIM Register

The RX SIM register enables or disables the generation of values in other registers.

From the run-time environment, you can enter 1 to enable all registers and 0 to disable all registers. 

 

RY SIM Register

The RY SIM register controls the speed (in cycles per hour) at which new values are generated for 
registers RA, RD, RE, and RF. 

From the run-time environment, enter a value from 2 - 3600. By default, this register is set to 60 (1 cycle 
per minute). 

 

RZ SIM Register

The RZ SIM register controls the speed (in bits per minute) that the RC register changes its value. 
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From run-time environment, enter a value from 2 to 1200.  By default, this register is set to 180 (3 bit 
shifts per second). 

 

Database Manager Dialog Boxes

The iFIX Database Manager includes the following dialog boxes (listed   in alphabetical order):

 l Alarm Shelve Policy Dialog Box

 l Browse I/O Address Dialog Box

 l Verify Database Dialog Box

Alarm Shelve Policy Dialog Box

The Alarm Shelve Policy dialog box displays the following items:

Policy Name

Displays the alarm policy name. Up to 64 characters are allowed, with no spaces. This field is read-only 
if editing. Displays in all capital letters.

Description

Displays the alarm policy description. Up to 256 characters are allowed, including spaces.  

Maximum Duration

Displays the maximum amount of time that an alarm can be shelved for the specified policy. Be aware 
that the shelve durations are based off the system clock and not a timer.

Units

The units for the maximum time: Hours or Minutes.

Default 

Select this button to define a default preset.

Add

Select this button to add a new preset. Up to 5 presets can be defined. Be aware that all shelve dur-
ations are based off the system clock and not a timer.

Remove

Displays the Items List using large icons.
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Preset Choices

Displays the list of defined presets.

Save

Select this button to save your policy or changes. 

Browse I/O Address Dialog Box

The Browse I/O Address dialog box displays the following items:

I/O Address

Displays the hierarchical path to the object currently selected in the   Items List.

Channels and Device Tree

Displays a hierarchical tree depicting the driver's channels and devices.    Expand   the tree by clicking the 
plus sign next to an object in the tree. When   you click an object, its available subsidiary objects display 
in the Items   List.

Items List

Displays the servers, groups, or items that are available from the selected   object in the Channels and 
Device Tree.

Refresh

Forces the dialog box to flush its cache and retrieve fresh information   from the driver.

Sort Ascending

Sorts the Items List in alphabetical order.

Sort Descending

Sorts the Items List in reverse alphabetical order.

Large Icons

Displays the Items List using large icons.

Small Icons

Displays the Items List using small icons.
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List

Displays the Items List as a basic list.

Verify Database Dialog Box

If Database Manager detects no errors, it displays a message box to   inform you. However, if it encoun-
ters errors, the Verify Database dialog   box appears. 

The Verify Database dialog box displays the following items:

Tag Names

Lists the tag name of the block that contains an error.

Error Condition

Describes the type of error that the block contains. The following table   lists the possible error conditions 
and how to resolve them.

Error Condition Description Resolution
tagname   a:tag-
name   b Tag is in 
more than one 
chain 

The block, tagname   b, has more 
than one upstream block linked to it. 
Tagname   a identifies one of these 
blocks. 

Remove one or more links to tagname   
b.

tagname:Tag   is 
not in any chain

You may have a secondary block 
that is not in any   chain or is the first 
block in a chain.

Remove the secondary block or add a 
primary block   to the start of the chain.

tagname:   Block 
not found for 
NEXT

The block, tagname,   chains to a 
block that does not exist. 

Create a block with the name specified 
in the Next   field or enter the name of a 
block that exists.

tagname:Chains   
to itself

The block, tagname,   contains its 
own name in its Next field. 

Change the name in the Next field or 
leave it blank.   If you want to repeatedly 
perform a task, use a Program block 
instead.

tagname:   is not 
defined

The block, tagname,   does not exist 
and another block references it. 

Create the block or change the ref-
erence to a block   that exists.

fieldname   No 
such field in 
FDT

The field, fieldname,   does not exist 
and it is referenced by a block in the 
database. 

Change the reference to a field that 
exists.

Exceeding MAX 
chain size of 30

The database contains a chain with 
more than 30 blocks.   

Redesign this chain by breaking it into 
two smaller   chains or remove any unne-
cessary blocks.

OK

Click to close the dialog box.
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Edit

Click to access the selected block's dialog box.

Re-Verify

Click to re-verify the database.

Help

Click to access Help.
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A

accessing blocks off scan  297

adding blocks to a database  9

adding columns  21

adding primary blocks to a database  4

adding secondary blocks to a database  4

adding, column to the sort order  25

ADDOUT command, Program block  261

ADDTAR command, Program Block  262

alarm acknowledgement  8

Alarm Analog block  287

alarm areas  7

alarm conditions  8

alarm limits  8

alarm priority  8, 286

alarm transitions  286

alarms  7, 288-289

Event Action block  289

Analog Alarm block  35, 56, 225, 236, 285-286

Analog Input block  36, 66, 225, 236

Analog Output block  37, 72, 226, 237

Analog Register block  38, 77, 226, 237

appending a query  29

applications, launching  32

arranging column in the sort order  26

arranging columns  23

ascending  26

assigning alarm areas  7

B

blocks, copying and pasting  11

displaying  6

duplicating  11

moving  12

blocs, going to  18

Boolean block  39, 83, 226, 238, 277-278, 288

buttons  31

C

Calculation block  39, 88, 227, 239, 278-279

CALL command, Program Block  262

chaining blocks together  5

changing the scanning order  15

CLOSE command, Program Block  263

closing a database  2

CLRDEBUG command, Device Control 
block  252

Program Block  263

CLRERR command, Device Control block  252

CLRERROR command, Program Block  263

CLRF command, Device Control block  252

colors  30

columns  20

adding  21

arranging  23

going to  18

loading format files  21, 24

modifying  22

overriding default column format layout  24

removing  23
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saving format files  22

command arguments  260

contact patterns  280

continuous use  8

control limits  283-284

copying blocks  11

correcting database errors  13

correcting verification errors  13

creating a new database, databases, creating 
new  2

creating a process database  1

creating a query  28

customizing  30

customizing the toolbar  30-31

customizing the Tools menu  30

D

Database system fields  299

database, adding blocks  4, 9

closing  2

correcting errors  13

creating  1

creating chains  5

duplicating blocks  11

finding data in  17-18

manually refreshing  20

placing blocks on/off scan  16

save as  3

updating  19-20

verifying  13

databases, changing the scanning order  15

correcting errors  13

exporting  15

importing  14

loading  16

merging  12

reloading  3, 16

verifying  13

Dead Time block  40, 92, 227, 239

DELAY command, Device Control block  253

Program Block  264

descending  26

Device Control block  40, 97, 227, 240, 251, 280

Digital Alarm block  40, 102, 227, 240, 290

Digital Input block  41, 112, 228, 240

Digital Output block  42, 108, 228, 241

Digital Register block  42, 117, 229

Digitial Register block  241

disabling sorting  27

displaying blocks  6

duplicating blocks  11

E

electronic signatures, configuring  8

END command, Device Control block  253

Program Block  264

errors, correcting  13

Event Action block  43, 122, 229, 242, 257, 289

Event Action block conditions  257

Event Action block operators  257

Event Action block: alarms  289

event messages  7

exporting a database  15

Extended Trend block  43, 127, 229, 242
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F

Fanout block  44, 131, 229, 243

fields  56, 66, 72, 77, 83, 88, 92, 97, 108, 112, 
117, 122, 127, 131, 136, 140, 145, 150, 
155, 160, 165, 170, 175, 179, 184, 188, 
194, 200, 205, 209, 214, 219, 298

finding data in a database  17-18

fonts  30

formulas  282

freezing spreadsheet columns  20

G

GOCLR command, Device Control block  253

going to a block  18

going to a column  18

going to a row  18

going to locations in a spreadsheet  18

GOSET command, Device Control block  253

GOTO command, Device Control block  254

Program Block  265

H

Histogram block  45, 136, 230, 243

I

IF Command

Program Block  265

iFIX Database Manager  1

IFTIME GOTO command, Program Block  267

importing a database  14

K

keywords  297

L

launching applications  32

Lead Lag block  45, 140, 230, 244

loading a database  3, 16

loading a query  28

loading a sort order  25

loading column format files  21, 24

locking a spreadsheet column  20

M

Manual mode  298

manually refreshing data  20

MAXWAIT command, Program Block  268

menu, customizing  32-33

merging databases  12

modifying blocks  5-6

modifying columns  22

moving blocks  12

MSG command, Program Block  269

Multistate Digital Input block  46, 145, 230, 244, 
288

N

NUL command, Device Control block  254

Program Block  269

O

off scan  16

On-Off Control block  46, 150, 230, 245

on scan  16

OPEN command, Program Block  269

opening a database  2
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opening and closing contacts  290

operators  257, 277-279

options  17

OUTPUT command, Device Control block  254

overriding the default a sort order  27

overriding the default column format layout  24

overriding the default query  29

P

Pareto block  47, 155, 231, 246

pausing refresh updates  20

PID algorithm  281

PID block  47, 160, 231, 246, 281

PLAYSOUND command, Program Block  269

preferences, setting  16

primary blocks  4

proc_toolbar, customizing  31

Program block  48, 165, 231, 247, 258, 261

proportional band  281

Q

query, appending  29

loading  28

overriding the default  29

restoring the default  29

saving  29

R

Ramp block  49, 170, 231, 248

Ratio Bias block  49, 232, 248

Ratio block  175

Rbar  283

reading SQL values  297

Redundancy fields  300

refresh rate  19-20

registers  301

reloading a database  3, 16

removing columns  23

removing, column from the sort order  26

restoring the default a sort order  27

restoring the default query  29

resuming refresh updates  20

rows, going to  18

RUN command, Program Block  270

RUNTASK command, Program Block  270

S

SAC system fields  299

saving a database  3

saving a query  29

saving a sort order  25

scan  16

scanning order  15

secondary blocks  4

selecting a database block  10

SETAUTO command, Program Block  271

SETDEBUG command, Device Control 
block  255

Program Block  271

SETERR command, Device Control block  255

SETERROR command, Program Block  272

SETF command, Device Control block  255

SETLIM command, Program Block  272

SETMAN command, Program Block  272
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SETOUT command, Program Block  272

SETSEL command, Program Block  273

SETTARG command, Program Block  274

SETTIME command, Program Block  274

setting a Database Manager preferences  16

Signal Select block  50, 179, 232, 249, 282

SIM register: RA  301

RB  301

RC  301

RD  302

RF  302

RG  302

RH  302

RI  303

RJ  303

RK  303

RX  303

RY  303

RZ  303

SIM signal generation registers  301

sort order

adding columns  25

arranging columns  26

loading  25

overriding the default  27

removing columns  26

restoring the default  27

saving  25

sorting, columns  26

disabling  27

spreadsheet, finding data in  17-18

going to locations  18

spreadsheets, updating  19-20

SQL data  296

SQL Data block  50, 184, 232, 249, 297

SQL Trigger block  51, 188, 232, 249, 298

standard deviation  283-284

states  298

Statistical Control block  51, 200, 233

Statistical Data block  52, 194, 233, 282-284, 
289

STOP command, Program Block  274

SUBOUT command, Program Block  275

SUBTAR command, Program Block  275

System fields  298

T

Text block  52, 205, 233, 250

Timer block  53, 209, 233, 250

toolbar, customizing  31

Totalizer block  53, 214, 234

Trend block  54, 219, 234, 250

U

unlocking a spreadsheet columns  20

unsigned writes  9

updating data  19-20

V

verifying a database  13

W

WAITAND command, Device Control 
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block  256

WAITFOR command, Program Block  275

WAITOR command, Device Control block  256

WAITSTAT command

Program Block  277

writing SQL values  297

X

Xbar  283
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